


■■ editorial

Apaperless office is still a mythical entity, but this year when you vote,
it will be paperless. Offices continue to feel the need for paper records, but
our General Elections will be conducted without any. Electronic voting

machines have been deployed in India since the turn of the century for various
local polls; but for the first time, 600 million Indians will elect a Central Gov-
ernment with the press of a button.

Paperless elections have been conducted around the world for a while now, but
the merits and risks are still a subject of heated debates. Brazil, for example, enforces
mandatory voting for national elections using electronic voting machines.

The benefits of ‘paperless’ are quite clear and immediate—enabling quick vote
counts and eliminating the possibility of ballot-rigging as well as the huge and
expensive exercise of printing and distributing thousands of tons of paper securely
around the country. 

But it has its dark side, too.
At the recent New Delhi assembly polls, returning officers and election booth

staffers were unable to operate the machines. At another place, a major party
allegedly scared voters by telling them the machines would deliver an electric
shock if they voted for the rival party; while the other party was accused of
teaching voters to ‘start’ the machine by pressing their allocated vote button first!

In some cases, ballot-stuffing could even be undetectable. In Tamil Nadu, one
party alleged that a machine was accepting votes for all parties, but crediting them
to only one party. Similarly, the then Punjab chief minister claimed before an
assembly election that it was possible to tamper with the programmed chips to
change the votes recorded.

While these incidents may be unsubstantiated, this scenario is indeed possible.
Worse, without a voter verifiable audit trail (paper is the usual method), there is
no way to confirm whether your vote was counted for the right candidate. While
officials may claim that no instances of tampering have ever been noted, that is
simply the nature of the new kind of tampering—no one will ever know. Hackers
just may find the election year quite profitable.

Just as computer astrology is an exercise in databases and not the divine word,
electronic voting machines are simply tabulating systems, and not the solution
to our electoral ills. Technology is an enabler; it can help and it can hinder. The
conveniences of electronic voting may be compelling, but the prime responsi-
bility is ensuring the voter’s intent is not lost. 

That remains to be demonstrated.

sumod_hajela@jasubhai.com

“Hackers
just may
find the
election
year quite
profitable”

Don’t Vote for Bits 

Sumod Hajela
Assistant Editor
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Subscribe now...
Get 15 issues for Rs 1,000 (33% off)
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Get 28 issues for Rs 1,800 (36% off)
Log on to www.thinkdigit.com/subscribe

WEB SPECIAL

WEB SPECIAL

taste technology at www.thinkdigit.com

Robo Sabiens 
The new wave of recon-
figurable robots will learn,
change themselves, and
evolve

Beyond Wires    
We take a look at the three most com-
mon wireless standards available today-
infrared, Bluetooth and WiFi. Learn how
they work, and how to use them.

Want to brainstorm? Start a discussion? Share an idea?
Log on to www.thinkdigit.com/forum
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FORUM

BY DEMAND

Polyphonic Wizard 2.7.7
Size: 4.53 MB
Mindware

Splinter Cell: Pandora Tomorrow  
Size: 119 MB
Playware

Expect these on the May 2004 CDs

April 2004
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Install PHP, Apache and mySQL easily
Dev Tools

TypingMaster Typing Test 6.2
Learn or improve touch typing easily
Home

iCandy Junior WinXP icons
A new wardrobe for your standard
Windows icons
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ObjectDock 1.0
Get that funky Macintosh zooming ring
type taskbar in Windows
Home

Mozilla Firefox 0.8
Browse the Internet with this latest 
browser
Internet

SimpLite 2.0.0.29 for MSN
Encrypt text messages sent and received
via MSN messenger
Internet

Free DWG Viewer 5.0
Easily preview AutoCAD files
Multimedia

Mix 2000 (Linux)
Use this alternative to Volume mixer while
autosaving user preferences
Multimedia

AmphetaDesk 0.93.1
Get latest global news right at your
desktop
Office

Folder Match
Synchronise two folders easily
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FREEWARE

Use your logic to put dominoes in a pattern, and then watch them all fall down in
one go in Domino Dash
Watch the latest movie trailers including The Whole Ten Yards, Home On The
Range, Starship Troopers 2
Listen to some funky new music from the Smiling Bee Band and more

The Connect section on your Digit CD
brings you some fun reading with Book-
marks and Newsletters.

The Bookmarks section contains a
list of sites on a particular subject, along
with a detailed description of the sites.
You can browse each site by simply click-
ing the URL. This month we bring some
cool sites on popular hobbies. The
Newsletters section brings you a collec-
tion of newsletters on different topics
every month. This month we have some
newsletters that keep you updated with
new hardware driver releases. 

So, if you’re looking for some light
and interesting reading, this is one sec-
tion that you don’t want to miss.

KNOW YOUR CD
MINDWARE\CONNECT

ON THE CD

Open Watcom 1.2 is a feature packed
IDE for C/C++ and FORTRAN
Multi Desktop 2003 helps your organise
your work in multiple virtual desktops
Groowe Search Toolbar 1.2 will give
you easy access to various search engines

Abrosoft FantaMorph Pro 2.23 will let
you take your friends picture and
morph it into yourself
The Bagle Fix tool will remove that
pesky virus from your computer, with
just a click

Mindware
MUST TRY SOFTWARE

A compilation of useful software across various categories and genres. Something
for everybody.

Bored with that drab PC of yours? Find on this CD stuff to pamper yourself, and 
your Windows installation

Playware



Spoilsports! We admit that
the United Nations is doing

a great job of preserving world
peace, telling the world in
advance about the SARS and
Avian Flu epidemics and
also bringing around
one-tenth of
Africa out of
the clutches
of poverty.
But really, did
they have to
tell us that our
dear PCs are
now the world’s
worst pollutants?

A UN research group
has concluded after
years of, well, research,
that computers create more
pollution than cars as they
contain higher amount of
toxic chemicals. They say that
a PC weighing 24 Kg uses up
energy equivalent to 240 Kg of
fossil fuels, 22 Kg of chemicals
and 1.5 tons of water. 

Even after the machine
has become useless, the group
says, the environmental dam-
age continues. As the discard-
ed PC ends up in a landfill, it

becomes even more
hazardous to

h u m a n
h e a l t h .
The only
solution to

this is to
upgrade or re-
use the com-
puter hard-

ware by manu-
facturers and

users instead of
throwing it away.

PCs contain
chemicals such as brominat-
ed flame retardants and
heavy metals like lead and
cadmium. In theory, local
water supplies are at greater
risk when these chemicals
leach into the ground where
they are dumped.
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WWiiMMAAXX  880022..1166  
■■  WWhhaatt  iiss  iitt??
WiMAX, the IEEE 802.16 Air
Interface Standard, has been
developed as a wireless
metropolitan area network
standard. It looks at
extending wireless networking
to above and beyond the 
LAN limited Wi-Fi IEEE 
802.11 standard.

■■  HHooww  ddooeess  iitt  wwoorrkk??
It uses the 10 to 66 GHz
frequency spectrum for long
distance transmission. An
extended standard, the
802.16a utilises the licensed
and unlicensed standard in
the 2 to 11 GHz spectrum.

■■  WWhhaatt  ddooeess  iitt  ddoo??
The WiMAX standard will
provide metro-wide wireless
networking capability
connectivity with its 31-mile
range. Its data throughput is
about 70 Mbps, which beats
the existing 802.11b/g’s
11Mbps and 54 Mbps hands
down. Moreover, it doesn’t
require line-of-sight for
successful transmission. It will
offer a wireless solution for
current ‘last mile’ wired
connectivity hassles.

hypethesis

Why should a meet-
ing between US Sec-
retary of State Colin

Powell and Indian Foreign
Minister Yashwant Sinha fea-
ture in a technology magazine?
Good question. The answer 
lies in one of the most 
raging issues of our times—
technology outsourcing.

US lawmakers are waging a
battle to curb the flow of jobs
to offshore locations, where
services are offered at unbe-

lievably low rates. Legal moves
in the US Senate and Congress
threatened to hurt the love

affair between India and the US
on the political side.

Powell and Sinha decided
that these business issues 

will not affect bilateral ties.
Powell suggested that India 
too open up its markets to 
US investments. 

Powell feels outsourcing is
a logical offshoot of the tech-
nology available today, so if
India opens its trade avenues,
the US would be able to offset
the losses sustained due to cur-
rent work and job trends. 

Still sounds like bullying, if
you ask us. Only this time, it is
couched in diplomatese.

Philips wants to get back
into the innovation mode.

Big time.
At the recently held CeBit

technology fair at Hanover in
Germany, the Netherlands-
headquarted consumer elec-
tronics giant debuted a tiny
lens that works by manipulat-
ing fluids in a tiny  tube. 

When a small electric cur-
rent is passed through the two
fluids, one of them attaches to
its edge, while the other fills
up the remaining space. The
spot where they touch, func-
tions as a lens.

The 3-mm lens will be
used in low cost digital cam-
eras used inside phones. 

The lens, whose technolo-
gy is patented by Philips, can
be shaped to be hollow or
curved, by changing the cur-
rent passed. As a result, the lens
can focus on objects far away
or as close as five centimetres. 

Ingenuous, we would say.

Is it a lens? Is
it an eye?

■ Macromedia updates Dreamweaver MX 2004, runs 50 per cent faster on a PC ■  Sony to launch personalised radio service for phones

Powell, Sinha bhai bhai

29 per cent of

American users have

reduced their

overall use of e-
mail due to abun-

dance of spam

snapshot

Source: Pew Internet & American 
Life Project ➜

Meet the new polluting
champ: The PC

Farzana Cooper
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W32.Netsky.K@mm
If you receive an e-mail from
a known person with subject
“Re: Here is the document”
and a .pif extension attached,
your PC may already have
met the Netsky virus.

The virus has its own
SMTP engine and spoofs its
sender’s address. It searches
the drives for e-mail lists in
files of pre-defined extensions. 

The Netsky author claims
his creation actually cleans the
PC of the Bagle and myDoom
viruses. The author has
threatened to make the
source code public.

Download its 
removal tool from http://
securityresponse.symantec.
com/avcenter/venc/data/w32.
netsky@mm.removal.tool.html

DDoS by
Symantec?
eEye, a security vendor,
recently found a flaw in
Norton Internet Security
2004, Norton Internet
Security 2004 Professional
and Norton Personal Firewall
2004, which allows an
intruder to gain remote
access to the victim’s PC with
maximum possible
administrative rights and
launch DoS attacks from
systems running the affected
software in their default
installation. It found another
flaw with all versions of ISS’s
RealSecure and BlackICE. eEye
is waiting for a patch to these
problems before releasing
exploit details to the public.

redalert

Source: Nielsen/NetRatings and ITU

Internet Users in India
(in million)

People cruising the Internet

statattack
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■ SuSE Linux 9.1 to use new 2.6  kernel; Novell to make YAST management tool open source  ■  Windows XP SP2 reaches Release Candidate stage

Intel changes
nomenclature

Intel will stop using clock
speeds as the name differen-

tiator for its processors. The new
system will account for per-
formance factors such as bus
speeds and cache memory.

The Celeron line-up will get
a 300 series number—for exam-
ple 355—the Pentium 4 desktop
processors will be the 500 series
and the Pentium M mobile
processors will be the 700 series. 

Wait! Didn’t Intel spend
millions to market clock speeds
as the ultimate performance
gauge? Yeah, but that was to
oppose AMD, who all along said
that clock speed was not the
only indicator of speed. 

The new naming scheme
seems to exchange one kind of
complexity for another. The
question is: Will this work bet-
ter for the consumer, or will it
simply make matters worse?

52 per cent of
San Diego city
in California,
USA use broad-
band access

snapshot

Source: comScore Networks

In the popular folk tale The
Pied Piper of Hamelyn, the

storyteller never told us how
many rats the piper eventually
enamoured to be condemned to
the sea. But we can tell you how
many songs did the world’s
modern pied piper Apple’s CEO,
Steve Jobs, manage to get peo-
ple download into their devices:
all of 50 million, all paid for, and
in only five months.

Apple’s strategic tie-up with
Pepsi means that another 100
million songs will be down-
loaded free.

It was in October that Apple
expanded the iTunes store to
work with Windows-based
computers—just another bril-
liant idea from Jobs,  the king of
comebacks. 

Apple sings—
50 million
times!

Some years ago, Kodak set-
tled a patent infringement

lawsuit against Polaroid cor-
poration by giving it US$ 925
million in damages. We are
pretty sure it wants that
money back.

Now to make its brand
name synonymous with digi-
tal photography, Kodak has
filed a suit in a US Federal Dis-
trict Court against Sony Corp,

alleging that the latter has
infringed upon 10 patents
issued to Kodak within 1987
and 2003. 

The patents covered vari-
ous aspects of capturing, stor-
ing and displaying both, still
and moving digital images.
Sony’s official line is: “We have
not violated any Kodak patent
related to digital imaging and
will fully defend any allega-
tions made in this regard.”

Kodak, however, will be
pretty confident of winning
the case since they won a
similar patent infringe-
ment case against Sanyo

Corp three years ago.
Sanyo then agreed to
license technologies
from Kodak. Before they

could become another Kodak
“victim”, Olympus also
agreed to license technolo-
gies from Kodak.

For the record, Kodak
holds an amazing 1,000 digi-
tal photography patents.

Another Kodak moment:
A lawsuit against Sony

➜

Internet
Source: Nielsen/NetRatings, ITU and Ipsos
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■  China shuts down blog sites; says content is "against regulations"  ■  TDK joins Blu-Ray Disc group to create next generation optical storage products 

What would you call the
Hitachi 400 GB Deskstar

7k400? OK, let’s see. Giant?
Nah. Leviathan? Maybe, but it
has a negative connotation.
So, we thought we would settle
for the serpentine Leviathan’s
arch mythological enemy—
the Behemoth.

A quick calculation on
what a 400 GB hard drive
could hold: 
! One lakh MP3 songs at 4
MB per song; 
! 1 crore MS Word files at
approximately 40 KB per file; 
! 100-125 DVD movies at 3-
4 GB per movie

Now, let us calculate how
much time would we take to
absorb all this data:
! Listening to all one lakh
songs would take 6,666 hours
or 278 days at a stretch.
! Reading all the MS Word
files (assuming we take 15
minutes to read one file) at
one stretch would take 2.5
million hours.
! To watch all the movies
would take 625 hours at a
stretch, assuming two hours
per movie.

Our question, then, is:
Who would want to buy a 400
GB hard drive? Hitachi says

the drive is aimed at the
audio-visual market where 
the principal criteria for 
selecting a drive are size 
and cost per GB. 

Besides, Hitachi informs
us, the drive features a new
industry standard AV
feature known as Streaming
Command Set used for
optimising storage and
retrieval procedure of
content on a digital video
recorder (DVR).

All that is great news.
But  our question still remains:
Why would you want to buy
this behemoth?

heroes

Lindows
Lindows has been forced to
pull out of the Netherlands,
Belgium and Luxembourg
after Microsoft got local
courts to ban Lindows from
the Benelux region on
copyright and trademark
infringement grounds.
Lindows has also been
slapped with a 100,000
Euro per day fine since
Benelux users can still
access the international
Lindows site.   

Peer-to-peer
companies
Recent moves in the US
state of California may
make P2P-software making
companies more
responsible of the sort of
content that is available
through their software, and
prevent them from
releasing features that hide
customers who deal in
pornography or
copyrighted material. 

zeroes

➜

In-store Wi-Fi
hotspots
McDonald’s is now offering
Wi-Fi hotspots in the US.
Bookstore chain, Barnes
and Noble, plans to launch
such services by September
2004, thus offering
customers wireless 
Internet access in more
public locations. 

Legitimate music
downloads
In a season where Napster
2.0 and the iTunes music
download service have
reported millions of legal
music downloads, the
StarBucks coffee chain now
offers customers the chance
to download and burn
entire CD compilations as
they drink coffee. 

How cool is a USB Swiss Army Memory
Stick! 

Victorinox, the world’s favourite creator of
the multifunctional Swiss Army
knife, has joined hands with
flash memory manufacturer
Swissbit to create a USB mem-
ory stick Swiss knife. The
knife, immortalised in popular lit-
erature and films, will also have
the usual assortment of quality
tools such as the saw, the
corkscrew and a tin opener, along with 64 MB
and 128 MB USB memory stick options.

It debuted at the much-liked CeBIT tech fair
at Hanover, Germany held March. Here is how

you can use it: Suppose you are on a jungle safari
carrying your favourite Victorinox knife, and

you are also carrying your laptop, and you
are stranded, and maybe you are still

alive, thanks to your survival
tin food or the absence of

wild animals, you may be
able to exploit the memory

stick to its fullest. Just connect
it to your laptop, and let GPS systems

help you get back to civilisation. 
Have more ideas on how to use

the Swiss Army Knife USB memory stick? Write
to us at readersletters@jasubhai.com. We will pub-
lish the top three innovative reasons in next
month’s Digit.

USB survival tool

Our guess is that the US Department of
Defence has not even spoken to, or has

not been influenced by its Indian
counterpart, which, allegedly,
does not cringe at earning a
little money on the side,
even coffin deals.

Why would the offi-
cials at the Defence Depart-
ment otherwise tell Microsoft
not to send free copies of their
Office suite to army officers. The department is
not alone. The army itself has issued a letter to
Microsoft’s chairman Bill Gates asking his com-

pany to desist from offering free software to
army personnel. 

The letter also points out that
army personnel may unknowing-
ly violate ethics rules and regula-
tions. The army has asked all its
officers to return the freebies.

For its part, Microsoft says
the software was sent “without
obligation”. Hmmm, is this the
same company that fought the

US government tooth and nail, claiming it
does not want to kill others in the market by
institutionalising its monopolistic outlook?

No more freebies, please

Hitachi ships 400 GB giant
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■ Programmer sues Kazaa for $25 million; claims partial copyright on code  ■ US Department of Defense contracts IBM for RFID strategy

IBM’s legendary chairman
Tom Watson used to have a

board behind his desk. On the
board were written five letters
in large type: THINK. Univer-
sal Music International (UMI)
has added three letters to that,
and come up with THINK BIG.

UMI has announced that
it has finished digitising three
lakh songs from the 25,000-
odd albums in its catalogue,
amounting to 20 Terabytes.

UMI tells us that each CD
worth of music has been stored
as a disc image and not as indi-
vidual tracks, with the Univer-
sal Packaging Code (UPC) and
International Standard Record-
ing Code (ISRC) codes intact. 

Now, distributors can
demand a format and a bitrate
of their choice for online deliv-
ery. As of now, Europe, where
UMI is located, has only one
legal download service—O2.

Universally digital

Clash of the titans 
Even as spam reaches
ridiculous proportions, 
four major US ISPs have
teamed up to sue over 
220 alleged spammers. 
AOL, Earthlink, Yahoo and
Microsoft have initiated
litigation in several 
US states against spammers. 

The move has seen
widespread support from
lawmakers in the US, who
have praised the initiative.
The lawsuits are the first
to be filed under a new
US anti-spam law that is
called CAN-SPAM.

Office XP users who install
the recently released Office
XP Service Pack 3 will find
that at least two anti-spam
products, Sunbelt Software’s
IHateSpam and Cloudmark’s
SpamNet are hampered 
by SP3. 

Users of these products
who have updated Office XP
will get warnings that a 
program is trying to access
the e-mail addresses stored 
in Outlook and that this
could be a virus, but no 
further details. 

IHateSpam users can 
find a patch on the Web site
that addresses this issue, but
users of SpamNet will have
to wait as Cloudmark and
Microsoft work towards
releasing a patch.

Spam
Service, no smiles

➜

In last quarter of

2003, total

Linux servers
shipments were

about 2,50,000
a growth of over 

53 per cent over

last year

snapshot

Source: IDC

It is a classic cat-and-mouse
game. US prosecutors spend

a lot of time busting online
gambling sites. But US law
holds online gambling illegal
only within the US. Most gam-
bling sites are located outside
US territory (Costa Rica, etc).

So, American law
enforcers are doing the next
best thing—targeting those US
companies that do business
with such sites by providing
advertising and other services. 

Several individuals and

companies who have worked
with Internet casinos have
been issued legal notices.
Along with pornography and
shopping, gambling is the
Internet’s biggest moneyspin-
ner. So, we guess it is back to
the good old days of heading
to Las Vegas to bask in the hos-
pitality of Caesar’s Palace.

Dice loaded
against online
gambling

IBM has the

largest server

market share in

Asia Pacific
region—37.4 per

cent in 2003, based

on revenue

snapshot

Source: Gartner

Ladies and Gentlemen, wel-
come to the bout that

decides the undisputed heavy-
weight search engine champi-
on of China. We have three
contenders for the champi-
onship belt. Join your hands
for Baidu.com, Zhongsou.com
and the interestingly named
Yahoo subsidiary,
3721.com in the
Red corner. 

And in
the Blue Cor-
ner, we have
the current
undi sputed
search engine
champion of the
world, Google.com, who
entered China some time back
to corner a piece of the US$
100 million market.

The bout has begun well,
with all the Nasdaq-listed Chi-
nese sites becoming profitable,
thanks to sponsored links at
the top of the search results. 

But will Google sit back
and relax? No siree, the cham-
pion fought back in February
launching a Chinese language
ad service. But 3721.com
founder Zhou Hongyi who
sold his company to Yahoo for
US$ 120 million has said a few

sweet words about Google
recently. We quote him verba-
tim: “My job in China is to
kick Google’s ass.”

Hongyi is all ready to take
on Google. With a Net pene-
tration of 80 million users and
expected market size to be US$
200 million by 2006, Hongyi
sees nothing but a brutal fight

for the top spot. He has
already scored the

first jab on
Google’s chin:

His site’s database
of searchable sites

is already at
150 million.

His part-
ner in the tag-

team bout is Robin Li,
founder of Baidu, who
claimed a searchable index
size of 220 million. But
chances are that Google may
buy over Baidu.

Zhongsou, meanwhile,
has a database of 280 million.

With this, ladies and gen-
tlemen, we come to the end
of Round One of the heavy-
weight search engine champi-
onship in China. Right now,
the honours have been
shared. See you soon in
Round Two.

China’s search engines
take on Google
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“These alleged
cures would make
matters worse... if
foreigners were to
retaliate, we would
surely lose jobs”

US Federal Reserve chairman
Alan Greenspan, who feels
protectionist measures
would damage the 
US economy. 

“We think this as
the next evolution
in mobile
entertainment...for
the same money 
as an audio-only
player, you will 
be getting video 
as well”

James Bernard, Portable
Media Center product
manager, Microsoft.
Microsoft plans to launch
portable entertainment
devices with 40 GB capacity
running Windows software
by the year-end in Europe.

“... unchecked
spread of open-
source software,
under the GPL (the
General Public
License) is a much
more serious
threat to our
capitalist system”

Dale McBride, CEO, SCO in
a message sent to the
members of the US Congress
earlier this year. SCO
threatened to launch legal
action against the Lawrence
Livermore National
Laboratory and the National
Energy Research Scientific
Computing Center (NERSC),
over the use of “unlicensed”
Linux-based supercomputers.

quoteworthy

Anew Internet data proto-
col developed at the

North Carolina State Univer-
sity may well have what’s
needed to give truly amazing
speeds for data transmission. 

Called Binary Increase
Congestion-TCP (BIC-TCP),
the new protocol was tested
alongside six other competing
protocols at the Stanford Lin-
ear Acceleration Center, and
was judged on top on several
parameters including stabili-
ty, scalability and fairness in
comparison to the others. 

BIC works by using a
binary search algorithm to
search for maximum net-
work capacity within mini-

mal data loss. It means that
such a protocol can be used
for large scale scientific stud-
ies in nuclear and high ener-
gy physics, astronomy, geol-
ogy and meteorology. BIC-
TCP can deliver speeds that
can work out to 6000 times
the throughput available
from today’s DSL lines or
1,50,000 times faster than a
modem connection. 

Co-developer Injong
Rhee says what TCP can do
in two hours, BIC can do
in less than a second. That’s
an impressive statistic for
what might become a dom-
inant protocol on tomor-
row’s Internet.

Net speed demon

Microsoft has knelt before
the courts. At least for

the time being. The world’s
largest software manufacturer,
and best known in the recent
past for its much publicised
fight with the US Department
of Justice, has offered to
include rival software on CDs. 

And if you are happy about
it, you should thank European
Union (EU) anti-trust regula-
tors who said Microsoft has
violated competition rules by
tying its media player software
to Windows. EU is considering
asking Microsoft to offer two
different versions of its operat-
ing system, one with audio and
video playback features and
one without them.  EU is con-
sidering this to give consumers
more choices over audio and
video playback software. 

The EU, always known for
its policy of doing everything
that Americans do, did the
same in this case. Instead of
attacking Microsoft by focus-
ing on browsers (like the
Americans did), EU concen-
trated on the Windows Media
Player. And it won.

EU has also indicated that
it will make sure that big PC
makers are free to choose what
multimedia software they want
to install on new PCs. Whoa!
Where does that leave Microsoft
now? Wait and watch.

How the
mighty fall

Though the Beagle project
for Mars exploration may

have not got what it really
wanted, the Bagle Internet
virus has no full stops. Since its
inception mid-January, it has
as many as 16 variants even as
we go to print. 

Bagle’s ingenuous way of
affecting a PC by enforcing a
backdoor entry has troubled
hundreds of network admin-
istrators. It spreads by scan-
ning the PC and
all shared fold-
ers with names
starting with
‘shar’, for any
lists of e-mail addresses, and
then mailing the infection to
these addresses. 

The virus spoofs the
domain name of the recipi-
ent. Therefore, a person
would feel that the e-mail
came from someone within
his domain such as the

administrator, or from his
friend (by his e-mail ID found
on his PC). 

It compresses the infect-
ed file inside a password pro-
tected zip file. The password
is provided in the e-mail
body. Virus scanners respond-
ed by ‘reading’ the password,
and using it to decompress
the attachment and weeding
out the virus. 

Virus developers soon
created a
new vari-
a n t — t h e
password
was now

part of an image, something
that Yahoo or Hotmail give
you to verify your account
while signing up. Anti-virus
firm Symantec, meanwhile,
has claimed that it can delete
this virus even without refer-
ring to the image.

The chase continues.

The Bagle has sounded;
run for cover

■ Haryana Government picks StarOffice for administrative purposes ■  Siemens unveils new 1.3 megapixel camera phone

Worldwide
sales of cam-
era phones
expected to reach

150 million in

2004

snapshot

Source: InfoTrends Rresearch Group

tomorrow’s technology

Find the Bagle
removal tool on the
Mindware CD



This TV viewing card on a PC with full
featured remote is a fully-featured PCI

card with highest resolution quality.
Powerful digital features include

recording of TV programme
or video
streams in
MPEG-1/2
formats, allow
you to burn
direct to a CD
or DVD
without

having to convert, and time-shifting
features on remote let you pause or
replay while recording a live show. It
includes a T-Rex multimedia file
converter and a trial version of Pinnacle
Studio video editing software.

Pinnacle PCTV Stereo
Hi-quality TV Viewing
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To cater to the advanced high-quality
mobile computing needs of an

executive on the move at an earthly
price, Millennium offers you the new
Legend laptop. This laptop is powered by
an Intel Pentium M 1.4 GHz processor
featuring Intel Enhanced SpeedStep
Technology. Features include 30 GB
HDD, 256 MB DDR Memory, 8x DVD-
ROM drive, 56.6 kbps modem, 10/100
Mbps Ethernet card, 1MB L2 Cache, three
USB 2.0 ports, Intel 855GM, excellent
graphics on a bright 15" XGA TFT Screen

made possible by Intel Extreme
Graphics 2, one FireWire, and
PCMCIA slot, besides the regular
PS/2, S-Video, Analog Video,
integrated LAN and Modem,
Line In/Out, and Mic.

Price: Rs. 67,250
Contact: Millennium Automation 
and Systems Ltd
Phone: 011-26495941/42/45, 26495799
E-mail: maslinfo@milleniumsystem.com
Web site: www.milleniumsystem.com

Price: Rs. 3,500 (all inclusive)
Contact: Pinnacle Systems
Phone: 011- 51608210
E-mail: MGupta@pinnaclesys.com 
Web site: www.pinnaclesys.com/asia

Millennium Legend
Feature-rich Indian laptop

New ArrivalsNew Arrivals

O'rite Cameras

O'rite cameras will be available in
various models such as the  O'rite

VC3260 6.0 mega pixel 
4-in-1 digital
camera, the O'rite
MC1300 USB PC
Camera featuring
a pure 1.3M CMOS,
which sets a 'new

standard' for webcams
earlier limited to 350k sensor.  Also
available will be exclusive products such
as the O'Rite RAM-CAM (RC300). 

Contact: Mediatech India
Phone: 91-11-6495941, 42, 45
E-mail: piyush@mediatechindia.com
Website: www.orite.com.tw

MoBo for AthlonTM64

The GAK8VT800M is the first AMD
certified motherboard supporting the
revolutionary AMD AthlonTM64
processor. It delivers a cost effective
platform and brings new levels of
performance and features to the
desktop systems. Accompanied with
the innovative designs of AthlonTM64,
the advanced VIA K8T800 chipset and
Gigabyte's unique technology also
contribute to its functionality and
stability. 

CCoonnttaacctt:: Digi Giga Systems
PPhhoonnee:: 9892642524
EEmmaaiill:: dlinkpr@dlink.co.in

2.4 GHz Home Antenna

SMC Networks announces a home
networking solution — a pair of high-
gain antennae that extends range and
improve signal strength for the popular
2.4 GHz WiFi network (802.11b, b+ or
b/g) — at prices that are ideal for the
home users. 

At just Rs 4950/- each, plus local
taxes and duties, there are two
variants, viz: SMCHMANT-4 and 6
which represent a great investment to
improve home networking performance.

CCoonnttaacctt::  SMC Networks 
TTeell::  +91 11 26234613 
EEmmaaiill:: sanjay.koul@smc-asia.com

New Arrivals is an advertiser-sponsored section that showcases the latest launches in the Indian market. 
All product specifications featured here have been obtained from the contacts listed, but have not been verified by

the Digit Test Centre. You may look forward to reviews of some of these products in our Test Drive section soon.

This All-in-One delivers fast printing,
faxing & copying, along with

outstanding scanning, everything in
one compact integrated product.
Offering professional print quality in
both black and colour (17 ppm
black/12 ppm colour), it is perfect for
all office needs. The integrated flatbed
scanner makes it easy to scan and copy
a variety of materials like documents,
books and more. 

Contact: Rs 12,499 
(taxes and levies extra)
Phone: (0124) 256 6111
E-mail: rajiv.rao@hp.com
Web site: www.hp.com/in

HP Officejet 5510
Versatile Cameras
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Pureview has launched its
branded TFT-LCD

Monitors in India in
technical collaboration with
Funet, Taiwan, with its
range of LCD monitors
from 13.3"/ 14.1"/ 15".
Pureview has set up its state
of the art manufacturing unit
in Sri Lanka with
Japanese collaboration in order to
ensure quality products. These LCD
Monitors are backed by a three-year
on-site warranty with 43 service centres
across the country. Pureview will be
emphasising on 14.1" LCD monitor as

they want to position
this model against CRT
monitors. This product
has some unique features
like built-in speakers,
wall-mounting facility and
330 degree rotation
horizontally. This 

will be a product of “value 
for money” keeping the

masses in  mind.

This all-in-one full-featured LCD
monitor and TV combo has a 17-

inch Wide WXGA LCD screen with
excellent display performance. It can be
used as a HDTV setup box and
progressive DVD input (1080i/ 720p/
576p/ 480p). There are multiple video
inputs for display of PC,TV, DVD and
VCD signals. The screen has a mode
adjustment for best movie or DVD
viewing ratio. It sports a Digital Nicam/
2CS stereo and an AUTO adjustment
optimizes picture quality with standard
VGA analog input.

Philips 170T Monitor

Contact: Pureview Technologies Pvt Ltd
Phone: 022-2416 5455
E-mail: sudipto@pureviewindia.com
Web site: www.pureviewindia.com

Price: Rs. 75,000
Contact:Philips india
Phone: 022-56912353
E-mail: sanjay.maheshwari@philips.com
Web site: www.philips.com

The new ZEN Digital Wireless
Keyboard + Mouse provides you

freedom from physical restraint. The
Optical Mouse with 3 buttons and 1
scroll wheel is worth the extra cost. These
peripherals use Radio Frequency (RF) to

give you reliable wireless performance
from a range of upto 1.5 metres for the
keyboard and 1 metre for the mouse. The
new Zen Digital Wireless Keyboard
features 107 keys-basic enhanced
windows layout, eight media hotkeys
and four Internet hotkeys, up to 256 IDs
to be free from interference, low battery
consumption circuit design for power
saving, low memory resources taken by
utility and finished with Dual Tone Color
(Silver Body with Black keys).

ZEN Digital Wireless Keyboard + Mouse (RF)
Freedom from cables

Contact: Turn On Systems
Phone: 022 - 22620444
E-mail: turnon@vsnl.com

LG EPE-N21HM3 A PC 

LG introduces this new MyPC with a
Pentium 4 2.66 Ghz, 128 MB DDRAM,
40 Gb HDD, a Combo Drive along with
an Internal modem, Onboard Sound ,
AGP and a LAN. The PC comes bundled
along with a special TV Tuner Card with
recording functions and remote and FM
Radio function. It comes bundled with a
MS Windows XP Home. The monitor is a
17” Flatron Monitor.

Contact : LG India
Tel : 0120 - 2560959, 2569957 
email: AjaySurjan@lgezbuy.com
Website: www.lgezbuy.com

MSI 915P Apex motherboard

Fully-loaded with the most cutting edge
technology, MSI 915P Apex is optimized
for Intel LGA775 Pentium 4 processor,
DDR2 memory technology and PCI
Express interface. MSI exclusive D.O.T.
(Dynamic Overclocking Technology) can
perfectly coordinate with Dynamic Vid
in LGA775 Pentium 4 processor.
Balance your PC system between
performance and power consumption.

Contact: MSI
Tel: 886-2-3234-5599
Website: www.msi.com.tw

FFoorr  aannyy  nneeww  pprroodduucctt  aannnnoouunncceemmeennttss
iinn  tthhiiss  sseeccttiioonn,,  vveennddoorrss  //
mmaannuuffaaccttuurreerrss  ccaann  ggeett  iinn  ttoouucchh  wwiitthh

! BBAANNGGAALLOORREE:: Bibhor Srivastava, 
EE--mmaaiill::
bibhor_srivastava@ jasubhai.com, 
PPhhoonnee::  5325670/88, 37629285 

! CCHHEENNNNAAII:: Sahayaraj Prabhu, 
EE--mmaaiill::
prabhu_sahayaraj@ jasubhai.com, 
PPhhoonnee:: 28235186/89, 33629282 

! KKOOLLKKAATTAA:: Jayanta
Bhattacharyya, 
EE--mmaaiill:: jayanta_bhattacharyya@
jasubhai.com, 
PPhhoonnee:: 22345100, 33629284 

! MMUUMMBBAAII:: Saurabh Pandey, 
EE--mmaaiill::
saurabh_pandey@ jasubhai.com, 
PPhhoonnee:: 56310515/14, 33629278 

! NNEEWW  DDEELLHHII:: Arvind Prabhakar, 
EE--mmaaiill::
arvind_prabhakar@ jasubhai.com, 
PPhhoonnee:: 51608658/59, 32358374 

! PPUUNNEE::  Vinayak Inamdar, 
EE--mmaaiill::
vinayak_inamdar@ jasubhai.com, 
PPhhoonnee:: 24482059

! SSEECCUUNNDDEERRAABBAADD:: Vinayak
Inamdar, 
EE--mmaaiill::  vinayak_inamdar@
jasubhai.com, 
PPhhoonnee:: 55221051, 3362980

Sponsored Product Annoucements

Pureview LCD Monitor 
Value for Money



Your fashion navigator?
Ahoy Digit! I have been a regular reader of your magazine for

quite a few years now, and most

of my computer knowledge

(little as it is) has been

acquired through your

magazine and CDs. I am 

also a die-hard First Person

Shooter gaming fan. 

I have a suggestion. For

years now, my wife Anu

has been jealous of my FPS

gaming and your magazine.

She says Digit just keeps me realising how outdated my PC

gets every year, even with upgrades. Yeah, yeah, I know that

today’s best is tomorrow’s crap. But your magazine keeps me

abreast of all the latest technologies, and I do learn a bit with

each issue. I am a doctor and she is a fashion designer. 

I would like a page (no more please) dedicated to various

software with demos on CD (not system heavy though) in the

fields of fashion, modelling, designing, recipe-cocktail

collection, family photograph collection, edited from a

woman’s perspective, thereby keeping myself still one step

away from the saying… ‘If you can’t beat them, join them’.  

Jean Mathew

Via e-mail
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Your vote counts
This month’s question:
How DVD savvy are you?

! I own a DVD-ROM ! I plan to buy a DVD/DVD-R soon
! I own a DVD-writer ! What’s the point? I’ll never buy one

Log on to www.thinkdigit.com and vote

Six to a dozen

I must admit upfront that I am not a regular reader of

Digit, since I can afford to buy only six of the 12 issues

every year. But, I must add that the March issue of

Digit was brilliant, and I more than glad to get the

software provided with the Mindware CD.

I had to buy the issue once I saw the contents, and

yes, I was not disappointed since the graphics were

stunning. Getting know about speaker enhancements

in the home theatre section was good, and I

understood it

quite well,

despite the fact

that I am not a

technologist.

Ashish Anand

Via e-mail

Dear Ashish,
We are sorry you cannot buy all 12 issues of
the magazine in a year. However, please do
keep coming back to the news-stands to
check out our content. Who know, you may
just be tempted to buy all 12!

Yes, I bought
a PC - 285       15.6% 34.5%

11.5%38.4%

Yes, I 
upgraded 

- 629  
None of
the above
- 700          

Yes, 
I bought 

a laptop - 210  Responses: 1824

Patch me up
Viruses, worms and Trojans are surely one of the biggest risks acomputer is exposed to. Apart from running virus scanners, itis possible to minimise this risk by downloading and applyingthe so many Windows patches that Microsoft releases atregular intervals. 

The only problem is that most users are not aware of this ordo not have the resources (read ‘high bandwidth’) to downloadsuch patches. I would request you to start a section on yourCD, which contains these downloaded patches. This could bethe biggest service you coulddo to your readers.
Karanvir Singh
Via e-mail

Tip that!
This is with reference to Digit’s section on home
theatre systems in March 2004. There is a useful thing
to remember, which I would like to share with readers
of Digit who have Intel D865 motherboards.I have a D865 board with a 2.6 GHz CPU with
hyperthreading, and the motherboard comes with
software that allows you to connect a 6.1 channel
speaker setup on to the three audio-out ports. For

people like me who do not want to buy a separate
sound card for surround sound, or maybe cannot
afford it, this is a cheap and versatile option.And one for the road: I converted my Windows
desktop into a Macintosh OS X Panther desktop, and I
am proud to say that I nearly fooled one Mac user—
until he found windows task manager running in the
background.
Pranav Naik
Via e-mail

Dear Karanvir,
Your wish is our command. Check
out the Bagle / Beagle patch on the
Mindware CD with this issue.

Dear Pranav,
You have a knack for the unusual, and there is no
doubt in our mind that your tips will be useful to all
our readers. As for your fooling the Mac user is
concerned, well, all we can say is: Congratulations!

pulse ■
■ letters

Have you bought a new PC or a laptop, or upgraded your system
after low prices following the mini-budget? 

Dear Jean,
Firstly, thank you for your kind words. It
is feedback from readers like you that
keeps us motivated month after month.
We have indeed taken cognizance of
your suggestion, and we will try and
implement it as soon as we can.

Mahesh Benkar
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E-mail: readersletters@jasubhai.com
Send your letters marked ‘Readers Letters’ to the Digit office: 

D-222/2, Om Sagar Building, MIDC, TTC Industrial Estate,  Nerul, Navi Mumbai 400 706 
Phone: 022-27629191/9200  Fax: 022-27629224

" The Intel 845GVSR
motherboard featured in
February 2004 on page 47,
is based on the Intel 845
chipset and features Socket
478 as opposed to Socket
A. The motherboard’s
documentation mentions
that it is designed,
especially for the Intel
Celeron and so, we tested
it using a 2.8 GHz Celeron,
leading to a total score of
41.01. However, the
motherboard also supports
the 533 FSB Pentium 4. We
re-tested it using a P4 3.06
GHz CPU, resulting in a
total score of 47.22, which
is approximately 15 per
cent more than the
previous one. 

Notice any goof-ups? 
Write to goof@jasubhai.com

Goof Ups

Yes we have ESP
What can I say, but huge thanks for the February issue’s Tips
& Tricks section, which covered useful stuff for Web
designers. That was a real help!It was also good to read the review on Gothic2, the game.
I am a big fan of Gothic or horror-based RPGs and there are
not many that are publicised. I would love to play Gothic1
before I go for the sequel. Yuvan
Via e-mail

Hey guys, I have tried out 3dsmax, Maya, SoftimageRhinoceros 3D andCinema 4D. 3ds max 6 isreally cool, especially thenew architectural toolsand integrated DX9shader support in thematerial manager. Nice for us game developers. I found Maya to be user-friendly, though the interface
isn’t as appealing as Max’s at first glance. Maya has better
features for nurbs and subdiv modelling, while Max would be
the better choice for polygonal modelling. You can find a trial version of Maya at www.alias.com (it’s
called PLE and is actually a free version of Maya). Maya was
used in the making of Final Fantasy: The Spirits Within and
LOTR 3: Return of the King. Anidex
Via e-mail

Service with a smile

Hi! I work in the

Merchant Navy, and

after five months

of exhausting

tour-of-duty at

sea, I recently

came back eagerly

waiting to feast my

eyes on Digit. All the tech-

nology knowledge I have is

primarily because of Digit.

So imagine my disappoint-

ment when I realised that

two issues sent to my resi-

dence had to be returned because there was no one at home.

I immediately wrote to Digit, explaining my problem.

This time around, it was my turn to be delighted. I was

mighty impressed that the two missing copies of Digit land-

ed at my doorstep within 24 hours of my mail. How cool is

that!
I know people sometimes do not have a good opinion

about Digit’s customer service, but hey, how much better

can you get than this.

My special thanks go out to Reema at the Customer

Service desk, and may your magazine succeed all the time.

In the meanwhile, let me get back to my favourite pastime

when I am home—

reading Digit, and

exploring the CDs.

Dilip D’Souza

Via e-mail

Dear Dilip,
Our customer service desk is always
ready with solutions for our read-
ers—be it subscription related
queries, or defective or broken CDs.
Please do no hesitate to get in touch
with the customer service desk at
help@jasubhai.com any time.

vickymustdie
Analogue Novice

Joined:
03 March 2004
Posts: 1
Location:
Mumbai

crusader77
In-House Geek

Joined:
29 Dec 2003
Posts: 198

Hi guys, Almost everyone at the Digit Forum likes to play games. The only
thing I wanna ask is: How many are seriously taking games as a career? How
many are looking forward to develop one? There’s a hell of a choice in this
industry that one can choose from… such as cinematic artist, game tester,
game designer, level designer, screenwriter, sound engineer, junior program-
mer, lead programmer, special effects programmer, audio programmer/engi-
neer, artificial intelligence programmer, multiplayer networking programmer,
3D modeller, etc. 

So, I request all you gamers to think of getting in the game industry.

What’s sorely lacking in the Indian gaming industry are good ‘ideas’. These
kind of games have a very small audience and it will get nowhere by making
these kinda games. Also, there aren’t enough people seriously into this field
(as a career) as compared to any other country. In the US and UK, there are
full-fledged courses and diplomas in game development, designing, and
programming. These also play a very important role as it’s a very
overwhelming task to start off especially in game programming, on your
own. For example, trying to learn and master Direct-3D programming on
your own, I know how difficult this is cause I am doing this on my own.

Posted: Mon Mar 15, 2004 3:06 pm  Post Subject: Games as acareer...

Posted: Wed Mar 17, 2004 10:03 am  Post Subject: 

Dear Yuvan and Anidex,
There is a treat awaiting you in this month's Tips and Tricks
section—all of eight pages devoted to just Maya and 3DS
Max. We have two of India’s best professionals—Suzzanne
Rebello and Sachin Puthran—who have given some great
tips for both these amazing software. Have fun.

The Winner of the ‘Post your best Planet Digit Experience’ contest is...
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It was the wheel that began it all—technologies
that have a fundamental impact on human
society. The steam engine, electricity, the car,

the airplane, the television, the phone—tools we
cannot think of existing without.

But surely, if there has been one advancement
in human endeavour that has overshadowed 
all others in the last decade and a half, it is infor-
mation technology. Arguably, it is also the only
development that has touched so many lives in so
little time.

The dotcom boom and bust may have earned
the Internet a bad name, but the initial experi-
mentation with associated business models and
democratisation of technology during the dotcom
boom provided a deep knowledge base to leverage
the Internet for the greater good. 

Consider this: The bust actually paved the way

for an evolved vision—growth accompanied and
tempered by ground reality. What this meant was
that corporates adopted the Internet to not only
enhance productivity, but also to develop innova-
tive business models. 

Once the corporate world adopts this model,
governments have to take it up too under pressure
to perform in a democratic setup. Which natural-
ly means that governments will have to look into
issues concerning people, processes and technolo-
gy. In the not-so-distant future, our public admin-
istration system could well have an online inter-
face to liaise with people. 

An online government implies a single point of
access to all public information, and greater citi-
zen interaction with the administration through
Internet-based services. It also helps actualise the
potential to streamline relationships between gov-

Jaijit Bhattacharya is Head, Oracle-HP E-Governance Centre of Excellence, 
Dr. M P Gupta is senior faculty at IIT, Delhi, 
Prabhat Kumar is additional director general, Directorate of Systems (Customs and Excise), Government of India
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ernment, business and citizens. 
Government departments operate in isolation,

and surely the first logical step to a single window
government is to create coordination architecture.
And perhaps the first government function to be
tackled could be financial management. Right
from the preparation of the budget to its execu-
tion and tracking of funds, every department goes
through the same set of pains. 

Obviously, an integrated financial manage-
ment solution should also enable governments to
switch from cash-based accounting to accrual-
based accounting. This fulfils two functions - it
protects the government's information technology
investment from future changes in accounting
standards. And secondly, it also adheres to the
World Bank Treasury Reference Model, which
ensures that the global best practices in managing
government financial systems are adopted.

Next on the roster of activities is coordinating
and collaborating with other departments and
agencies, managing employees and payroll, man-
aging large government projects, and providing
effective public services.

Technologically, government solutions are
mission critical—no government can provide the
excuse that it could not function because of a sys-
tem failure. Therefore, the systems need to have
high availability built-in.

The other pillar of technology is security. Imag-
ine having systems with every bit of municipal
data. Any security compromise on such a system
will completely undermine the faith in the gov-
ernment and may even lead to serious financial
losses. One process of ensuring that the appropri-
ate security is built into the solutions is to adopt
solutions having appropriate security certifica-
tions.

The technology stack in total, includes tech-
nology pieces like packaged applications, database,
application servers, operating systems, business
intelligence (datawarehousing and datamining),
support systems, Geographic Information Systems
(GIS), open source software, document manage-
ment, knowledge management, smart cards, bio-
metrics, telemedicine, and wireless. 

Once the government has its backend in place
and has crystallised its application architecture and
IT architecture, it would be in a position to roll out
citizen-oriented services.

Many national, state and local governments in

developing countries have tried to e-enable their
service delivery mechanisms. But to date, most
implementations have centered on publishing of
information with isolated instances of transaction-
al service delivery through government portals. 

One successful attempt has been eSeva in
Andhra Pradesh, where change management is
handled deftly.

In fact, it is municipalities that are aggressive-
ly adopting e-governance. But, they face problems
in scaling up to this demand. A primary issue hold-
ing them back is their financial management
processes and systems. 

It is believed that municipalities would bene-
fit from a clearer division of functional responsi-
bilities and enhanced linkage among different lev-
els of government that will ensure upward and
downward accountability. It will also help state
finance corporations in their constitutional task of

devolution of funds to municipalities.
One problem, though: Most municipal bodies

in India, with the exception of Tamil Nadu, follow
the traditional governmental cash basis accounting
system. Some forward-looking municipalities like
the Kolkata Municipal Corporation, have also
adopted a modified accrual basis of accounting as
an intermediate basis of accounting. 

One of the key problems arising out of the cash
basis of accounting is that municipalities do not pre-
pare or publish balance sheets. Because of this prac-
tice, the overall financial position (assets, liabilities,
receivables or payables) of the municipality is not
known at any point in time. Moreover, the accrued
income or expenditure is also not known. There are
no journal vouchers or revenue and expenditure
accounts. Hence, the financial status of the munic-
ipality, for the period or year, is not known.

Such a situation leads to difficulty in managing
the municipality. It makes it tough for municipal-
ities from going in for innovative financing of its
projects by issuing bonds or using other financial
instruments. So it is obvious that implementing
integrated financial management systems for
municipalities would benefit them tremendously.

In addition, municipalities like the Ahmed-
abad Municipal Corporation is using appropriate e-
governance solutions to increase revenue genera-
tion by a phenomenal 125 per cent. The Kalyan
Dombivli Municipal Corporation (KDMC) near
Mumbai has used e-governance to create a highly
successful online citizen service with the objective

Municipalities are aggressively adopting 
e-governance. However, they face problems in scaling
up to this demand. A primary issue holding them back
is their financial management processes and systems.

“
”



of making each citizen's interaction with KDMC
easy, simple, and efficient, while ensuring account-
ability and transparency. 

The Coimbatore Municipal Corporation (CMC)
has used e-governance for a “Anytime, Anywhere”
governance. This has helped CMC in making their
administrative processes transparent, efficient and
productive. It also helped in creating a simple,
friendly and efficient interface for their citizens.

Another issue that has almost become syn-
onymous with e-governance in India is the financ-
ing of the e-governance projects, or more precise-
ly the financing mechanism of Public Private Part-
nership (PPP). 

It is an old mechanism of engaging with private
partners, namely private companies as well as non-
governmental organisations (NGOs) to bridge the
gap in the quality, speed and efficiency in the serv-
ice delivery process in the public sector. In e-gover-
nance, this partnership has been cemented in pub-
lic projects like creation of infrastructure and pro-

visioning of services in the entire gamut of activities
relating to hardware, application software, mainte-
nance, finance and other activities. 

Governments have limited resources, and hence
cannot achieve everything by themselves. There is
already a financial crunch for investing in and
improving basic facilities like education, health care
and infrastructure projects in roads, power plants
etc. Few governments have ready-cash for investing
in IT-infrastructure projects. 

Therefore, governments are taking advantage
of the complementary strengths of private 
players to achieve the best results in the shortest
possible time. 

In fact, e-Governance projects are infrastruc-
ture projects requiring large investments into an
area that is not the Government’s core compe-
tence. Moreover, there are multiple risks involved
in such projects. These risks are mainly technolo-
gy risks, financial risks, operational risks and user
acceptability risks. Therefore the governments
need to leverage its limited resources, which is
where private financing and operating skills 
come in handy. 

Finally, comes the issue of change manage-
ment. Although most governments who have
seriously started off on the path to e-governance
are aware of the perils of ignoring change man-

agement, still the basic tools of change manage-
ment are being ignored in the rush to come out
with projects on the ground. 

Change management should start even before
the project itself has been identified. If the proj-
ect affects the departments then one should have
mechanisms to involve the departments for con-
ceptualising the project and then keeping them
informed about the progress of the project as well
as key decisions involving the project. 

A mechanism that has been widely adopted is
to have extended workshops to educate the
departments on the management issues of e-gov-
ernance and the possibilities opened up by e-gov-
ernance. Having done that, the departments
would be in a position to articulate their require-
ments, based on which projects can be concep-
tualised. Such a process also helps in reducing the
“re-inventing of the wheel” by reducing re-devel-
opment of common applications. 

It also helps in prioritising the applications to

be developed by identifying the common appli-
cations that needs to be rolled out. The workshop
approach also helps in creating an appropriate
technology architecture that can be centralized
as apriori the government can get a view of the
total requirement of all the departments. 

Finally, the workshop helps in getting the buy-
in and ownership for the solutions so that during
the actual implementation of the solution, the
departments extend their full support to the proj-
ect. This is absolutely critical as such large and
complex projects are highly people dependent.

India is being looked upon as a source of
innovative low cost e-governance solutions 
that are appropriate for countries besotted with
poor physical infrastructure around the world. So
not only should we be developing and imple-
menting the best-in-class solutions for e-gover-
nance for the sake of a more efficient government
and consequently a more efficient domestic
economy but also because it is our responsibility
to be the thought leaders in e-governance in order
to help out countries facing similar socio-eco-
nomic issues. And of course, no one is in doubt
that the Indian central, state and local govern-
ments will stand up to this challenge, but the
issue is how efficiently and how fast can they
show the results.
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“ Once the government has its backend in place
and has crystallised its application and IT architec-
tures, it would be in a position to roll out citizen-
oriented services.

Once the government has its backend in place
and has crystallised its application and IT architec-
tures, it would be in a position to roll out citizen-
oriented services.”



If a spammer sent you an e-mail with a
subject line that said, “Your mail stor-
age limit has changed,” you’d probably

open it, wouldn’t you? You wouldn’t know
it was spam until you opened it… but
CRM114—the Controllable Regex Mutila-
tor—would. And it’s 1,000 per cent more
likely to classify the e-mail as spam than
humans are. CRM114 is a spam killer that
employs Bayesian Learning, a technique
that’s getting increasingly popular in
spambusting.

Largely ignored so far, the possibilities
afforded by Bayesian Belief Networks
(BBNs) and Bayesian Learning (BL)—learn-
ing in BBNs—have only recently begun to
be explored.

Spam detecting and search enhancing
is just the tip of the iceberg when it comes
to the possibilities of this technique,
which, though it made its debut in 1984,
had its basic theoretical foundation spelt
out 250 years ago.

BL is a process whereby a machine is
trained on past data so it can come to deci-
sions about the future. The basic idea is
that the likelihood of something happen-
ing can be estimated by how often it hap-
pened in the past. These decisions—that
something will happen, or that something
is true or false—are probabilistic and are
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never a surety, but more a recommenda-
tion. For example, a Bayesian learner
might say, after observing the weather,
that it’ll be sunny tomorrow, with an 80
per cent probability. Though it might
well rain the next day, the 80 per cent
probability is a certainty. It’s up to us to
decide how to react to it. Some of us
might disbelieve it, others may plan a
trip to the beach, while still more might
toss a coin thrice, and only believe the
‘sunny’ outcome if the coin turns up tails
twice or more.

So, a Bayesian learner can predict out-
comes based on data. But so can Neural
Networks (NNs), and various other AI
models. What’s so special about Bayesian?
To begin with, a Bayesian learner can make
predictions incrementally, that is, as more
knowledge is fed into the system, the sys-
tem’s prediction changes instantaneously.
Secondly, BBNs are not ‘black boxes’ like
NNs, where no one can know what’s going
on in the system. Also, NNs generally give
yes or no answers, while a probabilistic
estimate is often preferable. With BBNs,
the ‘answer’ is updated as soon as data is
updated, which is not the case with NNs.
BBNs are more robust than rule-based
methods and other statistical methods. (See
box ‘Method Madness’)

Where have I seen a BBN?
Wherever anything needs to be predicted,
and wherever a pattern is to be found,
BBNs can work. Both these—prediction
and pattern finding—can come from
learning from the past; when you observe
something over a period of time, you can
predict what’s going to happen, and find
patterns in what you’ve observed.

Bayesian methods you see every day
include spam filters and also the cute but
immensely irritating assistants in MS Office.
The Office assistants learn from the mouse
clicks you make, the text you enter in your
searches, and such. Printer troubleshooters,
too, benefit from Bayesian knowledge.

Have you noticed how personalised
content delivery on the Net seems to

Here’s a comparison of three learning
methods: rule-based methods (make 
and find rules and stick to them), 
Neural Nets, and BBNs. An example
application is spam filtering. Suppose 
a rule has been learnt by all three
systems, a rule that says that any e-mail

with the word ‘debt’ in it is spam. And
now, suppose you work for a debt-
consulting agency for just three days, so
all legitimate e-mails contain the word
‘debt’ in them. You want to classify these
mails as ‘not spam’. What would happen
in each case?

Method Madness

Rule-based learning
You would have to
change the rule man-
ually, and after the
three days, the sys-
tem would need to
relearn the rule from
scratch.

Neural Nets
The system gives a yes
or no answer about
spam, and it would take
a lot of learning—many
e-mails—for it to learn
that your new job mails
aren't spam.

BBNs
The system only gives probabili-
ties. And, after you get a few 
e-mails with the word ‘debt’ in
them, and you say they aren't
spam, the system would look for
other factors in those e-mails that
make them non-spam.

End of
ertainty

Experience is the
best teacher, but
not in technology,
until recently.
Find out how a
250-year-old
theorem is being
employed  in
today's systems
to make use of
the knowledge of
the past
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increase by the year? Cookies are becoming
more ubiquitous. News sites offer person-
alised news. When you make a purchase at
Amazon, it makes a list of ‘similar items’—
items bought by others who made the same
purchase. The recommendations aren’t
based on only that list of similar items, but
also on what you’ve bought before.

In an interesting twist, even spammers
deliver spam based on the last few mes-
sages you opened. Advertisements are
delivered to your browser, based on what
ads you clicked on before. Bayesian tech-
niques also promise to infuse search with
an unheard-of degree of personalisation,
since there’s a whole lot of data that the
user enters—search queries that patterns
can be derived from. Microsoft and Google
are already looking at Bayesian search.

From Bayes’ theorem to BBNs
To see how BL works, an understanding of
Bayes’ theorem is essential. Suppose we
know the probabilities of three things—that
of catching a cold (A), that of catching a
fever (B) and that of catching a fever if you
already have a cold (C). Bayes’ theorem says
that the probability of someone with a fever
having a cold is simply C times A, divided
by B. Things such as A, B and C are called
events; and in BBNs, events are represented
as nodes in a graph, with their associated
probabilities.

Data about events—their probabilities,
whether they took place, etc—are ‘pumped
into’ the nodes.  When data comes in at one
node, it is  sent to all other connected nodes.
The network is updated each time a node
receives fresh data.

Let’s add two variables to the fever and
cold example—flu and pneumonia. A BBN

is typically drawn such that if a node is
beneath another and connected to it, it is
dependent on it—for example, a cold can
cause a fever, so the ‘fever’ node would be
above, connected to the ‘cold’ node
beneath. Now, for example, say we know
that pneumonia causes fever, and that flu
does not. If the patient contracts a fever,
data gets pumped into the ‘fever’ node.
The ‘pneumonia’ node is affected by this,
gets updated, and the ‘belief’ of the net-
work is set to new probability values—the
‘pneumonia’ node would now have a
higher probability associated with it. On
the other hand, the ‘flu’ node would not be
affected. Dependencies can also be

deduced by the system: if, often, the ‘flu’
node is often sent a value of ‘1’ just after

the ‘fever’ node is sent a value of ‘1’, the
system may deduce that fever causes flu.

Bayesian Learning is essentially the
process of the network changing its values,
based on the values that are pumped into
certain nodes. Each and every causal rela-
tionship need not be specified in a BBN:
the network can deduce likely dependen-
cies on its own.

A system called PicHunter gives a
flavour for how Bayes’ theorem can work
in real life. PicHunter finds a picture based
on certain parameters: a picture that
comes under a certain category, or a pic-
ture that looks like another, etc. Now, say
you want to find a picture that looks like
one of a certain dog. You look at some pic-
tures, and say ‘hot’ or ‘cold’, based on
whether the picture shown to you is sim-
ilar or not to the one you’re looking for.
A non-Bayesian system might analyse the
pictures you choose, and try and find the
one you’re looking for based only on that.
PicHunter finds a pattern in the sequence
of pictures you’ve been choosing, and
builds your profile. The problem is
changed from that of finding the picture
to the problem of building a user profile!
Once this user profile has been built, it’s
a matter of comparing it to PicHunter’s
model of what users would do if they
wanted a particular picture, and thus
delivering the correct picture.

Damn that spam!
Spam filtering is hot right now. It won’t be,
if Mr Gates’ proposal of ISPs charging a
penny per e-mail sent is implemented, but
that doesn’t seem likely—and so we have
a whole bunch of commercial and open-
source spam blockers, each claiming to be
the best. Several of these use BL as part of
their repertoire of methods. Anti-spam-
ming is ideally suited to BL, because it ➜

Researchers have found that adding lip
reading to conventional speech
recognition (SR) makes for better
accuracy, especially in noisy spaces.
And Intel has come up with software—
Audio Visual Speech Recognition
(AVSR)—which, combined with Intel’s
OpenCV computer vision library, lets SR
programmers build lip reading into
their software. The AVSR combined
with OpenCV can detect one face
amongst several, and observe that
person’s mouth movements.

Read My Lips

Intel’s new Probabilistic Networks Library
(PNL) and Open Source Machine Learn-
ing Library (OSML) are collections of
software using which computers might
be able to learn from experience. OSML
is free, and is available from Intel’s Web
site. Machine Learning (ML) is the disci-
pline dealing with, of course, machines
learning, and thus being able to make
predictions, among other things. And BL
is a methodology that’s being increas-
ingly embraced by ML folks.

OSML is basically a toolkit, which
incorporates Bayesian Learning methods,
for designers of computers 

and robots. The PNL and OSML can also
be used in enhancing applications, for
example, gene-database searching, and,
of course, spam classifying.

Using typical Bayesian phraseology,
David Tennenhouse, Intel’s Director of
Research, says, “Computers need to be
able to learn from their experiences with
users, and the world around them. Using
new statistical methods to identify key
patterns, these systems will start anticipat-
ing the needs of their users and pre-com-
puting responses to the most likely ques-
tions, so that the answers will be instantly
available the moment they are needed.”

Computers To Mature With Experience

An English
theologian, Thomas
Bayes was a
Presbyterian minister
who happened to
be a very good
mathematician. He
argued that the
existence of God could be deduced from
equations. He wrote an essay on his
theory of probability, which was
published by the Royal Society in 1764.
He also set out a method of deducing the
future from past events.

His findings and methods have
always been controversial. And Bayes'
theorem, as such, was not published
until after his death.

The Rev. Thomas Bayes
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involves patterns and predictions.
Accuracy is of paramount importance:

if you thought a filter with 99 per cent
accuracy is good enough, think again.
You’d rather wade through a hundred
spam e-mails a day than lose that impor-
tant e-mail from your boss, or worse still
have your boss classified as a spammer and
blocked without your knowledge. Spam
classifiers can botch things in two ways:
classifying non-spam as spam, called false
positives, and spam as non-spam, called
false negatives. The latter is certainly
preferable to the former; but we wouldn’t
want too many of either. Another problem
is that people tend to rely on and trust
their spam blocker too much, and to not
double-check those marked as spam, for
false positives. Accuracies, therefore, need
to reach something like 99.99 per cent.
Bayesian spam blockers learn from what
you tell them, improving their accuracy
every day.

Consider some of the things that make
Bayesian filters more effective than tradi-
tional techniques:

These filters see causal connections.
So, if the word ‘debt’ is evidence of spam,
but the phrase ‘get out of’ is not, Bayesian
filters would notice, all by themselves, that
e-mails with both these in them—as in ‘get
out of debt’—are spam.

They evolve with spam. As spammers’
techniques change the filter adapts. Even
if the spammer starts saying "Get 0ut of
debt"—with a zero instead of an ‘o’—the
filter would notice, because of the pattern
in the other letters.

Since they are aware of causal con-
nections, both ‘good’ words as well as
‘bad’ words contribute to the decision.

‘Gleeful’ or ‘Bayesian’ hardly occur in
spam, and this makes as much of a differ-
ence to the learning process as words such
as ‘debt’ or ‘xxx.’

Two open-source spam killers are
SpamBayes and PopFile. SpamBayes is dif-
ferent; in addition to ‘spam’ and ‘non-
spam,’ it can assign an ‘unsure’ classifica-
tion too—so there’s virtually no risk of

losing a good e-mail. PopFile uses a Naïve
Bayes classifier (NBC). An NBC operates
taking only two factors into account: the
number of spams you receive, and the
ratio of the probability of any word in the
dictionary occurring in spam versus that
of it occurring in non-spam. If ‘debt’
occurs with a 40 per cent chance in spam,
and with a 2 per cent chance in non-
spam, this ratio is 20. Surprisingly, even
using just these two factors, NBCs are 
very effective.

As an example of how effective
Bayesian searching and classification is,
consider these: Microsoft plans to incor-
porate Bayesian in Longhorn for search
and other functions. Netscape 7.1 includes
Bayesian anti-spam. AOL is now using
Bayesian to kill spam. Jim Nail, a Forrester
Research analyst, believes this is a more
sophisticated approach than others: “The
tools in the 9.0 release could be a major
improvement… I don’t think spam has
become a game-loser for AOL just yet.”
And Paul Graham, designer of the Arc lan-
guage and a major crusader in the spam
battle, says: “Of all the approaches to fight-
ing spam, from software to laws, I believe
Bayesian filtering will be the single most
effective.”

Bayesian everywhere
In biology, researchers are using Bayesian
to determine previously unsuspected cor-
relations between symptoms and diseases.
Also, searching through gene data, corre-
lations between genes and cell behaviour
have been found. Such correlations are
useful in cancer research, for example.

Bayesian prediction naturally finds
wide application in the fields of finance
and commerce. Stocks and shares are
unpredictable, and it’s intuitive that there
are hidden patterns at work, which makes
the stock market an ideal candidate for
Bayesian intervention. A real-world exam-
ple of a BBN at work in finance is Bayes-
Credit, which is used for predicting the risk
that a corporate will crash within a given
timeframe.

In addition to being
able to read people’s lips,
Bayesian learners can
also find what a sub-
tle change in a
person’s gait
can mean.
Certain
changes mean an
impending
s t roke ,

Microsoft’s Notification Platform (NP), part
of .NET, employs Bayesian techniques. The
NP will enable cell phones and computers
to automatically filter messages, schedule
meetings without human intervention,
and find the best strategy to contact
someone. An element of the NP called
Coördinate can gather data from
keyboards, personal calendars, sensor
cameras, etc, to create an entire ‘person
profile.’ In this profile, one can expect to
see the person’s schedules, the time and
duration of work hours and lunch hours,
what kind of messages he sends and
receives, and so on. The NP then uses this

profile to arrange for the best possible
time and place to deliver the information,
or notification.

Say you want to contact someone:
you get onto the NP, and declare that you
want to contact Mr X. The NP will first
identify you, then Mr X, decide whether
he’s busy or not, what kind of
communication he’ll prefer at this time of
the day, etc. It’ll then advise you of the
best mode and time to contact Mr X.

If the NP turns out to be a success,
‘context servers’ could be next: electronic
butlers that’ll help people organise their
information and their schedules.

He’s Probably In The Shower

APRIL 2004

I believe that 
probability is at
the foundation of 
any intelligence
in an uncertain
world where 
you can't know
everything

““
ERIC HORVITZ

Senior Researcher,
Microsoft Research
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researchers have found, and the person
can be warned. Along the same lines, a
security camera can feed a Bayesian learn-
er that can then learn to identify suspi-
cious persons at airports. For example, if
someone gets out of a car and waits
uncertainly for a long time before enter-
ing the terminal, it might mean a poten-
tial troublemaker.

Intel’s robotics branch has an ongoing
project that focuses on building Bayesian
control systems that will help create more
intelligent industrial robots. And robots
are being taught, in Bayesian fashion, to
navigate more effectively.

Bayesian inferences come in useful
where individuals need to make strategic
decisions of a certain kind repeatedly, for
example, pricing policies, or military
strategising. As the number of decisions
made increases, Bayesian inferencing
makes it easier and easier to make the next.

Bayesian is probably here to stay
Dr Marina Meila of the University of
Washington says, “Bayesian inference is
to statistics what the thermodynamical
laws are to physics”—not fitting in nice-

ly with the rules, somewhat startling, but
intuitive all the same.

It took centuries before Bayes’ rule
was conjoined with graphical methods 
to result in BBNs. And it’s taken years 
for BBNs and Bayesian reasoning and
learning to be taken as seriously as they
are today. This is partly because proba-
bilistic decision-making has been viewed
as something dark and untrustworthy.

In the mid 90s, ‘Fuzzy Logic’ was
much hyped; a phrase that was bandied
about as the method of choice for almost
any AI problem. Anyone talking loudly
about fuzzy logic was looked up to and
taken very seriously. Of course, fuzzy
logic is employed today in several prob-
lems, but there was more hype about it
than was warranted.

So are ‘Bayesian Learning’ and
‘Bayesian methods’ just buzzwords in
today’s AI and other scientific communi-
ties? Probably not. To quote Eric Horvitz
again, “This is a foundation… it was over-
looked for a while, but it is a foundation
for reasoning.”

RAM MOHAN RAO

ram_mohan@thinkdigit.com

http://www.gametheory.net/Mike/
applets/Bayes/Bayes.html
A cool applet that demonstrates Bayes’
Theorem. It enables you to answer the
question, "How worried should I be if I
tested positive for a particular disease?"

http://dmoz.org/Computers/
Artificial_Intelligence/Belief_Networks/
A comprehensive collection of links to
resources on Belief Nets, including BBNs.

http://excalibur.brc.uconn.edu/~baynet/
fieldedSystems.html
This page lists some real-world systems
that employ BBNs.

http://yudkowsky.net/bayes/bayes.html
An intuitive explanation of Bayesian 
reasoning, which provides a great 
non-technical understanding of how 
all things Bayesian work.

http://crm114.sourceforge.net/
All about the Controllable Regex 
Mutilator, or CRM114.

1/2 V AD
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Samsung ‘yepp’ YP-910GS Napster
Digital Audio Player
Yep, it rocks
Samsung’s newest portable music maker has 20 GB of
hard drive space, a built-in FM transmitter, and also acts
as a backup device. The yepp comes with built-in USB 2.0
support, and a charming feature—direct MP3 recording.
Connect the line-out from your tape player or LP and
make MP3s on the fly—no PC needed! And yes, yepp
connects seamlessly to the re-born Napster 2.0 service! 
Price: US$ 349.99

SoniqCast Aireo 
Peerless Wireless 

Armed with a 1.5 GB micro hard drive, a 1.5 GB capable Secure Digital (SD) slot,
an FM radio receiver and transmitter, the tiny Aireo supports MP3 and WMA,

and also doubles up as a storage device. Unlike others in its class, this SoniqCast
uses Wi-Fi connectivity to link to your playlist on your Wi-Fi enabled PC and
sync with it! Now doesn’t that tempt you to junk your iPod? Truly portable,

get it to sit at home on your tabletop or on your car’s dashboard. 
Price: US$ 300 (approx)

Altec Lansing InMotion iPod speakers 
iPod boom box 

Of course, you may well choose to keep your iPod and use this powered
add-on audio system to make it sound even better! The high-powered
amplifiers let you boom your mixes across the street, and the built-in

iPod dock means that you can use the sync and data transfer options as
well. With a total power of 4 W RMS, this pocket blaster may look tiny,

but makes a big sound. An added plus—run the system through the
power mains and charge your iPod as you hear it rock. 

Price: US$ 149

DDaanncciinngg
in the SSttrreeeett
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All you road warriors
out there—get set to
burn down the
highway with the best
in portable audio and
video this month



HandHeld Entertainment’s ZVUE! 
Personal Video Player  
Zounds! What videos!
This Motorola Dragonball-powered compact full colour video
playback device is made for all you video junkies out there. The
screen features a resolution of 160 x 234, with 24-bit colour. It’s also
compatible with SD and MultiMediaCards (MMC) cards. The TFT
LCD screen lets you view videos even in bright sunlight, at 15 fps. 
It features full MPEG4, compatibility and also has proprietary
format cards for secure video.  
Price: US$ 99

Roku SoundBridge Network 
Music Player M1000 
Tap the music, silently

Roku’s SoundBridge Network Music Player is made for
all those digital music junkies who need to stream

their Mac and PC-based files all over the house. No
moving parts here; it comes with 16 MB of DRAM, wired

Ethernet support as well as a slot for a Compact Flash Wi-Fi card to connect to your
Wi-Fi enabled PC. Connect this to your home theatre either through the optical

digital output or the coaxial digital output. Control the music through the infra-red
remote, or use a handy PC interface—either way, your music will follow you. 

Price: US$ 249.99

Archos AV380 Video Recorder,
with the AVCam 300 and DVR 100

Handy studio!
This feature-rich handheld will leave you gasping for

more audio and video. Its monstrous 80 GB hard
drive lets an incredible 250 hours of DVR video or

4,000 hours of audio recordings sit on it. View photos,
watch MPEG4 movies on its clear 3.8-inch TFT display or

connect it to a TV for large screen output. Connect the
AVCam 300 and shoot your own live videos, or use the
DVR 100 and record straight from a VCR. It also reads

the DivX and XviD video formats! 
Price: US$  899.95+ US$ 199.95 (AVCam 300) +  

US$ 59.95 (DVR 100)

Rosen Entertainment’s A9 All-In-One Mobile Video 
Video cruise control 
For road warriors, there’s nothing like this car roof-mounted Rosen that lets
you view DVDs as you drive down. Its drop-down bright 9-inch 16:9 wide
LCD screen is designed for easy viewing. The A9 also supports MP3 and CD
audio as well. Control everything through the included wireless remote.  
Price: US$ 1400 (approx)

▲ ▲

▲ ▲
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Pop in your ATM card and it takes
less than five seconds for the bank’s
computers to respond to your

request, but Yudhishthir Chede isn’t real-
ly thinking of that as he checks his
account and withdraws cash. If you bank
with HDFC, for instance, all the ATM,
Internet and phone banking queries that
you make worldwide are routed through
the core customer-banking database in
suburban Mumbai. In fact, with many
Indian banks today, it doesn’t matter
where you are, or how you choose to con-
nect—you always get service, anytime,
and just about everywhere. Welcome to
banking in the new millennium; the cus-
tomer is king here! 

Banking has moved a long way from
the 19th century. However, the kind of
services that we customers have come to
take for granted have been a recent phe-
nomenon as private and public sector
banks go all out to woo customers
with quality services. Even a
decade ago, you’d be standing
in a queue and waiting for
service; today, you conduct
transactions in seconds at
the press of a button or the
click of a mouse. 

Computerisation is 
working
“Automation has come
forth as a by-product of
business requirements,”
says V Chandrasekhar,
CTO, Bank of Baroda

(BoB), one of India’s largest public sector
banks.    

His bank has an enviable record, 
having been recognised internationally
for its remote banking services.
Microbanker Online magazine
awarded BoB the Best in Remote
Banking award in 2001. As a
matter of fact, banking opera-
tions today aren’t different
from those at cutting edge
network operations centres. 

At HDFC, for instance,
bankers manning the oper-
ations at their worldwide
data centre are technolo-
gists to the core.
They monitor
the centralised
banking data-
base, the core

BBaannkkiinngg
on tteecchhnnoollooggyy

Customers have
never had it this
good as banks go
all out to woo
them. A look at
what Indian banks
have on offer…

Atul Deshmukh
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banking system of the bank and ensure
that services are up round the clock all
day, all year long. 

Banking’s real push to reach out and
become more customer-friendly was
brought about by private sector banks,
who started by targeting customers who
maintained larger bank balances, and then
progressed to reaching out to large num-
bers of urban customers. 

All banks are moving towards setting
up core systems that will integrate their
retail and corporate banking operations,
and all associated services. Nationalised
banks are also computerising and consol-
idating their operations, and offering cus-
tomers the same levels of service that pri-
vate banks offer.

The bottomline—the only way to
retain your customer is to give them qual-
ity services. Consolidating all their oper-
ations around the core banking system
has meant that banks can now offer uni-
versal access to funds and other banking
services around the clock from anywhere
across the globe. 

You can access your account using an
ATM machine, the Internet, a phone, and
effectively, bank without walking into
your bank. How do customers find this?
Exciting at the very least… 

Anytime money
Bankers agree that ATMs are fast becom-
ing the main point for customers interac-
tion. A senior SBI official pointed out that
in certain branches, the load on the staff
has come down by almost 70 per cent. This
is a phenomenon that’s been happening
across banks. 

Private sector banks also see their cus-
tomers interacting through the ATM.
Today, ATMs offer you several services
besides cash withdrawals. Services that
Krishnan Raghavan, a software developer
in Mumbai, prefers to utilise often. “I real-
ly like the idea of ATMs,” he says, and
points out that most of his primary inter-
actions with the bank take place through
the ATM. He’s been banking with ICICI for
several years now and has absolutely no
complaints on any front. He withdraws
and deposits cash and cheques, monitors
his balance, and routinely takes bank state-
ments, all over the ATM. 

Ask him about any additional services
he would like to see, and he says he thinks
the tie-up of VSNL with ICICI, allowing
the bank’s customers to debit their
accounts directly to pay for their ISP
accounts, is pretty cool.  He goes on to say,
“I’d be using this service when I run out of
access time on my VSNL account. All I

have to do is go there and get the amount
debited, and then use the serial number on
the generated receipt to update the
account. Simple.”

Customer concerns
Customers do have their grouses though.
One of them is the ATM network. While
ICICI customers such as Raghavan are sat-
isfied with the ATM network, Citibank cus-
tomer, Yudhisthir Chede, isn’t too pleased
with the Citibank ATM network. “There’s
one located near IIT Bombay and the oth-
ers are quite a distance away”. Banks are
listening to customers like him; Citibank,
for instance, lets customers conduct trans-
actions a limited number of times from
other ATMs free of charge. HDFC has over

Blind computeri-
sation doesn’t
help; there has 

to be a carefully
charted out 
business strategy
to provide improved
services to 
customers

““
V CHANDRASEKHAR

Chief Technology Officer, 
Bank of Baroda

Private banks such as HDFC Bank have
started off by computerising all their
branches and networking them to the
core banking system. So, you can walk
into any branch and get your work
done. Most PSU banks have gone in for
computerisation at the branch level,
and have only now got down to net-
working individual branches and set-
ting up core banking systems. 

At Bank of Baroda, for instance, even as
the core banking system is being set up,
the individual networked banks work on a

smart solution.
During banking hours, the customer

communicates with the branch for any
ATM, Internet or phone banking
transactions. At the end of banking hours,
all this data is uploaded to a central
database, after which, till the start of the
next business day, the customer conducts
transactions with the central database. 

As the banks open the following day, 
all this data is transferred back to the
individual branches, which then update
their records. 

Core Banking for The Public Sector and 
Private Sector 
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850 ATMs, and BoB 140. However, ATM
alliances haven’t really matured, and
using another bank’s ATM almost always
invites a service charge, except for privi-
leged customers. 

Other concerns have more to do with
the limitations on the ATMs themselves.
Kiran Khade is a young businessman who
deals in timber, plywood and aluminum,
and his bank, Abhudaya Co-op Bank, han-
dles some of his business transactions. 

He prefers the ATM to walking into the
bank any day, but has a problem—he does-
n’t like the Rs 10,000-per-day limit
imposed on ATM transactions. He points
out that if he has to make larger cash pay-
ments, he either withdraws over two days
or pays a visit into the bank. Indeed, busi-
ness-related transactions are grossly limit-
ed by debit limits on the machines. 

However, most banks do score on serv-
ices offered. Chede regularly uses ATMs to
top up his pre-paid mobile phone credit,
and hasn’t bothered to hop into a store to
pick up recharge coupons—he can fill up
the amount of his choice at the ATM.
Overall, Chede is satisfied with the service
he gets, and has also opted for a credit card
from the same bank. 

What really impresses him about the
services is the quick response. Chede has
never had credit card bills coming in late,
and is gung-ho about banking in India.
“It’s definitely changed, banks have
become so people-friendly today as com-
pared to the old times,” he says.  

Net money
Internet banking is another place where
changing times have made a difference. 

Banks appear to be tripping over them-
selves to give users services over the Inter-
net. The initial level of service provided by
banks are, for instance, account checks and

getting balance statements, cheque book
orders, transfers to other accounts and so
on. Recently, several banks tied up with
billing companies to provide a uniform
interface to pay utility bills such as tele-
phone and power bills. 

At HDFC’s Net banking portal, for
instance, you can pay your mobile phone,
landline and electricity bills, and also pay
your LIC premiums and update your VSNL
account. Other features include setting up
a Demat account. You can also apply for a

loan by filling up forms online—the bank
contacts you for further information. 

There are other customer-friendly ini-
tiatives as well—for example, the
OneView service lets customers having
accounts with HDFC, Citibank, ICICI,
HSBC, Standard Chartered and Global
Trust Bank use a single window mode of
access for inspecting their account details.
This is an example of the ease of Internet
banking, where you can access various
accounts across six banks, and side-by-side
check out your credit card balance or the
balance in your Demat account.

Public sector banks, too, are providing
online banking features. For instance, SBI
lets you buy railway tickets at the Indian
Railways ticketing portal and pay directly
through your Net banking account; insti-
tutions such as IIT-Madras allow you to
pay tuition fees online through an SBI
Internet banking account. 

Yet there’s a fundamental problem
with adopting this. A senior MNC bank
IT manager pointed out that it’s prima-
rily ignorance, and the fear of weak secu-
rity, that keeps people away from using
Net banking. Customers aren’t always 
all that upbeat either—Kiran Khade, for
instance, doesn’t like the idea of
automating bill payments monthly
through the bank. “I wouldn’t know at
what point of time during the month my
bank balance goes down to zero”, he
jokes, and says that he is more comfort-
able signing cheques instead. 

Chede, on the other hand, enthusias-
tically uses Internet banking facilities such
as making drafts. “It is bit more expen-
sive,” he says, “but Citibank made it easi-
er for me by despatching the draft where I
needed to send it, saving me the time.”
Raghavan thinks that bill payments are a
great idea, and says he’d prefer doing that.
It also translates to additional revenues for
banks since every transaction done
through them benefits the banks finan-
cially, and there’s not a bank that isn’t
tom-toming it.

Calling for cash
Phone banking is as simple as dialling your
bank’s helpline number, authenticating,
and then accessing standard banking func-
tions such as procuring account state-
ments, making fund transfers, and asking
for cheque books and drafts. Banks also
allow you to set up mobile phone bank-
ing. With this, you can set up SMS alerts to
make account transactions and enquiries.
It’s a useful feature that comes out as a

PSU banks have had a two-fold
responsibility—one, to maintain their
financial health, and the other, to fulfill
the social obligation of letting customers
bank with them, regardless of the
profitability of the business, employing
large numbers of people. This has
typically meant that PSU banks have been
slow in computerising their work process,
typically because of their larger customer
base and internal staff strength. Owing to
social responsibility, PSU banks are forced
to maintain unprofitable branches in both

rural and urban areas. An SBI official told
us that 70 per cent of the profitable
business is conducted by 20 to 30 per
cent of the 9,000-odd branches. The
flight of customers hasn’t helped; now
PSU banks are gearing up to provide the
same level of retail-banking services that
private sector banks provide to keep their
customer base intact. It has also meant
that at this point of time, large amounts
of money (several hundred crores for each
bank) are being invested towards
consolidating their services. 

The PSU dilemma

I’m satisfied
with the kind 
of banking 
services that 
we have at 
our disposal
today—vastly 
different from 
the old days

““
YUDHISHTHIR CHEDE

Web Associate,  
TransWorks Information 
and Citibank customer

➜
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result of a “mature customer market,” as
Chandrasekhar would tell you. Chede reg-
ularly uses this—“It lets me monitor the
balance in my account,” he says, and
points out that at the cost of an SMS, he
can be anywhere and yet be checking back
with his bank. In fact, phone banking is
rapidly becoming a mode of interaction
that banks intend to promote; both BoB
and HDFC Bank for instance, goes a step
further by offering WAP banking.

Mobile phone banking services 
are network-dependent, though, and work
through tie-ups with mobile providers. 

Walking in
Ask customers when they last visited the
banks they maintain accounts with, and
they aren’t too sure. Take cash with-
drawals, and it’s a far cry, as V Chan-
drasekhar would himself say from the
times when encashing a cheque meant
spending at least an hour at the bank.

Raghavan says he visited ICICI’s
bank branch about six-odd months back,
to get some account details. “Other-
wise,” he quips, “I’d probably go there
to see the folks and keep in touch!”
There are some transactions where it’s
inevitable to head for the bank. For

instance, making an international fund
transfer is one. It works on a system
called the Society for Worldwide Inter-
change of Fund Transfer (SWIFT), where
a bank employee at one end enters the
transaction on a machine securely
linked to a bank at the other end. 

SWIFT merely needs the employee to
fill in the debiting and crediting account
details, and the transaction is complete.
Chandrasekhar points out there’s even
more automation along the way for bank-
ing operations. Bankers are excited about
the real time gross settlement (RTGS) that
will enable inter-bank fund transfers, tra-
ditionally routed through an Reserve
Bank of India (RBI) clearing-house, to
happen faster. 

RBI itself is spearheading the RTGS
implementation, and individual banks are
implementing it too. This means that the
RBI will maintain individual clearing
accounts with the participating banks and
hence enable faster transactions. As Chan-
drasekhar puts it, “For the customers, this
means quicker inter-bank fund transfers,
and for the banks, it’s a step towards paper-
less transactions.”

The future of banking is an interest-
ing study in prediction, yet there are ele-

ments already coming in. From the
banker’s side, the CTO of a large MNC
bank says, “I’d like to see all of our cus-
tomers using the bank’s Internet and
phone banking services to pay for any-
thing, be it groceries or school fees—it
benefits the customers and us”. 

For traditional bankers too, there’s a
reason to change. Chandrasekhar points
out that public sector banks have made
huge investments in human resources, and
now the front-office banking officer’s job
is fast changing from a clerical post to that
of an investment adviser. 

“I’d soon see my workforce advising
customers where to invest their money,”
he says,  “rather than just tell them details
of their accounts.” Banking services, as he
says, “are seeing an exciting phase of
change as we generate more revenues with
increased services, and with the tools of
modern banking, we can maintain our
social obligations and yet offer customers
quality services, second to none.” 

Indeed, it looks like the customers are
on a roll, on this wave of customer-orient-
ed services—as they go laughing all the
way to the ATM. 

SRINIVASAN RAMAKRISHNAN

srinivas_ramakrishnan@thinkdigit.com

When you interact through an
ATM, there’s a two step
validation process. First, the
ATM validates your card by
reading it in, after which the
customer authenticates it by
entering a Personal
Identification Number (PIN).
This immediately connects
you to the bank’s core
banking system, after which
you can conduct transactions.
The ATM communicates with
a local gateway through
secured links—either a leased
line or a satellite
communication link—which
forwards the request to the
central gateway, and from
there to the servers that
house the core banking
system. For Internet banking,
you log into the Internet
banking site with a username and
password. After authentication, the online
banking portal securely connects you to
the core banking system servers. Phone

banking works the same way, with
customers dialling up the bank, entering
details through the automated interface,
and then either conducting transactions

or talking to a banking official. Irrespective
of the mode of interaction, the customer
ultimately connects straight to the core
banking system.

How your buck moves

Local Gateway Servers

(passes transaction
to Core Banking
System) 
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To ensure that our readers have all the infor-
mation they need to make an informed buy-
ing decision, reviewers at the Digit Test Cen-

tre conduct comprehensive tests to evaluate the lat-
est hardware, software and technology services in
accordance with international standard evaluation
processes and methodologies. 

Our test results may be presented either as
Comparison Tests, or as individual reviews in the
Bazaar section. The representation of the results is
different for each in the interests of clarity, but the
test process for both is identical in all respects. 

Of all the products we test, only the best make
it to the A-List.

Comparison Tests
In the comparison tests, we compare the perform-
ance of products within a particular category. Each
product is evaluated under different parameters
such as performance, value for money, features,
ergonomics, etc. 

Weightages are then applied to the various test
parameters according to their importance for that
particular category of products. These weightages
are then used to arrive at scores for features,
ergonomics and performance for each individual
product. A detailed test process is included with
each comparison test, and explains the parameters
that were taken into consideration, along with
weightage allocation and reasons for the same.

In Bazaar
The evaluation of products in Bazaar also covers the
same parameters such as performance, ease of use,
value for money, build quality and features of the
product. 

Here, each of these parameters is rated on a
scale of 5, which is represented by arrows (->). 

The greater the number of arrows, the better
the product. This simple five-point rating system is
designed to give you an easy-to-interpret assess-
ment of a product. For example, a product that

receives a value for money score of five arrows 
signifies an outstanding buy. 

The Awards
Digit awards outstanding products by selecting 
a Best Performance and Best Value winner in 
each comparison test. The winner of the Best 
Performance Award will be the product that scored
the highest in the performance segment combined
with rest of the package including features,
ergonomics, bundled accessories etc. This award
represents the best performing product in our tests
in terms of the complete package that is offered to
a customer. The winner of the Best Value Award will
be the product that scores the highest in our value
for money parameter which is derived taking into
account the ratio of a product's ergonomics, per-
formance and features to its price. The product
winning this award offers a good combination of
performance and features at a great price. Since
value for money takes into account all scores for all
parameters including the price, this score will be
used to arrive at a grade (e.g. A+) for each product.

How we Test
It looks good and the technology is glitzy, but does it do the job?

Excellent: A brilliant combination of price, performance and features—far beyond 
expectations
Good: A good buy, better than most products in its category
Average: Reasonably competent but nothing spectacular about the product
Mediocre: Does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be used for its target
application

The 5-point Rating System used in Bazaar
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Quick! Tell us about some child-
hood memories. Ummm, ok.
Kindergarten? Yeah. Being pun-

ished in class for talking too much? Hide
and seek at the local playground? That was
fun. The do-it-yourself colouring book?

Cut to last week. You now have a job,
and your friend runs a small business. You
meet again, and you realise that the only
thing that still binds you to your child-
hood is colour. Does it really matter that you’re
a high-flying executive, or that your friend
runs a profitable SoHo business?

In school, you had to impress your teacher.
At work, you have to impress your boss or the
client. So, we come back to our basic premise—
no matter where you are, colour is more than
just a small component. And what better way
to express colour than a well-printed and well-
presented document. Colour printers are no
longer expensive marvels that sit in a corner,
with only the privileged few getting access. For
small, yet thriving businesses, printers are
indeed engines of growth.

To understand what printers would suit
small businesses, we tested five of the best
available in the Rs 6,000 to Rs 10,000 range.
What about a home user? For him, we

reviewed six colour printers in the range of
Rs 2,500 to Rs 5,000. Lexmark’s Z605 was the
cheapest, while Canon’s xnu i255 topped.

On the other hand, we haven’t concen-
trated on the ink cartridges, or consumables.
Let’s see why. The Lexmark Z605 printer costs
around Rs 2,500, while its cartridges cost
around Rs 1,800 for both black and colour.
Now, if you replace cartridges more than once,
you would be actually surpassing the cost at
which you brought the printer. It is better to go
in for refilled cartridges that are one-fourth the
cost or a new one. Or buy a new printer.

These apart, we reviewed three others that
could interface with a digital camera to take
printouts directly. Although HP and Canon are
strong in this particular segment, Canon has
the upper hand in compatibility. 

APRIL 2004
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Canon xnu i255
Designers touch 

In text printing mode, this entry-
level inkjet from Canon,

which replaces the older xnu
i320 model, was the fastest.
The USB 2.0 interface shows
its usefulness when printing
the same text file in best qual-
ity mode—it was twice as fast as the
others. Similarly, it printed the image file faster than any other
printer in this category. The Canon i255 uses two cartridges and
the black printout amounted to Rs 2.44 per page, whereas a
colour printout costs Rs 1.44 per page. 

On the print-quality front, it showed no jagged edges or
smudging. The photo output had good colour reproduction,
but overall it was dull and lacked the crispness shown by the 
HP printers. 

Some cosmetic changes have been done to the original
design, and it looks a lot better. The bright blue side panels of
the older design have been replaced by better-looking grey
panels. The Canon i255 comes with a foldable paper input tray
that provides enough paper support. The lack of an output tray
makes the design smaller. It was the only printer in this cate-
gory to support USB 2.0.

Installing the printer is quite simple. All you need to do is
connect it to the USB port and install the driver from the
accompanying CD-ROM. The maintenance tab, in the Printer
Properties dialog box, allows you to clean the cartridges, align
the print head as well as switch off the printer via software.
The status monitor was always wrong when displaying the
amount of remaining ink. 

Priced at Rs 4,500, the Canon xnu i255 is expensive, but if
you need a quality printer, this 
is it!

Epson Stylus C43SX
The last parallel samurai

The Epson Stylus C43SX is a spruced up version of the older
C41SX. Available with both the USB and parallel interfaces,

the one reviewed here is the parallel version—indicated by the
suffix ‘SX’.

As we expected, it was the slowest, a clear indication of its
legacy interface. The Epson C43SX took nearly double the time
to print text documents as compared to other printers. While
printing combi-documents, it was able to beat some of the

+ Great quality printouts and looks
good
- No output paper tray

Epson Stylus C63
A mate for the desk

The Epson Stylus C63 was a little
slower than its younger sibling—

the C43SX—in most of our tests. In
text printing, it’s reasonably fast,
finishing second after the Canon i255.
However, in all the other tests it lagged
way behind the i255.

Both the printers from Epson perform below par when it
comes to quality, but the C63 is better than the C43SX. The text
does show jagged edges and smudging, but only to a small extent.
Photo printouts reproduced every minute detail properly;
however, the image just didn’t seem vivid enough. The cost per
black page comes to Rs 3.50, and a colour page costs Rs 2.

The Epson C63 uses four separate cartridges, which is good,

better-configured printers. It took twice the time to print the
test photo when compared to the HP and Canon, but was
much better than the Lexmark Z605. 

Quality-wise, the Epson C43SX was a complete letdown.
Despite the rise in its optimised resolution, it couldn’t match the
print quality displayed by the Canon and HP printers. Jagged
edges and smudging were clearly visible. The photo prints were
good, with true colour reproduction, but were too bright. The
cost for a black page came to about Rs 3.27, and the colour page
translates into Rs 2.08 per page.

This model has undergone absolutely no cosmetic change
compared to the Epson C41SX, and still offers the same, dated
design. Nevertheless, the use of translucent plastic for the 
cartridge bay and output tray accentuate the otherwise dull
looks. The top-loading paper tray can hold about 100 sheets,
and the output tray does a good job of holding the printed
papers together. 

Installing the printer is quite simple and requires
the accompanying parallel cable to be
hooked on to the computer before you
install the driver. Comparatively, the
driver installation is not as intuitive as
the ones from HP or Canon, but defi-
nitely not difficult either. The driver
allows for cleaning and maintenance of
ink cartridges, and the ink status indicator is fairly accu-
rate. 

Priced at Rs 3,250, The Epson Stylus C43SX is one of the
cheapest printers available. Given the dated interface this
printer has, it’s the only available choice for people with legacy
computers. However, do keep in mind the average print qual-
ity that is on offer. 

+ Offers legacy parallel port
- Below par printing quality

H ome Printers

Epson Stylus C43SX

Performance
Features
Build quality
Value for money
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Canon xnu i255

Performance
Features
Build quality
Value of money
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HP Deskjet 3550
The hippie

The HP Deskjet 3550 was neck and neck with the
Canon xnu i255 in dishing out prints. In text

printout at normal mode,
the 3550 was faster than
the i255 by 4 seconds.
However, when the
same file was printed
in Best mode, the HP
3550 was almost four
times slower than the
Canon i255, the reason
being its USB 2.0 interface.
Similarly, when the combi-document was printed in Normal
mode, the HP 3550 did the job faster, but was beaten by the
Canon i255 in Best printing mode.

One thing that will scare away potential buyers is the cost
per page. A single black page sets you back by Rs 6, and a colour
page works out to about Rs 4.

Both the HP 3550 and the Canon i255 set themselves apart
from the rest of the crowd when it comes to print quality. The
printed text document is as good as the ones from laser print-
ers. Images printed from the HP 3550 were crisp, vibrant and
all colours were reproduced truly. Contrast and brightness were
optimum, despite the fact that no image enhancements from
the driver were used.

The successor to the HP 3325, the HP 3550 comes very close
to being the ideal home printer. Smaller than the Canon i255, the
HP 3550 is better engineered. While Canon sacrificed on several
functional things, such as the output tray on its i255, HP has
built the 3550 to be small, but fully functional.

With the off-white and grey plastic panel, this printer had
the best looks amongst all those compared. The foldable paper
input tray tucks away under the ink cartridge bay. The same
tray also functions as the output tray, and hence, human inter-

because you can replace only the cartridge that runs out first. 
It comes with specially-formulated ink that Epson claims to be
water-resistant, and fade-resistant up to 80 years. A slight 
accident in the Test Centre proved that the printouts really are
water-resistant.

The drivers are full-fledged, and allow for maintenance of
the cartridges, etc. Another nice feature is support for both the
parallel and USB interfaces.

It has a foldable paper-out tray, which fits nicely with the
body when folded back. The translucent cartridge bay flap hides
the cartridges, and also adds a touch of style to the otherwise
bland plastic body. The paper capacity is around 120 sheets.

At Rs. 4,750, it’s the most expensive in this segment. If 
you need a printer with decent output quality, and one that 
can do bulk text prints, look for the Epson Stylus C63 as a poten-
tial deskmate.

HP Deskjet 3650 
Face Off!

The HP Deskjet 3650 was no firecracker when it came to
pure speed, but met the best of the crowd at eye-level. It

was better than the HP 3550 in the text, combi-document and
image printout speed tests. However, it certainly is no match
to the superior Canon i255 that beat the hide out of it
when it comes to printing heavy docu-
ments such as the image
printout. 

Quality was one aspect
where the HP 3550 beat the
HP 3650 hands down.
Whether it’s text documents
or a full blown image printout, the
HP 3550 yields better prints than the HP 3650.
Both the printers reproduced every minute detail of the test
photograph. The only parameter where the HP 3550 beat it is
in colour reproduction. Like its younger sibling, the HP 3650
is an ink guzzler, and a single page of black will cost you Rs
4.50; a colour page costs Rs 4.

The HP 3650 attempts to look like a SoHo printer—every-
thing right from the colour to the design, attempts to imitate
a business look. But this attempt to be an office solution stops
with its looks—the paper capacity of only 100 sheets and its
features sends it back to the home segment. It comes with
separate foldable paper tray for input and output, which neatly
tucks away inside the cartridge bay. The separate output paper
tray solves the paper problem associated with the HP 3550.
Like its younger sibling, the HP 3650 interfaces with the PC via
USB 1.1. 

Installation was a breeze with no hassles. The driver
remains the same for both the printers, as do the utilities that
come bundled with them. The ink-status monitor is accurate. 

Priced at Rs 3,999, the HP Deskjet 3650 offers good looks,
decent performance and equally good print quality. But 
the Rs 1,000 difference between its price and that of the 
HP 3550 just for the design 
is unjustifiable. 

+ Great looks and decent output
- Tad expensive for its features

+ Good features, water-resistant ink
- Just decent quality printouts, a tad
expensive

Epson Stylus C63

Performance
Features
Build quality
Overall

CC

HP Deskjet 3650 

Performance
Features
Ease of use
Value for money

C+C+

vention is required at times to separate printed papers from
blank ones. The HP 3550 supports the USB 1.1 interface, but
not the parallel interface. Installing the printer is easy, and the
drivers offer good functionality. The ink-status monitor is the
best amongst the lot in terms of accuracy and legibility.

Priced at Rs 2,999 plus taxes, the HP Deskjet 3550 is a good
buy, considering its all round capabilities in terms of perform-
ance and quality, but do bear in mind that it has a high
running cost. For a home where printing is irregular, this
printer will do the job best. 

+ Quite cheap, good photo-printing
capability
- High cost per page

HP Deskjet 3550

Performance
Features
Build quality
Overall

BB
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Our test-bed comprised a Pentium 4 3.2 GHz processor
plugged onto an Intel 875PBZ motherboard, with 512 MB of
Corsair 400 MHz DDR RAM, an MSI Ti4800 display card and a
40 GB 7,200 rpm ATA IV Seagate Barracuda hard disk. We used
Windows XP with SP1 as the OS. The system was loaded with
all the latest chipset and graphics drivers. We also installed the
USB patch for XP, and connected the devices on the USB 2.0
port for optimum performance. Across the tests, we used paper
as shown below.   

Having established
the three areas—home,
SoHo and ‘graphics
and professional’
printing to evaluate
the printers, we
decided to further
define these areas

according to the printing qualities and feature sets available.
The graph below shows the individual weightages assigned

to the features set, the print speed, quality and cost per page
for all the three areas. The ideal home solution would therefore

be a printer
that gave
decent
speeds for
both text
and images,
and decent

photo printouts, while still being affordable—in the range of
Rs 3,000 to Rs 5,000.

In the SoHo category, we assigned equal weightages for
speed and quality. This was done with the assumption that in a
typical office, a perfect balance of speed and quality is needed,
along with features such as two-sided printing, ink status
reports through the driver, a larger buffer memory, etc.

Coming to graphics and professional printing solutions, the
score split was the same as for office printers, with one
difference: In terms of performance, output quality was given
more importance than speed.

We tested all the printers on the same test benchmarks.
These comprised a text document, a combi-document and an
image file. These documents incorporate every small detail that
a printer might need to reproduce—the smallest-point text and
lines, the specular effect (shine) on metal, etc.

The combi-document had text with varying points: lines
drawn inside a circle, seven colour bars of decreasing gradient,
and a small picture at one corner. Each of these sub-sections
tests a printer’s ability to reproduce details. Varying-point text
size tests its ability to reproduce the smallest possible text, that
is, the spatial resolution of the printer. The circle of lines tests
whether the printer can reproduce lines without jarring edges.
Similarly, the seven-colour bar test gauges the colour
reproduction capabilities of the cartridges.

The image document, too, was made up of several
elements, with areas of varying contrast and brightness.  This
tests a printer’s colour reproduction capability on photo paper.

The text and the combi-document were printed at Normal
and Best quality settings, whereas for the image file, we used
only the Best quality setting.

How We Tested

GSM: Grams per square metre
NovaJet: A widely available photo paper
brand for inkjets

Tests
Normal tests
Photograph printing
Cost per page test

Paper Used
100 GSM
NovaJet 130 GSM
75 GSM
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Lexmark Z605
Couch potato

The Z605 is the only printer from Lexmark to take part in this
shootout. It was the slowest when it came to printing, but has

definitely improved over the previous models. In the text printing
in normal mode, it matched the Canon i255. In the other tests, it

was a slow coach. It took almost 25 minutes to print
the image, whereas the average time taken by the oth-
ers was around seven minutes. 

The print quality has improved vastly
over the year, and this one betters the

Epson C43SX in this department.
Jagged edges and smudging were visi-

ble, but to a very low extent. The details
in the photos were reproduced

perfectly, but the final printout was
overly red. As far as cost per page

goes, the Z605 is right up there with the ones from HP—a bad thing.
As compared to last year, the Lexmark Z605 shows a quantum

leap for Lexmark in terms of performance and quality, but still has
a long way to go.

The Lexmark Z605 has evolved from a pedigree of products
that sported elegant looks. The use of a light and dark grey panel
gives it an identity of its own. The design cues are classic Euro-

pean—simple, elegant yet sophisticated. 
The Lexmark Z605 comes with a 100-paper capacity top load-

ing paper tray. The output paper tray extends out of the main body
and spans enough to hold the printed papers in place. The cartridge
holders are flimsy and you have to be careful when installing them.
The printer installation was easy. The driver pack, among the best
in the business, is quite intuitive. The printer switches itself off
when the PC is switched off.

Priced at Rs 2,599 plus taxes, the Lexmark Z605 is the cheapest
inkjet printer around. As far as
recommendations go, there are
better printers around that cost a
tad more, but are faster and better.

+ Good design
- Slow

Lexmark Z605

Performance
Features
Build quality
Value for money
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Interface
Input buffer 
Paper capacity input tray 
Max document size supported
Data cable included
Accuracy of ink tanks status through driver (S05)*
Special features
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Text print - Normal
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Combi-document- Normal
Combi-document - Best
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CCaannoonn
xnu i255

Thermal Inkjet
600 x 600

USB 2.0
NA
100 
A4 

USB 
2.5

None

22
37
95
182
217

4
3.4
3.3
2.8

2.48
1.92
395
745

68.92
7.5

76.42
2.39

3,995

EEppssoonn
Stylus C43SX

Piezoelectric
2880 x 720

Parallel
12KB
100 
A4 

Parallel 
3

None

40
77
121
236
614

2.5
3.2
3.1
2.8

3.27
2.08
490
770

53.91
6.2

60.11
2.31

3,250

EEppssoonn
Stylus C63

Piezoelectric
5760 x 1440

USB / Parallel
32 KB

120 
A4

USB 
3

Durabrite ink

30
44
132
249
616

2.5
3.3
3.4
3

3.48
2.21
695
1185

57.05
9.2

66.25
1.74

4,750

HHPP
Deskjet 3650

Thermal Inkjet
600 x 600

USB
NA
100 
A4 

USB
4

None

19
138
66

322
387

3.75
3.4
3.18
3.3

4.85
3.67
800
1100

58.60
8.6

67.20
2.10

3,999

HHPP
Deskjet 3550

Thermal Inkjet
600 x 600

USB
NA
100
A4 

USB 
4

None

18
140
72
148
395

3.75
3.4
3.4
3.5

5.93
3.93
800
1100

60.80
8.6

69.40
2.89

2,999

LLeexxmmaarrkk  
Z605

Thermal Inkjet
2400 x 1200

USB
NA
100 
A4 

USB
3.5

Automatic OFF

22
157
139
349
1514

3
3.3

3.27
3.03

5.59
2.28
850
950

51.51
8.4

59.91
2.88

2,599

HOME PRINTERS





Canon i455
Born in a studio

Only the Canon i455’s elder sibling overshadowed its
performance in the speed tests. It’s faster than a tracer

bullet when printing text in both Normal as well as Best modes.
As for cost-per-page, both a black as well as a colour printout
will cost you around Rs 2.50—quite decent if not near-perfect.

It also does
not compromise
on quality. The
printed text was
crisp and clear,
matching the
ones from HP. It
also reproduced
minute details in

the combi-document perfectly. It does
a reasonably good job at printing
photographs, but falls short of repro-
ducing the exact tonal balance, with
the yellow spectrum predominant in 
the output.  

The Canon i455 is an entry-level
SoHo inkjet printer that integrates
good features and performance 
in a small package. The design is
refreshing and cuts away from the
older mould.

The steep foldable front hides a
translucent plastic tray that extends
to serve as an output paper tray. You
need to clip the input paper tray to
the back of the Canon i455. It holds
100 paper sheets. A unique feature is
the presence of the new Pictbridge
port that lets it connect directly to a
digicam sans any PC intervention.
However, one can only control the
preferences offered by the camera,
since the printer has no controls to do
so. The Canon i455 uses the two
cartridge system, so if you run out of,
say, yellow, you’re going to have to
buy a new colour cartridge.

Installation takes hardly any
time—pop in the CD-ROM, install 

the drivers and connect the Canon i455
to the PC when prompted to do so.
While printing, it displays the print 
job status as well as the current ink-
level. The only grouse about the other-
wise decent driver was its inaccurate
ink-level measurement.

At Rs 7,995, the Canon i455 is way
too expensive, as better models are avail-
able for less.

S OHO Printers

+ Compact body and attractive design
- Expensive for its features

Canon i455

Performance
Features
Build quality
Value for money

B-B-

PictBridge is a technology developed by
Camera and Imaging Product Association
(CIPA) in Japan, to connect digital cameras
and printer, eliminating the need for a PC.
PictBridge ready cameras and printers can
be connected over a USB interface, and
images printed directly. You can tweak the
settings of the image from the printer itself.
Earlier, some printers could print the camera
input directly, but they were compatible
only with specific camera models. 

Many camera and printer vendors
such as HP, Epson, Lexmark and Kodak
are yet to register with CIPA for the
PictBridge protocol.  

With PictBridge, the advantages are
many. You can print images displayed on

the camera, or select a portion of an image
and print it. You can also print one or
multiple copies of an image, as well as
define the size of the print from the printer
itself, before printing it out. 

Once connected to a PictBridge-
compliant printer, the camera displays
connection-establishment messages and
also displays a progress bar when printing. 

Companies such as Canon, Sony, Sanyo,
Samsung, Fuji, Nikon, and Olympus have
their products PictBridge-certified. Visit
http://www.cipa.jp/pictbridge/CertifiedMode
ls/PictBridgeCertifiedModels_E.html for a
complete list of PictBridge-certified
products. Interestingly, no American or
European vendor is on that list.

PictBridge

APRIL 200455
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Canon i560
Blazing cannon

The Canon i560 broke all the
speed records that were

established thus far. The text
printout shot out in an aston-
ishing 11 seconds—the best
registered till date had been 14
seconds. The test photo, too, zoomed out in a quick 141 seconds. 

With such speeds we expected print quality to diminish, but
surprisingly, the Canon i560 set the benchmarks for the other
printers. Not even the upmarket Canon i905D could match its
quality. The only printer that came close was the HP 5160.
However, when it comes to photograph printing, it still seems to
be HP’s playground—they beat all the printers on this turf, and
the Canon i560 was no exception.

The printer is beautifully designed to hide away its expanses.
It is bound to appeal to those worrying about an impeccable décor.

Its well-crafted dimensions ensure that it doesn’t take up too
much desk space. The areas near the extendable paper trays are
well protected by plastic panels that act as dust caps. The Pictbridge
port is in the front. There are no controls to set the preferences for
the Pictbridge function; these can be set via the controls on the
digital camera.

The Canon i560 comes with four ink tanks, and hence, is more
cost effective in the long run, since you can replace only the
cartridge that runs out first. On the cost-per-page analysis, a black
ink printout will cost you around Rs 2 whereas a colour printout
will lighten your pocket by Rs 2.50. Installation of the printer was
a no-sweat affair. Drivers loaded perfectly, and allowed complete
control over the printer’s settings and preferences.

Priced at Rs 9,995, the Canon i560 is definitely worth the
money. If you need an exceptionally fast printer and your work
pertains to text and combo-
documents, buy the i560—it
will deliver.

Epson Stylus Photo
830 
Six colours, zero appeal

Speed-wise, the Epson Stylus Photo 830 is stuck in
the middle—the Canon printers are too fast for the

Epson 830 to catch up with and the HPs were too slow
to give it competition. However, it got

beaten black and blue when printing
photographs—it took around 10
minutes to complete the job; in
contrast, the Canon i560 took 2
minutes to do so.

Despite its claims of a 5,760 dpi
resolution, we found it lacking in the

photo-printing department by a huge margin. The printed text
was smudged and jagged along the edges and way behind the
standards set by the Canon i455 and i560. The photograph was
very detailed with every small area highlighted. The photo
colours had too much of contrast, making them look surreal
rather than natural.

The Epson 830 is quite bulky, and requires sizeable desk
space. The design is classic Epson. The paper-feeding mechanism
is top- loading and has to be guarded against dust. The input
tray holds 100 A4 sheets. The three control buttons are placed
on the top for easy access. The two-cartridge system uses a black
cartridge and one comprising 5 colours. The integrated colour
cartridge is a bad idea since running out of one colour will mean
replacing the entire module. 

It has a photo cartridge, wherein you have six colours as
opposed to the four in a regular inkjet printer. This feature
should have brought better colour reproduction capability, 
but it didn’t. Our black page
printout cost us Rs 3 and the
colour Rs 2. 

+ Class-leading print speeds
- None

- Slow
- Lacks quality output

Epson Stylus Photo 830 

Performance
Features
Build quality
Value for money
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Canon i560

Performance
Features
Build quality
Value for money
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Bleed: The outer region of the page that falls outside the
printing range of the printer.
Buffer: This is the memory within the printer that stores data
from the PC until it’s printed. Currently, this varies from 16 KB
to 16 MB. The greater the buffer, the better is the handling of
large print jobs. 
CMYK: This is an acronynm for the four-colour process printing
industry standard for cyan, magenta, yellow and black. By
combining these four colours, a printer can print all possible
colours. Some newer printers use a six-cartridge concept—with
a lighter version of cyan and magenta each.
Colour Balance: This term refers to the correct combination of
cyan, magenta and yellow required to reproduce the colours of
the original scene or object.
DPI: Dots per inch is a measure of the number of dots printed
per square inch. For example, a 300 dpi printer produces
90,000 dots in a square inch. Higher dpi values produce
sharper printouts—the minimum dpi supported by any printer
today is 600.
Duplexing: This process helps you print on both sides of a
page, thus reducing wastage of paper. These days, many
printers come with this utility.
International paper sizes: The International Standards
Organisation (ISO) categorises paper into three sizes: A, B and
C. Series A is used for general printing, Series B for posters and
charts, while Series C stands for envelopes and stationery. A
detailed report on paper sizes is available at http://www.cl.cam.
ac.uk/~mgk25/iso-paper.html
PostScript: This is a page-description language. It instructs the
printer about where to place ink. PostScript was invented by
Adobe. Currently in version 3, it supports complex page
layouts and provides excellent quality. PostScript has become
the de facto standard in imaging technology.

Jargon buster
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Printing large documents can really be a cumbersome task, espe-
cially if your establishment is on a big cost-cutting drive and you
have to print on both sides of the sheets. The actual procedure is
long drawn—print one sheet, take it out, reverse it, place it back
into the feed tray and print on the opposite side. 

A faster alternative would be to print out the even-numbered
pages first on one side, and then invert the entire stack to print
the odd-numbered pages. This requires relatively lesser attention
and work from the user’s perspective. However, in single-turn as
well as stack-turn manual-duplexing, the process of switching the
sheets around can cause the paper to crumple, leading to further
problems such as paper misfeeds, and paper jams. To avoid this,
printer manufacturers provide secondary duplexing units, such as
the one shown below, which when attached to the main printer

unit, completely auto-
mates the duplexing
process. The 
duplexing attach-
ment usually sits very
conveniently at the
back of the printer,

and doesn’t require any
separate calibration and driver instal-

lation. To actually begin printing on both sides,
there are a couple of things that need to be enabled in

the properties settings of the printer. 

Go to Control Panel,
right-click the printer

driver and select Properties.
Next, switch to the General
tab and click on Printing Pref-
erences. 

In the new dialog box
that pops up, click on

the Features tab. Now, enable
‘Two-sided Printing’ and tick
the box just below to enable

automatic duplexing. 
So now while printing on

both sides, after completing
one side, instead of dropping
into the output tray, the
sheet gets retracted auto-
matically back into the print-
er to print on its other side.
At this point, the only thing
that you need to do is
remind yourself not to pull
the paper out! 

Duplex printing

Canon i905D
Expensive hardware

The Canon i905D is a slightly slower than Canon’s other mod-
els, such as the Canon i455 and the Canon i560. Text print-

ing somehow doesn’t go well with the Canon i905D, but it’s fast
when it comes to printing photographs.

The print quality of text output was ordinary, going by the
standards set by the Canon i560 and Canon i455. There was some
smudging and jaggedness near the edges of characters. But when
it came to images, each minute detail was reproduced with near-
perfect quality. The tonal balance was excellent, except for the
yellow spectrum. Even then, the photos aren’t as good as those
printed by the HP Photosmart 7960. A colour printout will set you
back by Rs 4, and a text page will cost you Rs 2.

The Canon i905D can be hooked to a PC via USB. It uses the
six-individual-cartridge system, which makes for savings on ink as
well as great photo reproduction. You can connect a digicam

directly to the Canon
i950D without the need
for an intervening PC.
The driver has several
tweaking options,
such as noise reduc-
tion, image enhanc-
ing, etc. The ink-level
monitor is rather inaccurate. 

The printer is compact. The external paper trays folds for a
clean look, but are flimsy and more cosmetic than functional.
The control panel comprises an LCD display with a jog dial. 
The display shows all menus, from where one can choose 
from almost all options, such as paper size, ink mode, etc. It also
comes with a 5-in-1 memory card reader. Other accessories such
as CD-face printing adapter and a 4x6 photo printing adapter
come bundled.

At Rs 21,995, the Canon i905D is an expensive piece of hard-
ware. Exclusivity of features makes it stand out from the crowd, but
the output quality does not
justify the price tag.

+ Feature-rich 
- Quite expensive as a package

G raphics Professional s

Canon i905D

Performance
Features
Build quality
Value for money
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When it comes to printing
speed, the Epson Photo 900

beats both the HP and the
Canon hands down. This goes
for both text as well as images.
And in print quality, the Epson
is at par with Canon’s i905D,
in terms of text—you can clear-
ly see jagged edges and smudging.
Combi-documents with many colours are vivid and crisp, thanks
to the six colour cartridges. The Epson 900 is good at reproducing
details, but tonal balance goes for a complete toss. There’s too
much contrast in photos, which therefore seem too dark. A black
printout will cost you Rs 4.60, whereas a colour page is Rs 3.

This printer’s six colours are packed in two cartridges. Unlike
the other two products in this category, the Epson 900 is not a true
photo printer. You can’t connect a digicam directly, nor does it
have a multi-memory card reader. However, there are quite a few
handy features, such as the CD-face printing tray. There’s also an
attachment for paper rolls.

The printer is bulky for its features; also, the input paper tray
is an external attachment rather than an extendable one. The
buttons are on the front, which makes them less accessible.

At Rs 14,495, the Epson Stylus Photo 900 is no match for HP’s
Photosmart 7960, which is 
Rs 3,000 more, but turns up
results better on every front.

+ Relatively inexpensive 
- Average-quality printouts

Epson Stylus Photo 900

Performance
Features
Build quality
Value for money

AA

1/2 V
HP Photosmart 7960
Picture perfect

The HP Photosmart 7960 is a fire-
cracker when it comes to text

printout, and leaves the competi-
tors biting the dust. But despite
the mammoth 16 MB of internal
memory, the printer is slower
than the Canon and Epson mod-
els. However, the marginal differ-
ence does tilt in favour of the HP
7960, because of the quality aspect.
Printout quality is really good, whether it’s text or images. The pho-
tograph we printed was reproduced without loss of details; moreover,
the tonal balance was perfect, with true skin tones. 

A black printout costs Rs 3, and a colour printout Rs 2.50—quite
reasonable considering the quality. There are more colour 
cartridges with additional shades, so photos are more vivid, with great
contrast. 

The HP 7960 has a memory card reader that allows you to plug
in almost any type of compact storage device. Also, if you have an HP
digital camera, you can print directly from the camera. The printer
uses three cartridges—two are regular cartridges, and the third is the

Epson Stylus Photo 900
Fast forward
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We used the HP Photosmart 7960 to take a brief look at the printing
options provided with the printer driver.

The HP Digital
Photography Options is under
the ‘Paper/Quality’ tab. It
provides useful tools such as
red-eye removal, smoothing
and digital flash.

If you want to print with
text on facing sides, enable
‘Print on Both Sides’ in the
‘Finishing’ tab.  Enable ‘Flip
Pages Up’ to create a calendar-
like book. There’s also a

selection mode for booklet layout, that lets you print two sheets on a
page: After printing is done,
fold the pages at the centre,
and staple them together.

If you need to print several
sheets on one page, just select
the number from the
dropdown box at ‘Pages 
Per Sheet.’ You can also
specify the order in which
pages prints.

To enlarge a page, you
need to select one option from 2 x 2 (4 sheets), 3 x 3 (9 sheets), and

so on. Once your
document is printed in the
enlarged format, staple up
the individual sheets.

The Effects tab provides
resizing as well as
watermarking options.
Enabling ‘Scale to Fit’
rescales your image to fit
the page. Insert a

watermark too—the available ones are ‘DO NOT COPY’, ‘TOP
SECRET’, etc.

The ‘Advanced options’
helps you control ink
consumption and drying
time, so a sheet isn’t
released until the ink’s
dried.

The ‘Color’ tab lets you
control ‘Color Options’ and
‘Color Attributes,’ such as
printing in greyscale,
saturation, etc.

Settings Galore

Canon
Canon India Ltd

(011) 26806572
rajeev.singh@
canon.co.in

www.canon.co.in

HP
Hewlett-Packard India Ltd 

(1600) 444999 (toll free) 
seema.dawar@hp.com 

www.hp.com

Samsung
Samsung Electronics 

India Information & Telecommunication Ltd 
(011) 51511234 

farrukh@samsungindia.com 

www.samsungindia.com

Epson
Epson India Ltd 

(022) 28261515 
bertha@eid.epson.co.in 

www.epson.co.in

Lexmark
Computer Track 

(022) 25362479 
ctrack@hotmail.com 

www.lexmark.com

photo cartridge, containing additional colour shades. Ink level
monitoring is accurate.

The printer takes up a lot of desk space. The build quality 
of the flaps and paper trays are good. It has a crystal-clear 
LCD that displays the image to be printed, and the menu 
structure. Dedicated buttons are available for zoom, resize, rotate,
etc, making the printing process easy—you don’t need to go
through any menus.

Priced at Rs 16,999, the HP
Photosmart 7960 is a good propo-
sition if you need great photos.

+ Excellent at photo printing
- Lacks direct camera attachment for
non-HP cameras

HP Photosmart 7960

Performance
Features
Build quality
Value for money

AA

HP touched US$3 billion in revenues from consumables (or
cartridges) in 2002. This figure would have been higher if not for
the refilling of cartridges, which remains a big business despite
efforts by vendors to discourage it—by attempting to educate
channel partners and users through articles and advertisements.
The volume of ads in the print media speaks for the spread and
acceptance of the business.

Vendors say refilled cartridges give low-quality prints, damage
print heads, and, if leakage occurs, damage other parts.
Warranties are also void if refills are used. But Praveen
Khandelwal, Director of LIPAP Systems, which sells refill kits and
provide refill services, claims, in typical fashion, that their ink is as
good as the original, and that it’s harmless. As far as quality is
concerned, it depends entirely on the ink used and quality differs
from refiller to refiller.

To counter refilling, Epson in the US, installed smart chips in
one of its models—the Epson Stylus C60—that lock the printer
once the cartridges are empty, or if the printer doesn’t have an
original supply. While Epson claims that by doing this it
encourages users to use the original cartridge supply, customer
reactions have been negative. 

We contacted a local refill service provider. His prices for black
and colour cartridges for the HP DeskJet 990CXi were just Rs 100
and 400 respectively. Also, refilling would take only half an hour.
Using a refill kit is even cheaper, but time-consuming and messy.

Cartridges can’t be refilled more than three or four times—the
quality drop is significant, and the chances of damage increase.
But, a cartridge set for, say, the HP Deskjet 3350 costs Rs 1,900,
and the printer with its free cartridge set costs only Rs 3,000.
Refillers, therefore, say that it makes more sense to buy a new
printer, if you insist on original cartridges.
If you’d like to know how exactly to refill a cartridge all by
yourself, be on the lookout for the May issue of Digit.

Refilling Cartridges

Use the HP Digital Photography
options to tweak images

Set the colour attributes here

Manage your resources by controlling
these features

Resize your image to fit the media, in the
Effects tab
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Conclusion
For the home segment, our Best Perfor-
mance vote goes to the Canon xnu i255
printer for its good performance, rea-
sonable number of features and an
equally good print quality. If you are
looking for a printer that can print crisp
text printouts and fairly good images,
then opt for the Canon i255. The Best
Value award goes to the HP Deskjet 3550
for its impressive performance and out-
put quality at an excellent price of just
Rs 3,000. The HP Deskjet 3550 stands out
as a good printer for text printing as well
as those occasional photo prints. 

For the SoHo segment, our choice for
the Best Performance crown was unani-
mous—the Canon i560. The i560
combines the best of everything to
deliver groundbreaking speeds, without
compromising on quality. The price is  a
bit high, but it is worth the money if you
want a really fast inkjet printer for your
small office. The HP Deskjet 5652, on the
other hand, offers excellent output qual-
ity at reasonable speeds, earning itself
the Best Value award. Buy the HP 5652 if
your needs pertain to printing image
documents, for which it’s actually better
than the Canon i560. 

DIGIT TEST CENTRE

testcentre@thinkdigit.com

CATEGORY GRAPHICS & PROFESSIONALS PRINTERS
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CCaannoonn
i905D

Thermal Inkjet
4800 x 1200

USB
NA
100
✔

✔

✔

CD-face printing tray
✔

USB
2.5

Pictbridge

55
106
90
122
150

3
3.3
3

3.1

2.06
4.04
545
2725

59.43
11.8

71.23
3.24

21,995

EEppssoonn
Stylus Photo 900

Piezoelectric 
5760 x 720

Parallel / USB
32 KB

100
✖

✖

✖

CD-face printing tray
✖

Parallel
4

Paper-roll printing

40
80
48
94
141

3
3.1
3.5
3.2

4.66
2.94
1520
1840

60.99
8.6

69.59
4.80

14,495

HHPP
Photosmart 7960

Thermal Inkjet
4800 x 1200

2 x USB 
16 MB
100
✔

✔

✖

✖

✔

USB
4
✖

18
113
46
127
299

3.5
3.6
3.7
3.6

3.06
2.43
978
1615

63.25
10.6

73.85
4.34

16,999

* Scale of 5



test drive ■
■ laser printers

64 APRIL 2004

Ever since the prices of laser printers
came down to the level of afford-
ability of small and medium busi-

nesses, it’s made more sense to go for a
laser printer rather than a dot matrix or
an inkjet. There are several reasons for
this, primarily speed and quality. Lasers
are fast compared to the average inkjet,
and much faster than dot matrix printers.
That’s why a laser makes a very good
choice in environments where one
printer is shared amongst five to ten
users. Entry-level laser printers are gener-
ally capable of printing around 12-16
pages per minute (ppm). This speed is

good enough for SoHo environments,
where printing is not a continuously-per-
formed task, as in large organisations.
Even in a kind of setup where continuous
printing is done, the laser printer comes
in; inkjets start leaking after being used
for several hours at a stretch.

Mono lasers are the best choice where
documents primarily contain text. Laser
printers are also the printer of choice for
small DTP houses which see lots of cus-
tomers every day for various printing
needs. Here, most customers come for
prints that are later used for making
screens for screen printing. Inkjets and dot

matrix printers are useless here, because
both are ink-based, and light passes
through the prints. Laser printers create
fonts and graphics by depositing solid
toner on solid paper. Similarly, inkjets and
dot matrix printers are useless in trans-
parency printing, because ink does not dry
easily on transparencies.

Laser printouts generally show no
smudging, and graphics, too, are crisp.
Mono lasers are also capable of pro-
ducing excellent shades of grey, which
makes even combination documents
look lively. And lasers are quieter com-
pared to dot matrix printers.

The dream of the paperless office is still a dream, and printing
is still very much of a critical function for the whole gamut
of PC users—home users, small offices and corporates.

Whether it’s printing business reports or presentations for your
boss or clients, marketing material for your sales people, bills for
customers, or photos to share with your non-wired friends—com-
puter-generated printouts are everywhere. Usage patterns, and
therefore, the type of printer required for different kinds of user are
different. We analyse where the laser printer fits in.

For any printing requirement, you’d generally consider three
types of printer—dot-matrix, inkjet and laser. There are three
broad parameters to be considered with each—print quality,
costs, and print volumes and printing speed.
Quality: Dot-matrix printers are severely limited in terms of print
quality. Inkjets are suited for images as well as graphics, while
laser printers provide crisp text printouts.
Cost: There are two cost factors to be considered when purchasing

a printer: the upfront purchase cost, and the operational costs in
terms of cost per page (cpp). You can buy an inkjet printer for as
low as Rs 2,600, an 80-column dot-matrix for about Rs 7,000, and
an entry-level mono laser for Rs 10,000. However, in terms of oper-
ational costs, inkjet printers are the most expensive, with an average
cpp of Rs 2. Dot-matrix printouts are the cheapest with a cpp of just
about Rs 0.15, while lasers hover around Re 1 per page.
Volume and speed: At about six to seven pages a minute, inkjets
are slow, and not suited for high-volume printing, especially when
you consider the high cpp. Moreover, the print head tends to heat
up, leading to ink leakage if you’re doing high-volume printing.
But both dot-matrix and lasers are suitable for high volumes. The
duty cycle for entry-level lasers can be about 5,000 pages per
month, and you can get around 15 pages a minute.

Considering these factors, laser printers are ideally suited for
small-office and corporate environments where print volumes
are higher, and it’s primarily text that’s printed.

Entry-level Monochrome Laser Printers

You Need 

Look For

Our Pick

Price

A printer that can give you good print-
ing speeds and better quality than an
inkjet printer. Should have low running
cost and should be compact

A monochrome laser printer that has at
least 128 MB of buffer memory, offers
networking features, and can fire out a
minimum of 15 pages per minute 
HP LaserJet 1015; Canon LBP3200

Up to Rs 15,000

A one-stop solution for printing, 
scanning and copying at a reasonable
speed, provides good quality, and
incurs low running costs.

A laser MFD that'll give good printing
speeds, be able to scan at high 
resolutions, and have a toner life of
around 3,000 pages
Xerox PE16; Samsung SCX4216F

Up to Rs 45,000

A printing solution that can print at laser speeds
and be capable of high print volumes, while
being able to print colour printouts at inkjet-like
quality

Most entry-level colour laser printers will meet
these requirements

HP LaserJet 1500L; Canon LBP2410

Rs 45,000 upwards
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The LBP3200 has a rated speed of 18 ppm, and supports 600 dpi.
When we tested it, we got 16 ppm in factory default mode.

When the driver was set to ‘direct print’ mode, it managed 17
ppm—this is the fastest we’ve come across in any entry-level laser
printer so far. We recommend this printer, with this setting, for
environments where there’s sharing amongst five-10 users. The
200 MB test image took just 17 seconds, as compared to the 27 sec-
onds taken by the HP 1015 in factory default mode.

The 3200 uses Canon Advanced Printing Technology (CAPT),
where data processing is shifted to the PC. This means that this
printer should be used in conjunction with a system that has a
decent amount of memory, and decent processor speed.

The tray mechanism is unusual—the tray is at the bottom 
and is semi-detachable; it protrudes from the back of the printer.
You need to pull out the tray to feed in paper, and it might get
damaged if not handled carefully.

Pluses: It has a small footprint, weighs just 6.5 Kg, and meas-
ures just 245 mm in depth and 367 mm in width. Dual-colour

with rounded con-
tours makes for
attractive looks. A
minus: It works
over USB 1.1.

This printer is
best suited for
small and medium
businesses, as well
as DTP houses—where the pages printed are usually different
from each other, as opposed to multiple copies of the same doc-
ument. The 3200 can also be used as a network printer—you can
plug in a C-6200U network card.

Canon LBP3200
Round and fast!

The ML-1710 was able to print 15 pages in one minute—
only two pages short of the 17 ppm Samsung

claims. Output quality was very good, considering
the printing speed. It printed the test image and
combination document in just 17 seconds and 22
seconds respectively, which was quite fast.

This printer has an 8 MB buffer, which is quite
effective, as can be seen from its performance. The
downside is that the memory can’t be upgraded. The
printer uses the USB 1.1 interface, which is a minus.

Drivers for a host of OSes are provided, including all Win-
dows versions as well as many Linux distributions.  The drivers
also have features such as watermarking and high altitude cor-
rection. Bundled accessories include a 15A power cord and an
extensive manual, but no USB data cable.

The printer also comes with a Toner Save button—Samsung
claims this saves around 40 per cent in ink. The front panel con-
sists of just one multi-functional button and two indicating
LED’s. The printer also supports a manual paper feed

mechanism, located on the front side.
The body is milky white, decorated in slate

grey. Despite its small size of 13.7 x 14 x 7.6
inches, the printer features a removable paper tray
that holds up to 250 sheets. The upper body serves
as the output tray but can hold only about 40
sheets, after which the papers start flying

around—the flap to hold the print-outs in place is
very small.

At Rs 16,000, this printer is ideally suited for a
typical small office, and is a good buy for those on the lookout
for a small, fast, good quality laser printer. It may not be suitable
for a large organisations due to the lack of networking capabili-
ties, the small paper capacity, and poor paper handling.

Samsung ML-1710 Laser Printer 
Good things come in small packages

+ Compact and light; fast 17 ppm
text printing speed
- Flimsy paper tray mechanism
Price: Rs 13,995 + taxes

Canon LBP3200

Performance
Features
Value for money

A-A-

+ Good driver support for multiple 
OSes including Linux; 8 MB memory
- No USB cable bundled
Price: Rs 16,000

Samsung ML-1710 

Performance
Features
Value for money

B+B+
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In our tests, the HP Laserjet 1010 performed better
than the Laserjet 1015, both in

terms of speed and quality.
However, the test image
showed prominent banding
across the sheet. On the other
hand, the printed text was
clear and sharp.

The dimensions—37 x 23
x 20.8 cms— make it suitable
for a cramped office desk.
Also, weighing just under six
Kg, it’s more portable than
most other laser printers. The 1010
has a small paper input tray, with a capacity
of just 150 sheets. There’s no output tray as such—the
top of the printer acts as the output tray, with the help of a
small detachable flap. The 1010 lacks a protective plastic cover
for the paper input tray.

The printer controls, located on the top of the printer,
reflect the same simplicity of design as in the 1015—in fact,

the 1010 is almost identical to the 1015, featuring 
the same mixed bluish grey and white shaded

body. There are just two buttons, and 
three indicator LEDs to indicate the 
operational status. The printer is only 
compatible with Windows OSes, a big
minus for the product. The package
includes the driver CD, a power cord, the
printer cartridge and a setup guide. The
USB cable is not provided.

The Laserjet 1010 is targeted at
the ultra-low-end laser printing seg-
ment. At Rs 11,000, the Laserjet
1010 is a good printing solution for
the home and SoHo segments.

HP Laserjet 1010 Laser Printer 
Windows, please!

Colour Laser

Colour laser printers have been around for some time now,
but haven’t appealed to the SoHo segment so 
far because of exorbitantly high pricing. But now, it’s

possible to get one for as little as Rs 50,000. Colour laser 
printers have advantages over inkjet printers. First, colour doc-
ument printing is faster. Second, it’s even faster if multiple
copies of the same document are printed. When quality is
important, inkjets might be better, but then again, the cost per
page is higher, printing takes longer, and quality may not be
uniform if print volumes are larger. Colour lasers can print as
many copies as needed without a drop in quality. Third, colour
lasers have separate toner cartridges for each colour, so you can
just change the one that runs out first.

Most entry-level colour lasers can also have a network 
card attached. This facilitates printing for multiple users 
over a network. Some others come without a network card,
but with network capabilities: this means that you
can plug in the card as and when it’s required. You can also
plug in a wireless LAN card into some colour lasers,
which gives you the flexibility to place the printer at the most
convenient location, without any wire clutter. Entry
level colour laser printers are a good choice for printing
documents that are a mix of  text, graphs and images.
The colour reproduction is excellent, minute details are
printed excellently, and the text looks as good as when
printed on an inkjet.

+ Quite affordable, simple design
- Mixed results for image quality; the
test document showed prominent
banding, but printed text was clear
Price: Rs 10,999

HP Laserjet 1010 
Laser Printer 

Performance
Features
Value for money

B+B+

➜
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It took 16.7 seconds for the LBP2410 to print our test docu-
ment. This time includes the warm-up time, which was 9 sec-

onds. For 10 pages, it clocked 52 seconds. This means the 2410
is fast when you print several pages at the same time,  and not
so much so for single printouts.

We also tested the printer for image quality using the same
test image we used for inkjet printers. The image was dark with
a lot of banding. Also since the image was on the warmer side,
the contrast took a beating. However, the LBP2410’s perform-
ance in the combo-document printing test was good: colours
were vibrant, details accurate and two-point-size fonts readable.
The shades of grey the LBP2410 produces are good, too. Ditto the
quality of fonts printed on plain paper. The fonts were readable
up to two-points, with edges straight and curves smooth. 

Hence, we recommend the LBP2410 for pure text documents
that use coloured fonts, fonts on coloured backgrounds and
those that have images and graphics. We don’t recommend it if
your primary purpose is printing images.

The LBP2410 is compact, but not light. Rated speeds are 16
ppm in mono mode, and 4 ppm in full-colour mode. The printer

is Canon Advanced
Printing Technology
(CAPT)-capable ,
which means you
won’t have to invest on
additional printer
memory, as your system
memory is utilised. The paper tray is like the ones found in inkjet
printers, and it can hold 125 sheets. There’s one output tray on the
top, and one at the back. By default, the top tray receives the
printed sheets,but if you open the back tray, the output sheets finds
their way there. The back tray facilitates the straight paper path for
media such as postcards that jam inside the printer if folded. 

The printer doesn’t come bundled with a network card.

The HP Color LaserJet 1500L printed our text page in 18 sec-
onds, including the 8-second warm-up time. It finished the

10-document printing test in 52 seconds. This means this
printer is suitable for the SoHo environment, where eight to 10
people would be using the printer. An optional network card
lets you convert it into a network printer, and you can straight-
away set the printer up for sharing amongst several users.

However, the 1500L took 179 seconds to print a 200 MB test
image, for which the LBP2410 took just 105 seconds. As for the
print quality of the image, it was nowhere near the what you get
from inkjet printers—it appeared dark and had a lot of banding.

However, the combination document test returned very good
results. two-point fonts were readable, and the embedded image
was crisp, with excellent detail reproduction. 

All this means this printer is best suited for printing presen-

tation documents,
marketing collaterals,
and even magazine
pages: these usually
have custom fonts,
images and various
colour tones. The 1500L is a fast
colour printing solution for SoHos and
departments within big organisations. Graphic design houses
would be better off using inkjet printers for quality image prints.

The SoHo printer

+ Fast for multiple copies, good
quality text and greyscale
- Not very suitable for image print-
ing
Price: Rs 49,995 + taxes

Canon LBP2410

Performance
Features
Value for money

B+B+

Fast and colourful

+ Compact and light
+ Fast 17 ppm text printing speed
- Flimsy paper tray mechanism
Price: Rs. 44,999 + taxes

HP Color LaserJet 1500L

Performance
Features
Value for money

B+B+

HP Color LaserJet 1500L

Canon LBP2410

➜
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The 3700dn is slower compared to the other low-end
models. It took 31 seconds to print a text page, which is

twice the time taken by the HP 1500. It also printed the test
image slowly, taking 34 seconds. This means that if someone
fires a test image, others who have fired simple
documents will have to wait in queue for a
long time.  Again, image quality was not
up to the mark. The first print was very
dark, and in an attempt to get a better
idea of the print quality,  we printed
multiple images to warm up the printer
and then evaluate the copies. The rest
of the prints were better than the first
one, and comparable to those offered
by the LaserJet 1500, but nowhere 
near the quality offered by an average
inkjet printer. 

This network colour laser printer
has an unconventional cartridge
assembly. The CMY and K toner cartridges are
placed one above the other rather, than in a circular fashion.
This makes the printing process faster, since the printer saves
on the roll time of four toner cartridges. HP claims that the
printer prints both mono and colour pages at 16 ppm. 

The printer works over the USB 1.1 interface, and has a
built-in network card. The 3700dn also has a built-in Web
server, using which the administrator can access the printer
over the network and troubleshoot and monitor it. A test page

provides the necessary information such as the IP address and
DNS server, necessary to access the printer. The Web server can
be accessed through a browser that has three tabs—Informa-
tion, Setting and Networking. The page displays information

such as toner cartridge levels, paper level in trays
1 and 2 and so on. The printer supports
TCP/IP, IPX/SX, AppleTalk, Netware 
and Unix/Linux (RedHat and SuSe) 
networks, which means that most OSes,
if not all, in use today in big organisa-
tions are covered.

The printer has two paper-handling
trays, and if needed, you can use the
optional third tray. The first tray can
hold 100 sheets, whereas the second,
250. The printer is capable of automatic
two-sided printing, which means that

you can get 700 prints at one go.
All in all, the 3700dn is a good solution

for organisations where print documents are pri-
marily text, with images only occasionally.

HP Color LaserJet 3700dn
Connected Colour of Laser

+ Network-ready; easy configuration
of the network possible via the built-
in Web server; toner and paper lev-
els visible via a Web browser; two
paper trays with a third optional tray
- Image quality not up to the mark
Price: Rs. 97,999 + taxes

HP Color LaserJet 
3700dn

Performance
Features
Value for money

B+B+

! Initial price and the price of
consumables are the most important
factors to consider before investing in
a laser printer. Buy a laser printer only
if volume, speed and quality are all
important. Also check the price and
availability of toner cartridges
! Go for a printer that is network-
ready, or, at the least, has a slot for a

network card. Also, find out if wireless
networking is possible
! Find one that offers a memory
upgrade option. This will help with
larger print loads, once more users are
added to to the existing pool
! See if you can find a printer that
can take an optional paper tray—you
can purchase a paper tray if and when

needed. Add-on paper trays increase
paper capacity by 250 or so
! If there's going to be a lot of vol-
ume printing, look for USB 1.1/2.0. It’s
faster than the parallel interface
! You need an on-site warranty. If
you don’t get one, and the printer
stopped working, you'd have to lug 25
Kg of equipment to a service centre

Buying tips
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The technology behind a laser printer is completely different
from that of inkjets. A laser printer has a laser beam that creates
an image of what you’re printing, on the photoreceptive drum.
Here’s how a laser printer works:

The PC sends printed matter in either HP’s PCL (Printer
Command Language) or Adobe’s PostScript language. Here the
data is converted into vector information. 

The printer converts the vector information into dots (or, a
bitmap). Some printers use the GDI (Graphical Digital Interface),
where the bitmap is generated by the PC, and then passed on to
the laser.

Now, the laser fires when there should be a dot, and remains

off when there should be a blank space. The onboard electronics
control the movement of the laser, and the beam is then passed
through the lens filter to the Photoreceptor drum. Here the laser
beam is moved horizontally only, hence creating the dot
patterns on the photoreceptor drum. Once an entire line of dots
is completed, the drum rotates to receive the next line.
Wherever the laser hits the positively-charged drum, a negative
charge is created. The toner consists of a pigment that imparts
colour onto a paper. The pigment is blended into a plastic
particle to prevent smudging and making the borders of images
look sharp. There are four toners in a colour laser printer—cyan,
magenta, yellow and black. The positively charged toner
attaches itself to the negatively charged regions of the drum.

This is done four times in a colour laser printer. Now the paper is
passed over the drums. The paper is negatively charged by the
transfer corona wires. This charge is greater than the negative
charge on the drum, and thus attracts the positively charged
toner pigment. The pigment doesn’t stick to the paper here, and
the paper is then neutralised and passed through the fuser
assembly—nothing but a Teflon coated metal roller, heated by
the quartz lamp. The heat fuses the toner and the paper—this is
why if you print multiple copies one after another, the output
paper becomes increasingly warmer. The pattern is cleaned off
the drum using the charged corona wire, and the printer is
ready for the next document. 

How Colour Laser printers work

Shown above is the drum cartridge that holds the photoreceptor
drum and corona wires. On the opposite side is the Cyan toner
cartridge, which also holds the toner developer and toner hopper. 

Shown here are the four toner cartridges that are responsible for the
colour, and the toner drum with Photoreceptor roller (green roller).

This figure
shows the
holder,
where the
toner
cartridge are
seated. The
gear, which
is motor
driven, helps
in rotating
the toner
cartridge. 



Multi-Function Devices (MFDs) come in where scan-
ning, printing, fax and copy functions all need to be
done. Ever since they got cheaper, even home users

have begun considering MFDs as a viable replacement for
separate scanners, copiers and printers. They’re a great solu-
tion for all kinds of office, partly because they save so much
space. The quality of copies you get from MFDs is higher than
from standalone copiers. A laser MFD gives excellent fax
prints. Laser MFDs are a better choice than inkjet MFDs—they
afford low cpp, whether printed or copied, and print quality
is also good.

One reason for the popularity of MFDs is that they can
increase productivity in offices. As one example, instead of
scanning a document, OCRing it, and then taking it to the
copier, which may be at a different location, these can all be
done from one computer attached to the MFD.

Laser MFDs are the ideal choice for small firms like legal
advisory firms and accounting firms; legal documents,
account statements, bills, etc., are usually printed on stan-
dard stationery. In these situations, mono printing is pre-
ferred over colour, leaving the inkjet as both a low-quality
and a more expensive option.
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The SCX 4016 offers laser printing, digital copying and
colour scanning, but doesn’t integrate faxing. The opera-

tion console is intuitive, with button functions clearly
marked. The little LCD panel displays sufficient information,
but it could have been larger. It is built for economy, with
such features as Toner Save. Paper handling is via a 250-sheet
capacity paper cassette. There’s also a single-sheet feeding
mechanism on the front side.

The printer unit is the ML-1710, the fastest laser printer
we’ve tested so far. The scanner unit performance was not up
to the mark—the IT8 card’s tonal deviation test did not show
great results. Results were similarly poor in the dark region of
the IT8 card, but with acceptable resolution. Copies on the
4016 were crisp and clear, and the time it took for a copy was
average (10 seconds).

At Rs 36,000, the SCX 4016 is a good deal if you want a

laser MFD
with fast
printing and
decent print-
outs. The unit
as a whole
should be up
to the task in a
typical office.

Samsung SCX 4016 
Fast to print, slow to scan

+ Single sheet feed mechanism
present
- No fax function
- Average quality scanning unit
Price: Rs 36,000

Samsung SCX 4016 

Performance
Features
Value for money

B+B+

Multi-Functional Devices

Canon
Canon India Ltd

(011) 26806572
rajeev.singh@canon.co.in

www.canon.co.in

HP
Hewlett-Packard India Ltd 

(1600) 444999 (Toll Free) 
seema.dawar@hp.com 

www.hp.com

Samsung
Samsung Electronics India 

Information & Telecommunication Ltd 
(011) 51511234 

farrukh@samsungindia.com 
www.samsungindia.com

Xerox
Xerox Modicorp Limited 

(0124)2561930/40 
kuldeep.malhotra@ind.xerox.com 

www.ind.xerox.com



The 4216F has good fax features such as support for resolutions
up to 300 x 300 dpi, 4 MB of memory—enough for storing 320

pages, fax forwarding, and more. It comes with a hefty 8 MB of
buffer memory that gives it the extra edge while bulk printing. It
can connect to a PC via both the USB and parallel interfaces. The
scanner unit supports a native optical resolution of 600 x 600,
and an enhanced resolution of 4,800 x 4,800 dpi.

The printer unit is the fastest we’ve seen, and prints are crisp
and crystal clear. At scanning, the SCX 4216F is slower than the
4016. In the IT8 card tonal deviation test, the scanner unit on
the 4216F performed no better than did that on the 4016. And
in the resolution test, the unit was just mediocre, not detecting
the finer lines. Copying quality was excellent, and copying speed
was typical.

The cartridge for the 4216F is priced at Rs 3,300, and this

means lower cpp
compared to any
inkjet MFD.

Priced at Rs 45,000,
the SCX 4216F offers
good features at a com-
petitive price, and
should be considered if you want to
replace all your ageing peripherals with a single, cost-
effective solution.
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+ Good fax features
+ USB and Parallel interfaces
Price: Rs 40,000 + local taxes

Samsung SCX 4216F 

Performance
Features
Value for money

B+B+

Print ’em cheap

Samsung SCX 4216F 

Placing media improperly is one common problem across the
board, be it a home user or office users. Usually, most vendors
mark the printers with symbols that clearly indicate the placement
of media. Here, we look at the envelope and the printed
letterhead. We used the Canon LBP3200.

Envelope (Size 10: 4¼ x 9½) 
The tray in the printers has an adjustment knob, which slides in and
out to provide a straight media path. Several printers have a detailed
list of media sizes printed on the tray to facilitate quick placement. 
Place the envelope facing down if you are using the bottom tray.
Adjust the knob to fit the media size by moving it inwards or
outwards. Remember to open the back cover, which is the
alternate output paper path. This provides a straight paper path
eliminating bending of paper and therefore paper jams. In case of
a top-loading mechanism, the print surface faces the user.
Now, open a new document in Microsoft Word and type in the
recipient’s address. After that, go to Tools > Letters and Mailings >
Envelops and Labels. A dialog box appears, providing you with
two choices—’Envelope’ and ‘Label’. ‘Envelope’ is selected by
default; preview the address here and adjust its placement. Once
these settings are through, click Print.

Letterhead 
Type the content in Word, and adjust the margin. Do that by
shifting the text down to avoid printing on pre-printed content.
Place the media face down with its topmost edge towards you. 
Different printers have different ways to insert media. Refer to the
user manual for the steps you need to follow.

Of Letterheads and Envelopes

Shown in the
figure is the
Size 10 enve-
lope placed face
down for print-
ing. The symbol
on the tray
clearly shows
which surface
will be printed
on,  with the
help of the fold
corner and par-
allel line. 
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Conclusion
The popularity of laser printers can only increase. Prices will drop
further. As of now, because of toner costs, only SoHo users can
afford a laser printer; but once the price gets into the Rs 6,000-
7,000 regions, home users will begin considering laser printers.
600 dpi laser printers are entry-level now, and most of them have
faster processors; this has enabled them to support both HP’s PCL
and Adobe’s advanced PostScript printing language. PostScript
makes it easy for networked users, some of whom might be using
Macintosh systems, to print without problems. 

Such high-end features at entry-level price will make
mono lasers will eat more and more into the dot matrix
market, because entry-level models cost just about as much
as 130-column dot matrix printers, while offering much faster

speeds and far better quality. Dot matrix usage then will be
limited to specialised tasks such as billing, ticketing, etc.,
where print quality is not important. However, the dot matrix
printer will survive, partly because of the low cpp, and partly
because of general unwillingness to learn new things.

Large corporates prefer laser MFDs because of their higher
duty cycles and low print costs. But everywhere else, it will
still be some time before Laser MFDs replace inkjet-based
MFDs. Colour lasers are now already under the Rs 50,000
mark, and their prices, too, will come down as the technology
matures. Of course, we’re still a few years away from the time
when colour lasers get to the home.

DIGIT TEST CENTRE

testcentre@thinkdigit.com

The Xerox PE16 is a laser MFD that can print, copy, scan and
fax. The printer can print at a maximum speed of 16 ppm in

normal mode. It can go up to 600 dpi if the document includes
images or graphics. The paper tray can hold 250 pages, and has
separate slots to manually feed in single paper sheets, or media
such as envelopes, greeting cards, transparencies and so on. How-
ever, the support tray is missing here, and the user needs to push
the media into the slot.

The flatbed scanner comes bundled with an Automatic Doc-
ument Feeder (ADF) that can hold a maximum of 30 sheets at a
time. The scanner is capable of scanning at a maximum resolu-
tion of 1,200 dpi at 24-bit colour depth.   

The PE16 is a stand-alone copier too, which means you can
get as many as 99 copies of a document directly from the unit.
The menu allows you to set the type of page and the number of
copies. A hot key on the keypad allows you to set the contrast and
quality level. The toner-save button is a good feature—enabling
it makes the printer use less toner. These prints were light, but
were good enough for use in office environments.

The PE16 is also a full-fledged fax machine and has all the fea-
tures of a standalone fax machine. You can use the ADF to send
multiple faxes to a single number in one go. The broadcast feature
lets you send a single document to multiple numbers. You can set
a group dial to send one document to several numbers frequently.
The toll-save feature enables you to automatically restrict the

sending of faxes only during the
period for which the carrier
charges a discounted rate.

We were able to print
readable two-point fonts.
However, the standard test document
took 16.37 seconds—two seconds more than the
Xerox Workcentre Pro 412 that we tested earlier. 

The scanner was a real letdown, as it was slower than that of
any other MFD we’ve tested. At full-colour mode, we were greeted
with dark images, which when tested with Photoshop’s His-
togram feature, returned pathetic readings. We do not recom-
mend the PE16 for scanning images that will be be put to use in
presentations and other collaterals. 

The PE16 doesn’t have network capabilities, and has a 
comparatively slow printing speed of 17 ppm. However, its 
faxing and copying features are good enough for us to 
recommend it for use in small offices as well as departments 
within large organisations.

Xerox PE16 All-In-One
A better scan, please

+ Good fax features, compact design
- Below-par scan speed and copy
quality
Price: Rs 40,000 + local taxes

Xerox PE16 All-In-One

Performance
Features
Value for money

B+B+
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The best products in different 
hardware and software categories

Motherboard
MSI 875P Neo
+ Terrific performance and equally
good features
- Bad component layout
Contact: Cyberstar
Phone: 080-2276986
E-mail: narend@cyberstarin.net
Price: Rs 14,500

Primary Storage
Maxtor 250 GB MaxLine
Plus II
+ Tons of space
- Gets heated
Contact: Cyberstar
Phone: 011-6438216
E-mail: yogi@maxtor.com 
Price: Rs 19,500

Secondary Storage
DVD-Writer 
LiteOn LDW-811S
DVD-Writer
+ Fast write speeds
- Cannot write on dual-layered
media
Contact: Mediatech India 
Phone: 022-56396696 
E-mail: sales@mediatechindia.com
Price: Rs 13,750

Input Devices
Microsoft Natural
Multimedia Keyboard
+ Great quality and ergonomics
- Takes time to get accustomed
to new key layout
Contact: Microsoft Corporation 
Phone: 011-26294600
E-mail: connect@microsoft.com
Price: Rs 3,020

Graphics Card
Gainward GeForce FX 5950
Golden Sample
+ Extremely good performance
- Expensive
Contact: Mediatech India
Phone: 022-56396696
E-mail: sales@mediatechindia.com
Price: Rs 31,475

Sound Card
Creative SoundBlaster
Audigy 2 Platinum 
+ 6.1-channel output
- Expensive
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com 
Price: Rs 14,199

Speakers
Creative Inspire 5700D
+ Crystal clear sound reproduction
- Will not be able to shake the
room
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com 
Price: Rs 23,999

Display
LCD Monitor
SONY SDM-N80 18.1-inch
+ Stylish, great performance
- External power supply takes up
extra space
Contact: Rashi Peripherals
Phone: 022-28260258
E-mail: ho@rptechindia.com
Price: Rs 1,47,000

The A-List

Microsoft Wireless
IntelliMouse Explorer
+ Optical Mouse, USB interface
- Expensive
Contact: Microsoft Corporation
Phone: 011-26294600
E-mail: connect@microsoft.com
Price: Rs 4,278

Products that topped
our performance tests

Laptop
IBM T40
+ Great design, 
excellent performance
- Expensive
Contact: IBM India Ltd
Phone: 080 2063199
E-mail: sanmenon@in.ibm.com
Price: Rs 1,53,366

Branded PC
HCL Beanstalk 4658
+ Great package
- None
Contact: HCL Infosystems Ltd
Phone: 0120-2520977
E-mail: raman@hclinsys.com  
Price: Rs 51,490

Multi-functional
Device
Xerox PE16 All-In-One
+ Good fax features, 
compact design
- Below par scan and 
copy quality
Contact: Xerox Modicorp Ltd
Phone: 0124-2561930/ 940
E-mail: kuldeep.malhotra@
ind.xerox.com
Price: Rs 40,000

Laser Printer
Canon LBP3200
+ Compact and light; fast 17
ppm text printing speed
- Flimsy paper tray mechanism
Contact: Canon India Ltd
Phone: 011-26806572
E-mail: rajeev.singh@
canon.co.in 
Price: Rs 13,995 plus taxes

Inkjet Printer
Canon i560
+ Classy printing speeds

- None

Contact: Canon India Ltd 

Phone: 011-26806572

E-mail: rajeev.singh@

canon.co.in  

Price: Rs 9,995

PDA
Palm Zire 71
+ Feature-rich

- Below average audio

Contact: Tech Pacific 

Phone: 022-55960303 

E-mail: manishl@ 

techpacindia.com 

Price: Rs 24,500

Mobile Phone
Sony Ericsson P800
+ Easy and intutive navigation

- Blocky design makes it bulky

Contact: Sony Ericsson Mobile

Communications International

Phone: 011-26180808

E-mail: sudhin.mathur@

sonyericsson.com 

Price: Rs 34,995

Digital Camera
Canon IXUS 400
+ Cerabrite body, better 

buttons layout, wide shutter

speed range

- Ultra compact body 

hampers handling

Contact: Canon India Pvt Ltd 

Phone: 011-26806572

E-mail: shyam@canon.co.in 

Price: Rs 49,995

MP3 Player
Apple iPod
+ Hard-drive based, FireWire

cable bundled, line-out socket

- Very expensive

Contact: Apple Computer

International Private Limited

Phone: 080-25550575/ 73

E-mail: indiainfo@

asia.apple.com

Price: 30 GB-Rs 41,000

CPU
AMD Athlon64 FX-51
+ Great performance with multi-
media applications
- Expensive
Contact: Tech Pacific
Phone: 022-55960101
E-mail: pratik.chube@
techpacindia.com
Price: Rs 45,000
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Secondary Storage
CD-Writer
Benq CRW5224W
+ Cheap
- Data cable not bundled
Contact: BenQ India Pvt Ltd
Phone: 022-25705231
E-mail: salesenquiryin@benq.com
Price: Rs 2,000

Speakers
Frontech JIL-1870 
+ Good sound at an affordable
price
- Cannot handle high volume
Contact: Jupiter International
Phone: 022-22001211
E-mail: frontech@bom5.vsnl.net.in 
Price: Rs 1,750

CPU
AMD 2400+
+ Sufficient power for normal
desktop use
- Cumbersome installation
Contact: Tech Pacific
Phone: 022-55960101
E-mail: pratik.chube@techpacin-
dia.com 
Price: Rs 4,300

Motherboard
Krypton NF2400U
+ Good features, impressive per-
formance 
- Lacks onboard video 
Contact: Priya Ltd 
Phone: 022-56663100 
E-mail: priyabom@priyagroup.com
Price: Rs 3,900

Primary Storage
Samsung SV1203N 120 GB
+ Noise Guard and ImpacGuard
- 5400-rpm drive
Contact: Samsung Electronics
India Information
Telecommunication India Pvt. Ltd
Phone: 011-515111234
E-mail: marketing@
samsungindia.com
Price: Rs 7,200

Display
CRT Monitor
LG StudioWorks 700S
+ High resolutions, 
great performance, anti-static,
anti-glare, anti-reflection surface
treatment
- No extra accessories
Contact: LG Electronics India 
Pvt Ltd
Phone: 0120-2560900
E-mail: response@lgezbuy.com
Price: Rs 5,825

Branded PC
HCL EzeeBee
+ Winner of Best Value and
Best Performance
- Needs a better graphic card
Contact: HCL Infosystems Ltd
Phone: 0120-2520977
E-mail: raman@hclinsys.com
Price: Rs 26,500

Laptop
ACI Ethos 4
+ Good configuration for
the price
- Hampered ergonomics
Contact: Allied Computer 
International (Asia) Pvt Ltd 
Phone: 022-56943260/
26733124/ 56407000
E-mail: sales@aci-asia.com  
Price: Rs 46,990

Multi-function
Devices
HP Officejet 4110 All-in-
one 
+ Very fast printing speed
- Lacks a flatbed scanner
Contact: HP India Ltd
Phone: 011-26826000
E-mail: seema.dawar@hp.com
Price: Rs 8,999

Laser Printer
Samsung ML-1510 
+ Good image quality
- Slow print speed for combo
document
Contact: Samsung Electronics
India Information and
Telecommunication Ltd
Phone: 011-51511234
E-mail: farrukh@
samsungindia.com 
Price: Rs 10,990

Inkjet Printer
HP Deskjet 3550
+ Good photo printing 
capability, quite cheap
- High cost per page
Contact: HP India Ltd   
Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com 
Price: Rs 2,999

PDA
Palm Zire 
+ Affordable, good battery life,
comprehensive PIM applications
- No Palm Universal Connector,
no backlight, no expansion slots
Contact: Tech Pacific Technology
(India) Limited 
Phone: 022-55960101
E-mail: aparna@corvoshandwick.
co.in
Price: Rs 7,500

Digital Camera
Kodak DX6340
+ 3.1 megapixel camera with 
4X optical zoom
- Only 16 MB memory 
Contact: Neoteric Infomatique
Phone: 022-24172600
E-mail: rajeev@neoteric-info.com 
Price: Rs 18,900

Mobile Phone
Sony Ericsson T200
+ Light-weight, perfect grip,
WAP 1.2.1 browser and 
43.2 Kpbs GPRS, PIM features
- Keys are hard and noisy, 
unusual socket for the charger
Contact: Sony Ericsson Mobile
Communications International
Phone: 011-26180808
E-mail: sudhin.mathur@
sonyericsson.com 
Price: Rs 6,300

MP3 Player
Ennyah Digisound II
DS601
+ Fast data transfer, feature-rich
Contact: Great World Tech 
Pvt Ltd
Phone: 022-23892828
E-mail: sales@gtechworld.com
Price: Rs 6,000 (approx)

Graphics Card
Ennyah GeForce FX 5700
+ DirectX 9.0 compatible
- Very expensive
Contact: Great World Tech 
Pvt Ltd
Phone: 022-23892828
E-mail: sales@gtechworld.com
Price: Rs 8,500

Products that are 
the best value buy

Input Devices
Samsung PC Keyboard
+ Unmatched value for money
- No multimedia buttons, wrist
support not bundled
Contact: Samsung Asia Pvt Ltd
Phone: 022-22814886
E-mail: marketing@samsungindia.
com
Price: Rs 300

Logitech Scroll Mouse
+ Ambidexterous design
Contact: Rashi Peripherals
Phone: 022-28260258/ 59
E-mail: ho@rptechindia.com
Price: Rs 475



The Ethos V from the ACi is
probably the first laptop

to carry a price tag as low as
Rs 30,000. Its 256 MB DDR
RAM is shared
by S3 graphics
core. 

It has a D-
SUB connector
to connect an
external display,
serial and parallel
ports to connect
a mouse or print-
er, and a PS/2
connector for a
keyboard. 

The keys
make quite a
noise; but
they have a grainy finish and
provide good tactile feel. There
are four hotkeys provided to
control volume and access the
Internet and e-mail clients. 

The 14.1-inch TFT screen
provides enough space to
work scroll free in Word or
Excel applications and also
view Web pages easily at a res-
olution of 1,024 x 768. 

In Business Winstone
2002, we got a low score of
11.5, which means that this

product will provide crash-free
computing only with older
applications. In Quake III, we
got a playable frame rate of

30.8 at 640
x 480 pix-
els. At a
higher reso-
lution of
1,024 x 768,
we got just
10.2 fps. The
Ethos V isn’t
heavy, yet
it’s not
compact,
w h i c h
makes it
feel hol-

low. It
didn’t heat up after even four
hours of use—good news for
those who want a travel com-
panion. 

Overall, the Ethos V is
suited for students and small
business owners to access e-
mail, keep notes and type
business letters. At just 
Rs 30,000, this laptop is 
ideal for those on shoestring
budgets.

ACi Ethos V Barebone G320 laptop 
Affordable portable!

Price: Rs 30,000
Contact: Allied Computer 
International (Asia) Pvt ltd
Phone: 022-56943260
Fax: 022-26733119
E-mail: sales@aci-asia.com 
Web site: www.aci-india.com

SPECIFICATIONS

VIA Ethos 1GHz CPU, 256 MB
DDR RAM, 20 GB hard drive,
10/100 LAN, 56K modem,
14.1-inch TFT LCD screen, 
Weight: 2.4 Kg

ACi Ethos V Barebone 
G320 laptop
Performance
Features
Build Quality
Value for money

B+B+
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We test the latest and the best hardware and software products available in the market 

The Geo G1 has the camera
and flash in the front,

close to the external LCD. 
Its left side has the
headset jack, while the
right side has a camera
button. 

The phone stores
300 contacts, each
with different numbers
for home cellular and
office and data such as
e-mail address and
anniversary.  

Use the Geo G1 to
take self-portrait pic-
tures, or use the multi-
shot feature to capture
multiple shots at one
go. A nifty feature is the
inclusion of about 17 differ-
ent frames that can be select-
ed before or after clicking a
picture. 

The Geo G1 also includes
Avatar—an application that
offers you a menu of different
face types, eyes, etc, that you
can use to create and save dig-
ital personas. You can then
associate these with your con-
tacts, or sent them as MMSes. 

Voice clarity is decent.
The phone has a problem in
detecting the network in weak
signal strength areas and goes
in search mode, thereby
affecting battery life.

It captures decent images
and video clips but lack of

audio support is noticeable. It
connects to the PC through
the serial port via the bundled

cable. The Geo-sync
software provided lets
you synchronise data
with the PC. However,
it rebooted the phone
a few times when we
tried to connect it. 

The lithium-ion
battery provides about
a day and a half’s worth
of life, though this
reduces significantly if
you shoot a lot of
images and use the
flash. An extended
lithium-ion battery is

also bundled that lasts
for about double the time. An
external desktop charger, a
travel charger and a manual
are also bundled.

Considering its problems
with network detection, poor
application support, lack of
support for Java applications
combined with the high price
tag, this is not a worthy buy.
Consider buying a Nokia 6600
in the same price range.

Price: Rs 24,999
Contact: First Mobile India Pvt Ltd
Phone: 022-56944070
Fax: 022- 26845085
E-mail: response@
firstmobileindia.com

Geo G1
All photo, no voice

Geo G1 CC
Performance
Features
Ergonomics
Value for money

SPECIFICATIONS

Dimensions: 88 x 46 x 23.2 mm,
Weight: 90 gms, dual band,
dual-LCD, 260 K colours, 
integrated VGA camera with 4X
digital zoom, video recording,
MMS, 64-note polyphony
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The BenQ S830C has dual
LCD screens. Colour clari-

ty is reasonable, though the
screen is hardly read-
able under direct sun-
light or when the
backlight goes off.   

The left softkey
activates the silent
mode if pressed and
held for a couple of
seconds. The phone
memory can hold
500 entries. Features
such as MMS, and

predictive text input are sup-
ported. Voice clarity is quite
good, and it  detects weak sig-

nals too. However, images
taken using the tiny external
camera attachment appear
grainy. PC synchronisation is
also  an area of concern. 

Though the BenQ S830C
is above average as far as voice
clarity and feature set go,the
Rs 12,450-plus price tag is a
tad too high.

This NV36 core-based chip
has 256 MB DDR II mem-

ory that provides bandwidth
in excess of 14.4 GBps. A TV
encoder chip with support for
MPEG 2 decoding is includ-
ed. The Y-cable (S-
video to RCA and
stereo cable) is also
provided. 

In the Gunmetal
benchmark, it re-
turned 20.76 fps at
1,024 x 768, and beat the 3D

Prophet
R a d e o n
9600 256
MB card,
w h i c h
l o g g e d

19.05 fps.
In Aquamark 3, it

averaged 32.31 fps at a reso-
lution of 1,024 x 768. 

Priced at only Rs 8500, it
has an amazing price to per-
formance ratio. 

BenQ S830C Mobile Phone  
Flip it open

SPECIFICATIONS

425 MHz core clock, 500 MHz
memory, 256 MB DDR II 
memory, 0.13 micron 
fabrication process, 14.4 GBps
memory bandwidth, 1.9 billion
texel per sec fill rate, AGP 
8X interface, DVI connector   

Price: Rs 8,500 
Contact: Great World Tech Pvt Ltd
Phone: 022 - 23892828
Fax: 022 - 23879020  
E-mail: sales@gtechworld.com
Website: www.ennyah.com.tw 

Ennyah GeForce FX 5700

Performance
Features
Build quality
Value for money

A-A-

Ennyah GeForce FX 5700 
High performance, low price

Price: Rs 12,450 (Rs 2,000 extra 
for camera attachment) 
Contact: BenQ India Pvt Ltd
Phone: 022-25705230
Fax: 022-25705235
E-mail: salesenquiryin@benq.com
Web site: www.benq.co.in

SPECIFICATIONS

Dual band for GSM900/1800;
Dimensions: 87 x 45 x 19 mm;
Weight: 98.5 gm, integrated
WAP 2.0 microbrowser, seven
caller groups for identification,
IR port

BenQ S830C Mobile
Phone
Perfrormance
Features
Ergonomics
Value for money

B-B-
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The first thing that strikes
you about these speakers

is their design—classy and
sleek. The Altec Lansing
MX5021 is a 2.1 system with
a wireless remote and THX
certification. 

The Minority Report
DVD sounded great, but
the surround
e x p e r i e n c e
was missing.
The satellites
brought
out the
t i n i e s t

detail, while the sub punched
in the lows with equal
strength. Listening to ‘O rey
chhori’ from Lagaan made us
want to watch the movie
again. Gaming benchmarks

also gave it a top-notch
rating, especially the
Quake III intro movie.

The MP3
tests also
went well.
The fre-
q u e n c y
tests were a
bit of a let-

The Umax Draco combines
an MP3/WMA player, a

portable USB storage device,
and a voice-recorder into one.
Build quality could be an issue
if you drop it accidentally.

The PC recognises it
as a removable
drive under
W i n d o w s
2000, Me and
XP. The jog
switch lets you
switch modes
between music,
recorder and voice playback,
apart from customising other
settings. 

Bass and treble output for
the English tracks were quite
weak. However, the Hindi
tracks sounded reasonably
good. The audio output was
low even at maximum vol-
ume and not up to the mark.

You can create folders in
the removable drive, but only
music files stored in the root
can be played. The unit gave
us just about four hours of
continuous playback, while
the rated time by the vendor

is 12 hours.  The battery gets
charged automatically once
you connect it to the USB
port. However, it tends to heat

up while charging. 
With its sub-

Rs 5000 price
tag, the Draco

may appeal
to the
y o u n g e r

crowd. How-
ever, the average

audio quality, average build-
quality, and poor battery life
need to be considered before
purchasing the product.

SPECIFICATIONS

128 MB flash memory; sup-
ports MP3 and WMA formats;
multiple repeat function: Loop
one, Loop all, A-B/A-V repeat,
USB storage, 1.5V AAA charge-
able battery

Price: Rs 4,900
Contact: Neoteric
Phone: 022-24172600
Fax: 022-24185294 
E-mail: sales@neoteric-info.com

Umax Draco MP3 Player

Performance
Features
Ease of use
Value for money

AA

Umax Draco MP3 Player
Meet Count Draco!

The Siemens C60 looks
good in its grey silver out-

fit with a dash of chrome that
adds beauty. The
colour panels are
exchangeable,
and you can opt
for other colour
schemes. It has
small cramped
buttons that are
hard to press and
lack tactile feed-
back. The build
quality leaves a
lot to be desired. 

The 7-line
colour display
screen is nothing to
write home about—so
long as you use this phone
indoors, you won’t go blind
trying to read the screen. The
icon based menu structure is
really simple to operate. 

You can store 350 phone
book entries in all. Support
for MMS and Java applica-
tions is included. The phone
comes with an external cam-
era and flash attachment.

Taking pictures drains the
battery very fast-especially
when you use the flash. 

No infra-red
connectivity is
provided. The
p a c k a g e
includes the
handset, a
700mAh lithi-
um-ion battery,
battery charger
and a user guide.
The voice clarity
is good and the
reception is clear.
The battery lasts
for about three

days on normal
usage. At just Rs 8,000, the
C60 is sensibly priced. 
We recommend it only if 
you spend most of your 
time indoors and are not an
SMS junky. 

SPECIFICATIONS

Tri-band, 12 bit colour display,
16 polyphonic ringtones, GPRS,
350 phone entries and external
camera with flash

Price: Rs 8,000 
Contact: Siemens
Phone: 022 - 2498 7430/46
Fax: 022 - 2496 8085
E-mail: contactus@bom4.
siemens.co.in
Web site: www.my-siemens.com

Siemens C60 
Mobile phone

Performance
Features
Build quality
Value for money

B+B+

Siemens C60 mobile phone 
Flash it! 

down, especially the mid-
range frequencies, but only
experienced ears can catch 
the difference. Distortion 
was noticed only when we
played with the EAX equaliz-
er settings—setting it to 
rock, pop, etc.

It’s steeply priced at Rs
12,000.You can get a 5.1 set
for just as much. This is for
those who want the best 2.1
sound available. 

SYSTEM REQUIREMENTS

90 Watts RMS, frequency
response 30 Hz ~ 22 KHz, 
Signal-to-Noise ratio at 
1 KHz >80 dB,  system Total
Harmonic Distortion < 0.3 per
cent at -10 dB, satellite driv-
ers—1-inch horn loaded
tweeter and two 3-inch mid-
range, subwoofer driver—one 
6.5-inch Long Throw woofer

Price: Rs 12,000
Contact: Zeta Technologies 
Phone: 022-24102277
E-mail: tejas@zetaindia.com  
Web site: www.alteclansing.com 

Altec Lansing MX 5021

Performance
Features
Build Quality
Value for money

B+B+

Altec Lansing MX 5021
Luxurious sound



The SMC2655W is a tiny
device that measures

about 117 x 62 x 22 mm, and
weighs under 100 gms. It
comes with the external
dipole antenna, and works on
the Direct Sequence Spread
Spectrum type radio signal.

The utility bundled with
it is easy to

use and
set up.

It comes with a default IP
and DNS that are needed to
access it. These can be
changed of course. You can
also enable MAC-level filter-
ing by creating and adding a
MAC address list to it. Thus,
only devices that match the
MAC address list will be
allowed access. This is a 
must have, especially when
the neighbours also have a
wireless network. 

Though the SMC2655W
claims to offer speeds of 11
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Mbps at a distance of 
128 metres, our tests showed 
otherwise. It took us 12 min-
utes and five seconds to 
transfer a 200 MB single file—
a data transfer speed of approx-
imately 2.2 MBps only; and
this was at a distance of just 12
metres, with only a single user
connected and even the line-
of-sight criteria satisfied for
best performance. So though it
claims to support up to 32
users per device, practically,
this doesn’t seem feasible.

The access point came
bundled with a power adapter,

the utility software CD and a
manual that explains the
setup process. We recommend
this device for a wireless net-
work wherein most data trans-
fers are just surfing and e-mail
access, and that too, for a
small group of users.

Price: Rs 8,000  
Contact: SMC Networks
Phone: 022-56962790
Fax: 022-56962794  
E-mail: Jayesh.dabrai@
acctontech.com
Web site: www.smc-asia.com   

SPECIFICATIONS

802.11b compliant, 2.4 GHz
operating frequency, dipole
antenna, 825-feet operating
range, supports 64 or 128-bit
Wired Equivalent Privacy (WEP)
encryption, support for up to
32 users 

SMC SMC2655W Wi-Fi
Access Point

Performance
Features
Ease of use
Value for money

BB

The Wacom Graphire 3
combines the accuracy

and ease-of-use of a pencil to
draw images, along with the
enhanced functionality of
the mouse as a pointing
device. 

The well-designed cord-
less pen sports an electronic
eraser at its end. The re-pro-
grammable dual side-switch
can be assigned functions
such as right-clicks and dou-
ble-clicks. The tablet’s sur-
face has a smaller customis-
able active area to detect the
pen’s motion and replicate it
correspondingly onto the
screen.

We had to manually
enable the pen’s pressure
sensitivity in Photoshop, but
otherwise it was quite pre-
cise. However, as the pen

activates within 5 mm of the
tablet’s surface, novices may
find it tricky to use. 

With a
price tag of Rs 5,400, the
Graphire 3 is a better buy for
design professionals and
artists.

SMC SMC2655W Wi-Fi 
Access Point 
Freedom of movement

SPECIFICATIONS

Tablet size: 8.27 x 8.20 inches,
active area size: 3.65x5.02
inches, pen accuracy: ±0.02
inches, bundled software:
Painter Classic, PhotoExpress 4
SE, Pen Plus Personal

Price: Rs 5,400 
Contact: Trifin Information 
Technology Ltd
Phone: 011-26236061
Fax: 011- 26436447
ashish@trifintech.com   
Web site: www.wacom.com

Wacom Graphire 
3 G-430 Pen Tablet

Performance
Features
Ergonomics
Value for money

B+B+

HA! CD Burner, a CD
recording software made

in Taiwan, supports CD as well
as DVD media. The software
has all the necessary elements
such as Disc Copier, Raw Copi-
er, Audio Copier, MP3 CD,

Video CD, Super VCD, etc. You
can also create audio CDs on
the fly from MP3 format. Just
drag-n-drop MP3 files in the
wav copier, and your audio CD
is ready.

The manual was outdat-
ed—it mentioned only support
for CD-R and CD-RW, when in
fact, it also supports DVD burn-

ing. The documentation didn’t
even mention some features
related to CD-burning such as
Video CD, Super VCD, etc. 

Performance-wise, it’s sim-
ilar to other applications such
as Nero. It also offers most of

the features such
as multi-session,
d r a g - n - d r o p ,
image creation,
etc. A few fea-
tures such as for-
mat CD, over
burning, copy
protection sup-
port are missing. 

The interface
is simple and
won’t even scare
a novice. At Rs

2,700, it’s a good software to
buy as it performs well and has
the required features.

HA! CD Burner
Impressive!

Price: Rs 2,700 
Contact: Mediaman Infotech 
Pvt Ltd
Phone: 022-23823100
E-mail: alok@mediamangroup.com
Web site: www.acard.com 

SPECIFICATIONS

Media supported:CD-R/RW,
DVD-RAM, DVD-R/RW, and
DVD+RW/+R; supports Windows
98, Me, NT, 2000 and XP

HA! CD Burner

Performance
Features
Ease of Use
Value for money

A-A-

Wacom Graphire 3 G-430 Pen
Tablet
The pen is mightier than the mouse

HA! CD Burner is the new kid on the write
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speed of 923 KBps report-
ed was the highest we
have ever logged for a USB
Flash drive. The CPU utili-
sation, as reported in
HDTach, was very low. In
the real world tests too, the
drive turned in an excel-
lent performance in the assort-
ed write test with a high data
transfer speed of 1.47 MBps.

The Simmtronics USB PnP
Flash drive is a good deal-for
just Rs 3,000, you get amazing
performance.

Price: Rs 3,000  
Contact: Silicon Impex Pvt. Ltd.
Phone: 011-54618247/48/49
Fax: 011-31061852  
E-mail: a_silicon@rediffmail.com

SPECIFICATIONS

USB 1.1, 128 MB capacity,
physical dimensions 73.6 x 24
x 10.3 mm, carry strap, 
extension cable

Simmtronics USB 
PnP 128 MB Flash Drive

Performance
Features
Build quality
Value for money

B+B+

The Samsung SP1614C uses
the SATA interface,

which is becoming the
interface of choice on the
latest motherboards. It also
has an 8 MB buffer to speed
up the data throughput.

Performance-wise, its
results were on par with other
SATA models tested earlier.
The SiSoft Sandra 2004 Pro
test returned a drive index of
41,724 with sequential read
touching 62 MBps and access
time as low as 7ms. 

The drive logged a decent
random read/write score of 
12 MBps. It logged a relative-
ly high CPU utilisation of 4.4
per cent in the HDTach 2.60
tests. The drive we received
wasn’t bundled with any kind
of manual or documentation,
nor was any interface or
power cable supplied. 

The SP1614C is best suit-
ed for gaming PCs and work-

stations that need fast and
continuous data access. With
a price tag of Rs 7,000, it also
goes well with a home system
that has a horde of mp3
songs, movies and images.

The Simmtronics USB Flash
drive is extremely light,

and is among the thinnest
we’ve tested so far; measuring
just 10.3 mm, or less than half
an inch. Despite its size, the
build quality is good. 

The installation was sim-
ple and was immediately
detected in both Windows XP
and Windows 98, but needed

the driver CD for proper instal-
lation in 98. For data protec-
tion, the drive only features a
physical write-protection
switch, and lacks a software
password-locking tool. In fact,
besides the driver CD, the
package only includes a carry
strap and a short extension
cable.

We ran Drive Benchmark
from the SiSoft Sandra 2004, to
gauge the theoretical transfer
speeds. The sequential write

Simmtronics USB PnP 128 MB
Flash Drive
The Plug and Play Drive

SPECIFICATIONS

150 MBps, SATA interface, 
8 MB buffer, 7,200 rpm 
fluid dynamic bearing motor,
Weight: 653 gm

Price: Rs 7,000 
Contact: Samsung Electronics india
information & telecommunication ltd
Phone: 011-51511234
Fax: 011-51608820
hddsupport@samsungindia.com   
Web site: www.samsungindia.com 

Samsung SP1614C 
160 GB SATA hard drive

Performance
Features
Build quality
Value for money

A-A-

The SSD-8in1 card reader
can read flash memory

card and plugs into a USB
port. It can read Compact
Flash (CF), MultiMedia Card
(MMC), SmartMedia (SM),
MemoryStick, SecureDigital
(SD), Microdrive cards and
xD-Picturecard formats. 

Once the reader is plugged
to the system, Explorer shows 
a total of 5

d r i v e s .
The advan-

tage of this is that you can plug
in different cards, and read or
write to all of them simultane-
ously. The disadvantage is the
reduced bandwidth shared
across four slots.

We tested it with the
Princeton 32 MB Compact
Flash card. In SiSoft Sandra
2004 Pro, it logged a score 
of 936 KBps. The sequential
read maxed out at 949 KBps

and sequential write topped at
943 KBps. For a card reader,
sequential data transfer is more
important over random, as it is
used mainly to transfer large
images, music files or short
video clips.  The random read
and write score was 948 KBps
and 801 KBps respectively,
which is quite good. 

The card shows 30.6 MB of
space, and we tested it by trans-
ferring a 30.4 MB single file
and the same amount of assort-
ed data. It took 35.26 and
41.12 seconds respectively.

This card reader costs just
Rs 1,090, which not only
makes it affordable, but a
must have for all those with
cards plugged into your digi-
tal cameras, PDAs, etc. Since
it can both read and write to
the cards, you could also use it
as a USB memory stick.

Techcom SSD-8in1 1.1Card Reader
Read one, read all

Price: Rs 1,090
Contact: Shree Sagarmatha 
Distributors Pvt. Ltd
Phone: 011-26428541
Fax: 011-26428542
E-mail: sagarmatha_dlh@bol.net.in 

SPECIFICATIONS

USB 1.1 interface, USB cord,
four slots, supports MMC, SD,
SM, MemoryStick, Microdrive,
xD-Picturecard 

Techcom SSD-8in1 1.1
Card Reader
Performance
Features
Ease of Use
Value for money

B+B+

Samsung SP1614C 160 GB SATA
hard drive
Bigger is better!
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Xerox PE16 All-In-One
A better scan please

Xerox PE16 is laser multi-
function device that can

print, copy, scan and fax. The
printer is capable of printing
at a maximum speed of 16
pages in normal mode and
can go up 600 dpi if the doc-
ument includes images or
graphics. 

The printer tray can hold
250 pages and has separate
slots to manually feed in sin-
gle paper sheets or media
such as envelopes, greeting
cards, transparencies and so
on. However, the support tray
is missing here and the user
needs to push the media in
the slot, which is then pulled
in by the printer. 

The flatbed scanner is
bundled with an Automatic
Document Feeder (ADF) that
can hold a maximum of 30
sheets at a time. The scanner
is capable of scanning docu-
ments and images at the max-
imum resolution of 1,200 dpi

at 24-bit colour depth.   
The PE16 is a stand-alone

copier too, which means you
can get as many as 99 copies
of a document directly from
the unit. The menu allows
you to set the type of pages
and the number of copies. A
hot key on the keypad allows
you to set the contrast and
quality level. The toner save
button provided on the key-
pad is a good feature that can
be enabled to get more copies
as less toner is used. The
prints were light after we
enabled this feature but were
good enough for use in office
environments. 

PE16 is also a full-fledged
fax machine and boasts all
the features of a standalone
fax machine. Use the ADF to
send multiple faxes to a sin-
gle number in one go. The
broadcast feature lets you
send a single document to
multiple numbers. Set a group

Ennyah GeForce FX 5700 
High performance, low price
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Ah! Finally got my hands on Unreal
Tournament 2004. After a few hours
of adrenaline pumping action from

my professional, well greased gaming skills,
I finally overcame the game in record
time—3 seconds faster than Agent 000—
my brother! Yay! Kabloooey!. Sniff sniff!
Huh? What was that? Oh damn! I spilled
coffee on my keyboard in my excitement.
Oh well, time for new keyboard, Agent 000
can pay for it—after all, he lost the bet. 

So, after a quick trip to 000’s ATM, I was
off to Lamington Road, Mumbai’s haven
for all things electronic. I want something
with hotkeys to launch the heat-seeking
rockets in Unreal. 

The first shop had an Acer key-
board for Rs 550. “No way”, I
thought. The next shop had a wall
lined with keyboards, but when I
asked the shopkeeper to recom-
mend a reliable multimedia key-
board, I was told, “Yeh sab deewar
par hain naa, see for yourself!
They’re all good keyboards”. It was
obvious this guy treated keyboards
like potatoes, and probably sold
them by the kilo as well… 

The next shop owner seemed too
interested in his phone call than in me.
Now, while shopping, if you fail to find
what you want…cross the street; and I did. 

I walked into a shop and the owner
seemed excited to see me—it was obvious
from all the scribbled-on paper lying about
that business was slow here today. “Good
for me”, I said to myself. They always pay

attention to you when they’re hard-up for
customers. He showed me an Odyssey mul-
timedia keyboard, but I didn’t want to look
at unheard of brands. “Show me the good
stuff,” I said. 

With a smile, he told me about the
Microsoft optical combo pack of wireless
mouse and keyboard. Controlling my 19-
inch flat screen from the bed itself, now
that would be something. 

Whilst I was daydreaming, I was just
nodding to everything the owner said, and

before I realised
it, he had started

writing up a bill. “Wait,” I shouted, “How
much did you say it costs?” “Only Rs 5,400,
Sir,” he replied.

I awoke coughing and sputtering; the
owner was splashing water on my face.
Muttering my thanks, and blaming the
episode on those damn vada pavs, I beat a
hasty retreat. I decided to stick to shady
alleyways; at least if I meet muggers I can
deal with there. I wandered about, making
a mental list of what’s available…
Microsoft wireless combo: Rs 3,850, but it
uses 4 batteries that only last five hours.
Logitech wireless combo: Rs 3,150, and
has a one-year warranty. 
Microsoft optical wireless combo:
Rs 5,400. Gasp! You don’t win that much
money at Unreal match-ups.
Samsung Multimedia keyboard: Rs 450,
but oh, so boring.

McDonalds veg burger: Rs 30. Yummy! 
That decided it, I really was hungry. I

ordered a sev puri from a roadside stall, and
noticed a tiny shop that was even smaller
that this chaat stall. While my eats were
being prepared, I walked in and looked
around. The owner was polite and told me
that he would recommend the Typhoon
wireless combo. 

For just Rs 1,450, I would get an RF wire-
less multimedia keyboard and an ambidex-
trous mouse. He also showed me a Neotech
option for the same price, which comes
with an integrated trackball. I was delight-
ed, and was all set to buy it when I found
that it was an infra-red-based keyboard.
There’s no way I want to always keep my
PC in the line of sight of the keyboard—
wireless without the freedom of movement
is not wireless at all.

When I asked about the batteries, he
said “Nahi nahi, no batteries needed”. Not
wanting to waste my money on peripher-
als that run on the energy of our souls, or
on the goodwill of society—especially
when the box says “4 AA batteries need-
ed”—I went back out to eat my treats. 

The Mumbaiyya snack gave me enough
energy to continue this quest, and onwards
I trudged. 

I came across an iKey combo at the next
stop, with a wireless keyboard and a wire-
less optical mouse for Rs 3,250. The receiv-
er looked like a UFO, but the mouse wasn’t
ambidextrous. Since I’m a firm believer in
the equality of handedness, I decided this
just wouldn’t do, and asked to see more. 

He showed me a white Microsoft wire-
less combo for Rs 3,100, and a different
Microsoft combo that looked much better
because it was black, for Rs 4,150. The
mouse that comes with this combo has
horizontal scroll as well. He also had a Log-
itech model for Rs 3,200.

As soon as he told me that the Microsoft
models carried a 3 year warranty, my mind
was made up. With a little extra money, I
could buy peace of mind. I decided to save
what I could, and bought the Microsoft
Wireless Optical. 

This was still good enough to show off,
had the option of either PS/2 or USB con-
nectivity and was cheap enough to buy
from my winnings. 

■ Remember that wireless input
devices look cool, but need bat-
teries. You’ll go broke buying

new AA batteries every five days.
■ An RF wireless solution is better

than the infra-red version, as you won’t
have to worry about line-of-sight.
■ An optical mouse is better in the long
run as it has almost zero maintenance
and better precision.
■ Look for models with the maximum
warranty. Microsoft offers three years,
and it’s advisable to spend that little extra
for peace of mind.
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CLICKITY-CLICK
Agent 001 hits the streets to find the ideal keyboard and mouse
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Mahesh Benkar

Neeraj gets up with a start. “Oh no!
It’s already 6:30 am. I’ll never
make it to the reservation count-

er on time.” He pulls on his clothes and
dashes out into the cool morning air. The
sunrise is beautiful, but he doesn’t have
time to notice it. Quickly flagging down a
taxi, while still buttoning his shirt he yells,
“Station, jaldi!” He pulls up at the station
at about 7:15, dashes to the booking
counter and breathes a sigh of relief. 

He’s just about the 10th guy standing
in line; his laziness hasn’t cost him too
much time—he’ll only have to wait
another hour and a half before the count-
er opens, and another hour for his turn. By
about 10:00 am he’s back home and
already an hour late to work. “Oh well! It’s
worth it to finally be able to go on that
family vacation after a month.”

Some of us will relate to this, others
will just laugh in disbelief. The fact still

remains that this was a
reality as little as five or six years ago. Back
then, people had three options. 

The first was to do exactly as Neeraj
did, except that it usually took longer to
get tickets. The second was to visit the
local travel agent, but you risked getting
a wait-listed ticket that would just never
seem to get confirmed. The last option
was, as all last options usually are, illegal.
Buy tickets from a tout, hope and pray
they have one for a 50-plus woman, so
your mother doesn’t have to travel as a

46-year old male, and learn to answer 
to your assumed name a few days before
the journey. 

Today, times have changed. The
Internet has afforded us the luxury of
being able to make it to work on time and
use a little of our home or office band-
width to book our tickets.

Of course, the touts still hover about
the station, and the TTE still tries his best
to catch those travelling on assumed
names, but Neeraj outsmarted the lot. He
sat at home on Sunday, surfed the Internet
and booked tickets, hotel reservations and
even a car with a driver to take his family
sightseeing. The Internet is redefining
travelling in the country. 

Right from giving us a first-hand feel
of the destination of choice, to selecting a
package deal that fits our budget, the
Internet offers everything you need to
make your family’s vacation memorable.

Travel the
world…
but start the
journey
online



APRIL 200491

The first step
Priya Raje, 26, a con-
sultant with an HR
firm in Mumbai, dis-
covered the potential
of the Internet when
she wanted to surprise
her husband, Ravi,
with an exotic holiday
package for their sec-
ond marriage anniver-
sary. However, there
was a slight problem.
“I was distraught when
my travel agent told
me that my savings

were barely enough to cover the
travelling expenses for a week’s holiday in
Tioman Island, Malaysia, leaving nothing
for boarding and other expenses. It really
was a huge disappointment.” 

Actually, it turned out to be a blessing
in disguise; a friend advised her to check
out several Indian Web sites that give infor-
mation on holiday destinations within the
country. And she chanced upon, what was
to be a ‘perfect romantic getaway’ for her in
Lahul and Spiti Valley—places cradled in
the breathtaking beauty and serenity of the
stately Himalayas. 

What’s more, she could splurge like a
queen and still be within her budget—it
was a dream come true. 

For exotic getaways within India, the
first Web site that you should check out is
that of the Ministry of Tourism (www.touris-
mofindia .com or www.incredibleindia.org). An

interesting feature of this
well-designed Web site is the
list of useful phrases in Hindi,
Kannada, Bengali, Punjabi,
Malayalam, Telugu and their
English equivalents that
come in handy  when you
visit these states. 

Another Web site worth
exploring is Outlook Trav-
eller (www.outlooktraveller.
com). It’s loaded with reams
of information. It has holi-
day ideas and detailed infor-
mation on several destina-
tions. The travel news and
articles segment is a good
feature; these news stories
and articles talk about the different expe-
riences you can expect when travelling by
road, train or air. 

All India Travel (www.all-indiatravel.com)
is a Web site that provides useful holiday
ideas for almost all the cities in India. Find
out all the details on various cities and
tourist attractions such as bird sanctuar-
ies, wild life preservations, etc, at IndiaE-
Travel (www. indiaetravel.com). 

Another interesting Web site is Travel
Jini (www.traveljini.com). Apart from pro-
viding some very interesting holiday
ideas, it also has a special honeymoon sec-
tion for romantic getaways.

Visit the hyperlinks page at Tourism
of India (http://www.tourismofindia.com/
foot/links.htm)for detailed information
about a particular state in India. Here, you

can find links to the official
sites of state tourism depart-
ments. To assist you in final-
ising your holiday destina-
tion, there’s Maps of India
( www.mapso f ind ia . com ) ,
which has maps of all the
states, their major cities 
and the connecting roads
and highways.

Tickets, please
Cryptic station names and
train codes notwithstanding,
the functionality of the Indi-
an Railways Web site
(www.indianrail.gov.in) has
improved immensely after its
re-launch in May last year.
The Web site not only gives
you extensive information of
train routes and timings, but
also lets you check the avail-
ability of seats. 

To book your train tickets online, you
need to log on to the Indian Railway
Catering and Tourism Corporation
(IRCTC) Web site at www.irctc.co.in.

If you want to travel by air, it makes
sense to plan ahead and avail yourself of
APEX fares. Alternatively, you can also try
the bidding options available at the Web
sites of domestic airlines. 

If you’re really lucky, you can save as
much as 50 to 60 per cent of the air fare.
Log on to http://indianairlines.indiatimes.com
to bid for Indian Airlines tickets. You can
place a bid seven days in advance, but the
bid will last for five days and is only avail-
able for selected routes. You can also buy
the tickets directly from the official Indi-
an Airlines Web site (http://indian-
airlines.nic.in), but there are a few limita-
tions—you can’t book tickets within 96
hours of departure and can’t book tickets
on discounted fares. 

Air Sahara also allows you to bid 
for tickets up to 15 days in advance. 
Visit http://airsahara.indiatimes.com, or www.
airsahara.net. 

Travel Jini also has a very useful fea-
ture called Flight Route Finder. Key in 
the origin and destination airport in India
and it shows you all the possible routes.
The site also gives you the route with 
the cheapest fares between the selected
destinations. 

Want to book a hotel?
“We have always stayed at the hotels of
our choice, without paying a premium,”
claims Rupesh Shah, a south Mumbai
businessman and a savvy traveller, who is
as meticulous as ever when he plans his
family vacation. Earlier, he would dig into
travel brochures or guidebooks for
advance hotel bookings. Now, he scours

The Maps of India site gives you decently detailed maps of just
about any holiday destination you choose

Find some interesting holiday ideas, exhaustive list of tour
operators and more information at the official website of
Ministry of Tourism at www.tourismofindia.com
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the Internet for the best deals available,
even booking the rooms online. 

Shah feels that Indian travel sites still
have a long way to go before they can
offer the best hotel deals. Most of the deals
offered are expensive. There are, however,
a few exceptions, such as the decent hotel
choices offered by Make My Trip
(www.makemytrip.com). For instance, if you
want to stay in Mumbai, you can find
hotels with fares ranging from Rs 2,200 to
Rs 11,000 per night. 

Likewise, Indian Hotel Booking
(www.india-hotel-booking.com) is a good
Web site to check for hotels situated in
major cities in India. The Web site has a
wide variety of hotels to offer—wild life
resorts, ayurveda resorts, spas, heritage
hotels, etc. 

Some Web sites, cater to hotel accom-
modations in a particular city. For exam-
ple, www.hotelsindelhi.net offers hotel 
rooms in Delhi, www.bangalorehotels.net

lists hotels in
Bangalore and
w w w . h o t e l s -
m u m b a i . c o m
for hotels in
Mumbai. 

Rent a car
So you’ve decided every-
thing, got your tickets,
booked the hotel, arranged
for a airport pick-up service,
but what do you do once
you get there? Taxis in a
strange city are always best
avoided, unless you have
money to burn. Well, you
can always hire a car. Travel
Jini lets you do so in any of
the 50 listed cities. And the
rates are affordable too. 

Normal full-day rental
charges for standard air-

conditioned car
are as low as Rs
800. Similarly,
Make My Trip helps you rent
a car in any of the 30 cities in
the country.

One more Web site that
offers car rental services is www.
carrental-india.com. Here, you
can book cars for a trip to any
major city. For other cities, you
will have to fill an online form
and you get a reply with
details. Not only does this Web
site let you book cars, but also
mini coaches, large coaches as
well as tempos.

Package deals
The first Web site to check for
package deals is Outlook Trav-
eller. Click on a destination,

and it will show you the deals available.
Make My Trip also has a lot of good pack-
ages deals on offer for the Indian traveller.
The Web site also lets you customise your
package tour according to your preferences. 

Travel Jadoo (www.traveljadoo.com) also
lists customised holiday packages—you
can choose the cities, the routes and the
mode of travel.

Get up, and get going
Truly, the Internet has a plethora of
addresses that you can knock at to get that
perfect idyllic deal. So, go net your spot,
pack your bags, and go surf the waves or
search for the meaning of life—it’s all a
few clicks away!

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

Hire a car online at www.carrental-india.com

Traveljini (www.traveljini.com) offers tour packages for
national and international destinations. If you are not
satisfied with the packages on offer, you can always
customise your own

We spoke to J Vinayan, Deputy
General Manager - Operations,
IRCTC. He told us how IRCTC’s
online reservation module is fast
becoming a viable alternative for
the Indian traveller.

He says, “We started www.
irctc.co.in in August 2002 with
around 100 reservations per day.
When we started, we delivered
tickets only in Delhi. Now we
deliver tickets in 111 cities and
facilitate more than 3,500
reservations per day.” He
attributes the increase in the
number of online reservations to
IRCTC’s strategic tie-ups with
banks, and of course, an
increasing Internet user base. 

“When a customer books his

ticket online, he gets other
advantages as well. Currently, 
we are running a special scheme
where we refund the booking
amount to one customer, 
every week.” 

He talks enthusiastically about
the future plans of IRCTC, “We
will soon introduce a host of add-
on services like getting PNR-status
alerts via SMS. Then, we will
introduce a scheme for corporate
bookings and later, we also plan
to introduce the facility of
booking ticket through mobile
phones.”

Looks like travelling for those
of us with Internet connections is
going to become a lot easier in
the near future.

IRCTC: The virtual reservation counter

Bid for Air Sahara tickets online at http://airsahara.indiatimes. com,
and save up to 60 per cent of the airfare most of the times
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... and gives weather alerts, and news updates, and
pings appointment alerts, and sends you instant 
messages, and manages your schedules. Soon, it may

tell you which girlfriend to date this evening. Want to
know how it works?

This watch
tells time...

Put Microsoft’s Smart Personal Objects Technology
(SPOT) on your wrist and you get news and weather
updates, stock quotes, sports scores, instant messages
via MSN Messenger as well as alarms that work in
coordination with Outlook. Of course, you can also
use it to tell time with precision, since it’s set using an
atomic clock as reference. 

Microsoft’s SPOT initiative aims to see more intel-
ligent daily objects providing useable information at
a glance. The idea is to take something as ordinary as 
a watch, a keychain, or a refrigerator magnet, look at
what its primary role is and see how this can 
be enhanced. 

A little over a year later, that’s what they have
done with the first of their SPOT hardware, taking
watches, and developing them into an entirely new
computing platform. Microsoft worked with chip
manufacturer, National Semiconductors, and com-
munication experts, SCA Data Systems, to design the
platform and the networking protocol that drives it.

Now, Microsoft has partnered with sports watch
manufacturers, Fossil and Suunto, who use this new
platform in their smart watches to provide customers
in 100 locations in North America with content from
Microsoft’s MSN Direct service.

SPOT isn’t going to be limited to watches. More
intelligent everyday devices are on their way, but the
watch is prime real estate to start from. Think fanta-
sy devices, and watches are a part of the deal. 

It’s not quite James
Bond’s watch. Yet.
Agent 007’s legendary

Omega has laser beam
metal cutters built into
it, a two-way
videophone and remote
detonators for mines
scattered about the
country. However, one
glance at the newest
range of Fossil Wrist
Netwatches, and you are
convinced that they’re a
fantasy come true.
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James Bond knows that, so does Mr
India. Interested customers—called ‘early
adopters’ in industry parlance—are signing
up for the service in droves. Alan Reiter,
wireless industry analyst and famed tech-
blogger (http://reiter.weblogger.com—rated by
Forbes magazine as one of the top five of its
kind), is one such early adopter. Customers
buy the watches from Fossil
and Suunto—they retail for
between $100 and $300—and
then subscribe to MSN Direct
(http://direct.msn.com) for $9.95
a month or $59 a year.  

Indian customers will
have to wait a while—
Microsoft says they have no
immediate plans of introduc-
ing the service in India.

When the service is off, or
you go out of range, it’s a nor-
mal watch; the rest of the time you get per-
sonalised content feeds straight from MSN
Direct on the watch face. The watch
receives data using an ingenious channel
of data propagation, FM radio. This com-
munication is strictly one-way; the watch
receives data from MSN’s content servers,
but doesn’t talk back to them. 

Microsoft says that they researched the
reactions of over 12,000 customers and
found that most people prefer quick,
glanceable information against two-way,
immersive communication. 

Binary tick tock
So what does a wrist-top fantasy look like?
It has a slightly large build; it doesn’t com-
pete with the slim and elegant offerings
from Swiss timekeepers, but it’s not much
different from the average sports watch.
Reiter finds the watches to be slightly large

and clunky. He admits it’s fun, but main-
tains that it’s still for geeks and early
adopters. Reiter should know, having used
the Suunto N3 SPOT watch for quite a
while now. 

On the inside, the smart watch is 
actually a small wrist-top computer. The
computing platform works on a seven-chip
custom chipset, which measures 34 x 

30 x 2 mm. Its main components
are a baseband processor built 
on the core of an industry 
standard Arm7 processor that is
commonly used in low-power
applications. 

According to National’s Cen-
trum Buero Information Telek-
ommunikation (CeBIT) 2003
press release, the custom-
designed integrated cir-
cuit (IC) runs at 28

MHz and processes the
received signals. The baseband
processors come built with dig-
ital signal processor (DSP) accel-
erators and have a unique 256-bit
identification number etched onto
the Arm7 core. 

The other ICs on this system
board include the sensitive
Radio Frequency (RF) chip,
which receives the FM
radio signals. The RF chip
can receive FM signals across
the entire range of the commer-
cial FM radio spectrum, from 88
to 110 MHz. The entire solution
lives off 512 KB of ROM and 384 KB of
RAM, which provides for sev-
eral days of alerts and
alarms apart from con-
tinuous updates of all

sorts. Power requirements for the system
are proprietary information, but we found
that SPOT watches use a unique induction
charging mechanism that needs the watch
to be placed on top of the charger; a full
charge should suffice for three to five days.

The SPOT system’s transmission pro-
tocols and architecture are just as inter-

Watches in most Hollywood movies are
just supremely expensive jewellery—from
Bvlgari, Cartier, Rolex, to Omega.

However, a handful of movies have
shown watches to be something more
than just classy time keepers. 

James Bond movies have shown the
debonair spy wearing
multi-functional devices in
his Rolex and Omega. 

In 1983’s Octopussy,
007 sports a Seiko
Sports watch with a TV
screen; in Golden Eye,
Tomorrow Never Dies and
The World Is Not Enough,
Bond sports classy Omegas
that have remote detonators, laser metal
cutters, and grappling hooks. 

American cartoon fantasy character,
Dick Tracy, had a two-way radio built into
his watch. Not to be left out, Indian
cinema had Mr India with a fantasy
watch that could make the person
wearing it invisible! 

Out in movieland, a watch is certainly
not just for telling time!

...This goes through
MSN’s content servers...

Send out Outlook alerts, IMs  and
content from MSN Direct... ..broadcasted via FM radio towers...

..and voila! Stock updates on
your SPOT watch!

The Arm7
chips used in
SPOT watches
are designed at
National’s India
Design Center,
located at 
Bangalore. 



esting; SCA Data Systems and Microsoft
worked on creating a noise tolerant, high
bit-rate solution that uses the FM sub-car-
rier technology. The system currently has
a throughput rate of 12 Kbps that is suffi-
cient for data to flow continuously into
the watch. Microsoft tells us the watches
run on an embedded software platform
that incorporates several .NET tools and
has  been optimised for miniaturisation
and minimal power consumption. 

Tuning in
Microsoft calls it DirectBand. The name
collectively applies to the radio receiving
units and the wide area network created
over existing FM radio networks. Direct-
Band works in association with US radio
broadcasters, using unused frequencies in
the radio spectrum for content broadcasts. 

While signing up for the MSN Direct
service, customers enter a unique person-
alised reception code—the 256-bit identifi-
cation register etched by lasers into the
Arm7 core—and set up the kinds of per-
sonalised content feeds they want. 

Currently, you can choose from public
feeds such as news, weather, sports and
stock tickers as well as private feeds such as
Outlook alerts and instant messages, all of
which, Microsoft says, are encrypted. A
plug-in connects Outlook to the MSN
Direct service. Then tasks and meeting
alerts can be set to make the SPOT watch
buzz you. To send instant messages via
MSN Messenger, right-click on the user-
name and choose to send messages.

All the information requested is 
routed in through MSN Direct’s data 
centre and then transmitted out on the FM
airwaves via local radio stations, en masse.
The RF chip picks up all the radio content
being streamed out, and sifts through all of
it to pick up and display only the content
specific to its unique personalisation code.

How good is it?
The service sports several cool features; one
among them is the ability to get fun faces
for each of the watches. Yet another is the
roaming feature. If you happen to move
out of one coverage zone and into anoth-
er, you don’t need to reset the time. MSN
Direct automatically does that for you, so
you always have the correct local time. 

Customers are excited at the watch’s
ability to sync with Outlook’s alerts and
get continuous content on the move.
There have been some teething troubles
though: Reiter points out that several
users have complained of network out-
ages, with Microsoft’s content servers also
giving trouble. 

Microsoft’s official spin on this is that
they are working on enhancing the Direct-
Band network; the bottom-line is that such
wireless networks are going to take a while
to reach reliability. 

First watches, then the world
Gauging the public reaction to the servic-
es, Microsoft looks forward to a point
where common everyday objects are going
to become smarter and more functional
using software. The idea is to have innocu-
ous, intelligent and pervasive devices 
existing side by side with the desktop. 
The future might be to have two-way 
communication. 

The moot point is that of acceptabili-
ty—would you junk your current watch
and choose to buy this clunky, possibly
more expensive watch? Reiter would tell
you that if he’d get a slimmer watch, with
a dependable, robust network, and more
feeds, he would consider switching over for
certain occasions. Until then, his hand-
some gold and chrome Cartier stays firmly
strapped to his wrist.

SRINIVASAN RAMAKRISHNAN

srinivasan_ramakrishnan@thinkdigit.com

96

insight ■
■ technology

APRIL 2004

Watches are no longer looked at as just time
pieces, and probably every single watch
manufacturer is planning on getting the
unthinkable into a watch. Already, sports-
watches have a variety of features—
temperature sensors and altimeters, slide
rules and tools for divers. 
The Fossil Wrist Net and Suunto N3 are
examples of what watches can become.
Fossil has also worked towards making
watch-PDAs, although they’re expensive. 

These are basically decent PDA-watch

hybrids, with standard Palm PDA features—
essentially, a personal organiser disguised as
a watch. Cell phone-watch form factors have

also been tried out. Last year, for instance,
NTT DoCoMo was looking at releasing the
WRISTOMO, a watch that lets you make
phone calls, send and receive e-mail and
exchange data at 64 Kbps. 

The good old two-way communicator
may well be coming alive, with Xact
Communications’ Wristlinx two-way radio,
which puts a radio transceiver into the
watch. It seems that next-gen watches will
either be personal communication devices or
personal organiser devices.

Watch’s the future like?

Calling secret agent Xact, here’s your next
mission!
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You may have an awfully huge col-
lection of MP3s on your computer,
and a majority of them may not be

correctly identifiable. Whilst copying
MP3s or ripping an audio CD, seldom does
anyone bother to fill in information such
as the artist name, song title, year, genre,
etc, into the MP3 file. And if you don’t fill
in this info, called MP3 metadata, or tags,

you won’t be able to use the tag-searching
feature of some MP3 players, which sup-
port playlist searches by searching on tag
information.

One of the many utilities that help you
fill in tags is Tag & Rename 3.0.6. Use it to
edit the tag as you play the file in your
default mp3 player. Of course, many play-
ers such as Winamp have a feature built-in
by which you can fill in the tag, such soft-
ware make it easier.

After installing, start the application
and take a look at the tabs in the open win-
dow. When you select your MP3
folder from the pane at the bot-
tom, the first allows you to
rename and tag a single file. The
second one does a batch job of
renaming and tagging a group of
MP3 files ripped from an album.

Click on the first tab. Tag &
Rename lists the files in the right-
hand pane with or without tag
information. It shows a column
view of the MP3 files with the file
name, title, artist name and

album fields. Right-click a file, and in the
menu that pops up, click ‘edit’ to edit the
tag. A window pops up wherein the ‘Gen-
eral’ tab displays song duration, bitrate,
copyright protection, etc. Enter the title of
the song, name of the artist, album name,
year of release and genre in this window.
Add the song’s lyrics into the MP3 file by
clicking on the Lyrics tab. Click on Save

when you’re done.
A cool feature supported is the

latest ID3v2 tag system, which
allows you to specify an image file
to be integrated into an MP3 file.
Thus, you can scan and resize the
album cover and copy it into all the
songs ripped from that album. Click
on ‘Find art file’ within the ‘Gener-
al’ tab, and browse to the image file.
Click Open and then Save. The
mp3 file is embedded with that par-
ticular image file. The size of the
mp3 file size increases by the size of

the image file, of course. Also, those play-
ers unable to read ID3v2 tags will not be
able to read the embedded image file, but
will play the MP3. Click on save to save this
information.

Next, in the ‘Rename’ tab, after select-
ing the files of your choice, click Rename,
and all the selected MP3 files are renamed
using the default naming convention—
‘Artist name - Title’. Customise the file-
name format by changing the File name
mask, using the ID3 identification mask
list to the right of this field. For example,

change the mask to ‘%2 - %1 - %3 - %4’ to
rename files in the following format—
‘Title - Artiste name - Album name - Year.’

Tick ‘Replace underscores with spaces’
if your MP3 files tags contain them. You
can also change the case of the filenames
to be generated. You can have the entire
file name in capital letters or small caps.
Alternatively, you may capitalise the first
letter of each word or just the first word
only. 

Select a group of files in the multiple
file tag editor, and fill in the information
in the fields labelled artist, album, year,
genre and click on Save Tags. This will fill
in all the tags in the selected mp3 files.

For those unfortunates who have no
idea which MP3 is the creation of which
artist, there’s a software known as Mood-
Logic (www.moodlogic.com). After installa-
tion, it asks for a login name for your
account and a password. Registration is
free. MoodLogic scans and saves all MP3s
on your hard disk to its playlist. It then
connects to the MoodLogic server and
automatically updates the MP3 tags. The
trial version allows you to update a limit-
ed number of MP3 files. You can sign up
for unlimited access. 

To update an MP3 tag, click on Tools >
Fix ID3 tags and file names. A window
showing the number of MP3s it can update
pops up. Click on Continue. The window
lists all the available information it can
provide and update. Select the check box
Fix file names and Fix ID3 tags to update
the ID3 tag information and also the file-
name of the file to artist name - song title.
Next, click on Fix All to complete the auto-
matic updating of the selected files.

A plug-in also lets you use MoodLogic
from within Winamp. 

So, go tag your mp3 files all nice and
proper, like you always wanted to, and stop
nonsense such as ‘Song%2025.d333"
scrolling across Winamp when you’re play-
ing a song for the first time!

NIKETU SHAH

niketu_shah@thinkdigit.com

Tag me if you can

Edit the tag information along with adding a small
image to the MP3 file

Add the lyrics too into the MP3 file itself

Don't know the name of the artiste serenading you? Time to get your MP3 tags in place!



Your PC used to be a rocket once, but
that’s all history now. All you can
do now is consider putting this

ancient tortoise out of its misery. Sounds
familiar? Does your PC take over 45 sec-
onds to start? Can you finish reading this
entire article while waiting for Adobe Pho-
toshop to open that 10 MB TIF file? It’s
time for an upgrade! And there's no need
to call in a team of hardware engineers
either—we’ll help you do it all by yourself!

Enough talk—time to get those
hands dirty.

First and most important, shut
down the PC normally, and dis-

connect the power cord from the mains.
Then disconnect all peripherals such as
the keyboard, the mouse, the printer etc.
from the cabinet. Set the cabinet gently
on a flat surface on its side.

Before opening the side panel,
ground yourself completely and get

rid of any electro-
static charge on your
hands, by touching any
metallic surface. This is
very important, as these random charges
can damage the motherboard’s delicate
electronics.

After opening the side panel, look
for the processor with the fan and

heatsink sitting on top of it, which is
usually somewhere close to the centre of
the motherboard.

First, you need to disconnect the
fan’s power supply. To do this, just locate
a thin group of three wires leading away
from the fan, and gently pull out the
connector linking these wires to the
motherboard.

At this time, it might
be a good idea to remove
the graphics card as
well, if there is very
little room to manoeuvre
within the cabinet. Now
to release the heatsink-
fan assembly, you’ll find
two clips holding it
in place.

These clips swing in
both directions, but

to release them, the
clamps have to be opened

outwards in an
a n t i - c l o c k w i s e

direction, till they
snap open and release

the plastic holding mechanism for the
heatsink (See picture Step 4).

Gently pull out the heatsink to
expose the processor, using both

hands (See picture Step 5a). Pull the
heatsink and fan out of the cabinet before
you attempt to remove the CPU (See pic-
ture Step 5b). Release the catch next to the
processor’s socket, and pull the CPU free
from the socket (See picture Step 5c). 

Unpack the new processor and plug
it gently into the socket. While

doing so, look for a small indicator on the
processor itself, and then match it with an
identical mark on the socket below, corre-
sponding to the pin layout on the CPU
and the socket (See picture Step 6). Do not
apply any undue force, because if you find
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Step 4: Open the clips holding the heatsink, as shown above

Sloth! One of the seven deadly sins, and your PC
is commiting it right now. Give it a shot of the
steroid called upgrade, and start your life in the
gigahertz world
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you need to, you’re probably doing some-
thing wrong. Push down on the latch to
lock the new processor in place securely. 

After plugging the processor in, apply
a little thermal grease  on the top sur-

face (See picture Step 7). You may not need to
do this, as most heatsinks today come
packed with paste already applied on them.

The thermal paste will absorb the heat
from the processor’s core and spread it
evenly for the heatsink to dissipate. Apply
the grease gently, and spread it evenly

over the processor’s core. This
step should be done very care-
fully, especially for AMD
processors, as their main core
is exposed and is not shielded
like those from Intel.

All the newer processors
come packaged with

their own certified heatsinks
bundled, and these are usually
sufficient. However, if you are
an overclocking geek or a

heavy-duty gamer, you may
require a larger heatsink and a
more powerful fan.

Lower the heatsink care-
fully. Be very gentle,

or you might damage the
processor core. Now, lock
the heatsink into place by
swinging the holding clips (See
picture Step 9), this time in the
clockwise direction. Finally,

reconnect the fan’s power cable back to
its original location. If you can’t find it,
refer to the board layout diagram in your
motherboard manual.

As against changing
the CPU, upgrading

the memory is comparatively
a piece of cake, and doesn’t
take more than a couple of
minutes.

The RAM slots are typi-
cally located close to the
processor, next to the con-
nections for the IDE cables.
Unclip the latches—usually
coloured white or beige—
located on the ends of the
slots, and pull the old
memory modules free from

the motherboard (See picture Step 10a). 
Of course, you may need to do so only

if you don’t have any free slots for the RAM
you want to add. Now, take the new
memory module and hold it at an approx-
imate angle of 45 degrees, at one end of the
slot (See picture Step 10b). At this point, just
ensure that the slit on the RAM module is
lined up correctly with the corresponding
spot on the motherboard’s slot. 

This slit is easy to identify, as its
location splits the RAM module into
long and short sides. Just press the
module down until it slides in and fits
snugly into its slot. Now, snap the clips
back up manually to lock it in place.

Now to mop
up, just place

any other components
you removed back into
their slots, before
closing the cabinet.
Reconnect all periph-
erals and the power
cable after setting it
upright. 

After all that hard
work , the efforts of
your blood, sweat and
tears—you get to press
the Power Button to a

For this all-important transplant onto your
PC, you’ll need only a few tools, namely: 
! A Philips head (+) screwdriver for those
pesky little screws
!A small box of thermal paste
! The most vital one—your motherboard
manual. The manual will assist you by
serving as a guide to the layout of the
motherboard.

If you don’t have the manual, there’s
no need to panic. There are dozens of free
utilities on the Internet such as Mother-
board Monitor and SiSoft Sandra, which
can help you identify your motherboard.
After identifying the component, you can
simply visit the manufacturer’s Web site,
download the manual and print it out.

Checklist

Step 5a: Use both hands if necessary to get a good grip on
the heatsink while detaching it

Step 5b: Lift the heatsink clear outside the cabinet, before
going for the processor

Step 5c: Remember to unlock the clip (shown with a red
arrow) holding the CPU down, before removing it

Step 6: Place the processor carefully, so as to not damage its core. Also
line up the marking as indicated by the arrow

Step 7: Apply the thermal paste gently to
form a thin film on the processor's surface
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revitalised and re-ener-
gised computer, which
will not only run your
applications and games
faster, but also more effi-
ciently and effectively.

Hold on there
Before rejoicing, you need
to listen for any warning
beeps during booting. A
single beep is healthy, but
a series of beeps indicate
that one of the compo-
nents may be loose—open
up the cabinet again, and
ensure that the video card
is placed securely, and the
RAM modules are locked
tight in their slots. One last
step—before the OS loads,
access the BIOS screen and
check if the values for the
CPU voltage and speed are
reported correctly. For
some BIOS versions, you
may need to enter these
values manually, but
beyond that, you need
only watch in wonder as
your computer is trans-
formed from a lumbering
truck to a slick sports car.

ANIL GANGOLLI

anil_gangolli@thinkdigit.com

Step 9: Lower the new heatsink slowly, till it sits snugly above
the processor

Step 10a: Press firmly on the white clips with your fingers to
release the RAM

Step 10b: To insert the RAM module easily, hold it at an angle
above the slot

1 COL AD

Before you step into DIY mode, there are
a couple of important things to consider. 

First, if your computer is a branded
model, you should know that by
carrying out the upgrade, the service
warranty offered by the dealer will
cease to exist. Although some OEMs
may allow for some minor upgrades
such as replacement of keyboards
and mice, any attempt to open the
cabinet, and change the components
within, is regarded as a violation of
the service contract. 

Therefore, it would be a better idea
to carry out any upgrades after the
service period is over. 

When buying components, always
insist on original box-packed CPUs and
good quality RAM modules. An
important factor that you must consider
here is the type of pin arrangement your
processor has, to connect with the

socket on the mainboard, especially if
you have an Intel-based system.

The older Pentium 4 processors
(codenamed Williamette) had an
arrangement of 423 pins, but beginning
with the Northwood series and later,
Intel has been using a 478-pin
arrangement for the socket. In
comparison, AMD CPUs have stuck to
the tried and tested Socket A standard.

So if your motherboard will only
support an older series of processors,
upgrading the motherboard too would
be a good idea.

The same recommendations stand
while procuring the RAM modules. The
prevalent memory standard is DDR RAM,
faster than the older SD RAM, which has
almost been phased out. RD RAM, too,
is almost out of the scene—and besides,
these memory formats are more
expensive than DDR RAM.

Things to look out for
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Creating PowerPoint presentations is
easy. However, presentations that
drive the point home succinctly,

need some finesse. If you like your pre-
sentations to be appealing and leave an
impact on the boss and members of the
committee, then you need animation or
movies with some great audio in them
that will make them sit up and take notice!

Animations
Slideshows with animated text, pictures and
other content help you hold the interest of
your audience, to emphasise important
points and also make maxi-
mum usage of slide space
by moving elements on the
slide. However, do not over-
use this element as it dis-
tracts from the main
presentation. 

You can have six types
of animations in Power-
Point. The first is Transition.
This is the effect that you
see when a slide is revealed.
The other five types of ani-

mations apply to the individual elements
of the slide such as title, body, images, etc.
Entrance is how an element enters the slide
and Exit is how it exits.

The third type is Emphasis—when you
highlight something to direct attention to
it, while Fading is used to leave an element
and move on to next.

The fifth type, Motion Path, is probably
the most interesting animation  to work
with. It defines the path along which an
element moves.

Here come  12 cool things you can do
to enhance your presentation:

your
Throw in some animation and movies with the right
noises and slide up the interest in your presentations!

The easiest way to
animate slides is by
using preset
Animation Schemes—
sequences of effects
that can be applied to
any slide, or the
whole presentation. 
Press [Ctrl] + [F1] to
activate the Task
Pane. Here, go to Slide
Design > Animation
Schemes, choose a
scheme and click
‘Apply to all slides’ to
use the the scheme
for all the slides.
Preset Animation
Schems cannot

animate individual elements. For that, you
would require Custom Animation. 

Schemes

Power up

Find it on the
Mindware CD
: In the April

2004 Mindware
CD, you will find all the
files we have used
throughout this article.
Play around with that
presentation, or just see
the power of Power-
Point in action

pOint
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Custom Animation lets you animate individual elements
on the slide. The Custom Animation task pane provides
you with many such effects. Once added, you will see a
number that indicates the playing order (marked with a
‘1’ in the screenshot), star symbol that indicates the type
of effect (marked with a ‘2’ in the screenshot) and a
mouse or a clock icon that lets you know when the effect

will start
playing
(marked with
a ‘3’). Step 3
goes into the
nitty-gritties
of adding
them to your
presentation. 

Select a Custom Animation and click on Add Effect to
bring up a pop-up menu. Here, choose an effect and then
point to an option in the second pop-up menu. Click on
‘More Effects…’ to see all the effects available under that
type. A preview of the effect is shown immediately. The
text on the Add Effect button changes to Change if you
have already added some effect to an element. Step 4
shows you ways to fine tune these customisable options.

Right-click on the effect to access the ‘Effect Options…’
menu. Here, you can change the settings for that button.
You have three choices when it comes to setting the start
time of the animation: ‘On click’ activates the animation
only when the mouse button is pressed. Select ‘With
Previous’ to start the animation with the previous
animation. ‘After Previous’ causes the animation to
commence once the previous animation is over. You can
also choose the direction, speed and attach a sound to
an effect as well. Jump to Step 5 to learn about another
powerful way of adding animation—Motion Path. 

A motion path is the track along
which the element on the slide
moves. To add the motion path
to an object, select it and go to the Custom Animation
task pane. Click the Add Effect button, go to Motion
Path and click on ‘More Motion Path’ to choose a preset
motion path. When you click on a motion path, the
selected element on the slide shows you the preview of
the animation, provided you enable the Preview Effect
checkbox. You can also draw your own motion path.
Simply, click on Add Effect and go to Motion Paths >
Draw Motion Paths... To edit the motion paths, see the
next step. 

Custom Animations Adding Custom Animation

More Custom Options

Motion Path
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A motion path has three components. A green arrow
(marked ‘1’ in the screenshot) denotes the starting
point, a red arrow (‘3’) denotes the end point and the
path is shown as a dotted line (marked as ‘2’). Right-
click the path for a shortcut menu with three options:
‘Reverse path direction’ that interchanges the green
and red arrows, ‘Close path’ that draws a straight line
from the red arrow to the green arrow, and thus closes
the path, and ‘Edit Points’. Click ‘Edit Points’ to view
the points. Drag these to edit the path. Usually, it’s
easiest to apply a preset path and edit it according to
your requirements. With motion, you do need sound.
Here’s how you byte them in. Presenting Step 7! 

Inserting sound in a slide is simple. Go to Insert >
Movies and Sound > Sound from a File and select the
desired sound file. This done, PowerPoint will ask you
whether you want to play the sound automatically or
when clicked. After this, a small speaker icon appears
on the slide. Now to tinker with these sound notes...

To set advanced sound options, go to the Custom
Animation task pane, click the speaker icon, right-click
the effect and choose ‘Effect Options…’. Here, you will
find options to set the Play and Stop, repeat, etc. You can
also specify the number of slides for which the sound
should play. You can access some of these settings by
right-clicking the speaker icon and choosing ‘Edit Sound
Object’. If you insert a .wav file smaller than 100 KB, it’s
embedded in the .ppt file. Otherwise, they are just
linked. Wanna play Audio CDs with presentations too?
Go to the next step to learn how. 

Go to Insert > Movies and Sound > Play Audio CD track…
and choose the Audio CDs. You can specify the start
and end tracks and few other options here. 
You want movies in too? It’s possible. Here’s how.

Fine Tuning the Path Playing Sound

Set Sound Options CD Audio
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The last word
So that’s the way you get your presentations to make their point
with aplomb. Indeed, they are bound to go a long way in getting
those much-sought smiles and nods of satisfaction at the end of
the show! 

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

Inserting movies into a slide is very
similar to inserting audio. Right-
click the inserted movie and
choose ‘Edit Movie Object’. Here,
you find options to ‘Rewind 
movie when done playing’, 
‘Hide while not playing’ and
‘Zoom to full screen’. 

Note that movies are never
embedded, but always linked.
Hence, while transferring the .ppt
file onto a CD, you will have to
copy the movie as well. Use the
Pack and Go wizard found under
File menu, to put all the linked
files in one folder, which you can
then transfer onto the CD. 

So far we have seen that the movie or the audio file that
we have inserted plays when clicked. You can create
buttons to play, pause or stop the movie or audio, thus
giving your presentations a professional touch. To create
an action button, go to Slide Show > Insert Button.

Here, click on a button that you wish to insert.
Now, click on the movie and switch to the Custom
Animations task pane. You will see an entry to Play
and Pause the movie. Right-click Play and choose
Effect Options.

Now switch to the Timing tab and click the Triggers
button. Click ‘Start effect on the click of:’ and click on
the button you just created. Click OK to close the dialog
the box. Repeat the process for the Pause effect.

The Stop action needs to be added before you get the
Stop button in place. Here’s how that’s done.

To create the stop button, you need to add this effect
first to the movie. This is necessary because the Stop
action is not added to the movie by default.

Click the movie and then click the Add Effect but-
ton. Go to Movie Actions and click Stop. You will see
this entry in the Effects list-box.

Create an action button as explained above and
assign it as the trigger to stop the movie. This process
works for audio as well.

Playing Movies

Creating Action Buttons Add Stop
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rvind Chandrasekar laughs as he says,
“If you don’t like someone, just start
packeting them...happened to me,
many times over...”. Chandrasekar has
really good reasons to secure his net-

work. Business development manager for AMD Far
East, long time IRC user and a techie to the core, his
many computers at home and a fat pipe to the Inter-
net has made him a favourite target of cranks and
phreaks. Even as we speak to him, he’s being 
packeted, but he isn’t worried; his stripped-
down Debian Linux-based 386 provides him with
enough protection.

Protection, of course, is key. When you go online,
don’t think of doing so without adequate protection.
You might think a Linux box is immune to the nas-
ties of the world, but there’ll always be people ready
to come and probe your computer, and use your 
network resources—it’s like getting mugged in a 
dark alley.

The only way to make your computer truly secure
is to stay off the Net, and even your LAN. But don’t
worry—we’re here to help you avoid such drastic
measures. We loaded up Red Hat Linux 9 on a test rig,
used the default installation options, and configured
it to connect to our LAN and to the Internet.

LLoocckk LLooaaddn

AA

LINUX
You just set up your Linux

box, and think you’re finally

safe; well, think again.

Use these standard tools 

to secure it 

LINUX



You are as vulnerable as the software that’s
installed on your machine. As soon as you
install Linux, be sure to update all the
packages you installed. This is especially
important if you’ve installed an older ver-
sion of Linux—several security issues
would have arisen since its release, and
addressed in subsequent updates. 

By default, Linux tends to start up a
whole bunch of unwanted services, and

what’s worse, having them running
makes your computer more vulnerable to
attacks. First, look for daemons—system
services that are listed. These wait for a
signal or connection and make a list of
what you don’t want or need. For
instance, the Common Unix Printer Sys-
tem (cups) and Linux Printer Daemon
(lpd) daemons are useless if you don’t
have a printer connected, either directly
or via a network. 

To look at all the services currently
running, click on the Red Hat button and
go to System Settings > Server Settings > Ser-
vices. This opens up the Service Configu-
ration applet, which lists out all the
daemons that can run on the machine.

The left-hand pane lists out the servic-
es, and the description and status are list-
ed on the right. To start or shut down a
service, highlight it and select Start, or
Stop, from the menu bar on top.  

Each service listed has a checkbox next
to it; if this box is ticked, the service will
automatically start when the machine
boots. Uncheck the box to prevent the
service from automatically starting. 

What you don’t need
Here’s a list of services that you might
consider switching off:
APMD (Advanced Power Management

Daemon)—Only needed if
your power source is a bat-
tery, as in laptops.
atd (AT Daemon)—Used
to start a job like cron does;
it’s not needed, as you can
set the system to run sched-
uled jobs using cron.
cups and lpd—Only need-
ed if you have a printer
connected.
httpd (the Web server
service)—Only needed if
you run a Web server.
Sendmail (the mail trans-
port agent)—Only needed
if you run a mail server.

Chandrasekar points
out that people routinely
run Sendmail on Linux or
Unix, and it doesn’t take
much to attack known vul-
nerabilities in Sendmail.
Worse, people can exploit
your computer by running
port scans and using your
computer as a mail relay to

send spam.
These are just

a few services
that you can ter-
minate for good,
but there will
always be even
more that you’re
left in doubt
about. Here’s
where descrip-
tions come in
handy. Highlight
a service and
read through its
description on
the right. For
instance, telnet
and sshd are
both used to
access the
machine from

remote locations, so if you don’t plan on
doing so, turn them off—this will prevent
others from doing it.  

Although you’re safest with a mini-
mum of services or daemons running,
make sure you have every service that’s
vital to the functioning of your machine
turned on. To list out the whole set of
services, type in ‘chkconfig -list’. This lists
out all services, including those started by
xinetd—a daemon that starts network
services. 

Chkconfig will also tell you which
services start on which run-level. Think of
run-levels as different modes of operating
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The Service Configuration applet lets you start, stop and restart
services

ntsysv is almost as good as chkconfig, and is easier to work with because of
the Curses interface 

Your PC’s downfall—its software

With huge numbers of computers
scattered all over campus—over 1,800
PCs connecting just from the 
13 hostels—IIT Bombay’s networks have
Windows and Linux-based PCs
connected to their network backbone.
We spoke to Dr J P Maharana, the
systems manager at the Computer
Center, who told us that IIT-Bombay has
started recommending using Linux-
based PCs, ever since the Blaster attack
last year bogged down their networks—
due to infected Windows PCs. 
Dr. Maharana himself runs Linux on his
workstation and says that just about
everything can be done with Linux. His
advice to both Linux and Windows
users is, “Get all critical system updates,
and ensure that your antivirus
definitions are updated as well.”

Linux at IIT-B
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Your Linux distro comes with its own fire-
wall—the iptables firewall system.  ipta-
bles is a 2.4 kernel feature, which was
known as ipchains in prior distributions.
Chandrasekar’s router-and-firewall is
based on ipchains, and though he has no

problems with iptables, he prefers not to
fix what ain’t broken.

On Red Hat 9, iptables is standard, and
we’ll show you how to tweak it. Essen-
tially, the firewall system is built into the
Linux kernel, and is called Netfilter. ipta-
bles is the interface that controls Netfil-
ter, and is relatively easy to configure,
once you understand how it works.

As with any firewall system, iptables
works with a set of rules; these rules will,
for instance, allow all outgoing traffic,
block inbound traffic for specific services,

etc. The default firewall (Medium Profile)
that you can choose while installing Red
Hat Linux 9 is pretty secure—for example,
remote access techniques are closed down.
This configuration works on the basis of
accepting all connections, and then deny-
ing specific access. Of course, you can
choose to be less, or more, paranoid.

We used the following sample config-
uration for the firewall on our Linux test
rig—sourced from the book Red Hat Linux
9 for Dummies. The logic is simple—deny
all connections, and then accept for spe-
cific services. Each of the following is a
command that you can only enter when
logged in as root.

You can check your current iptables
rules by typing in ‘iptables -L’. Then flush
out the current rule set using ‘iptables -flush’.

Next, set the firewall to deny absolute-
ly everything—incoming, outgoing and
forwarded traffic—by typing:

‘iptables -policy INPUT DROP’
‘iptables -policy OUTPUT DROP’
‘iptables -policy FORWARD DROP’
This is ultimate security, but it also

means you’re cut off from the world. So,
we need to start selectively accepting
incoming traffic. You need to start out by
typing in

‘iptables -A OUTPUT -j ACCEPT -o lo’
‘iptables -A INPUT -j ACCEPT -i lo’
These two commands allow the

machine’s loopback interface to work,
thus allowing the OS to send and receive
packets that originate from, and are
directed to, the machine itself.

All fired up

Use the ‘iptables -L’ command to check your setup, after you’re done configuring the firewall

the machine—run-level 3 will not start
with a text login, run-level 5 will start a
GUI login, and run-level 1 is single-user,
root-only mode for repairing 
your machine.

You can use ‘chkconfig <service name> off’
to prevent a service from running at start-
up—<service name> is, of course, the
name of the service you want to stop, for
example, ‘chkconfig sshd off’.

You can also use ‘service -status-all’ to
inspect and change the current status of
all services listed. You can start a service
using ‘service <service name> start’, and stop
a service using ‘service <service name> stop’.
To stop and restart a service, and force it
to read and implement any changes you
made in its .conf file, use the ‘service <serv-
ice name> restart’ command.  

Alternately, if you like the GUI feel,
you can use the ntsysv utility to tweak
services within the current run-level from
its basic cursor interface, which is easier to
navigate.

Remote access services are perhaps the
easiest way to attack a machine.
Common remote access tools include
Telnet, RSH, SSH and FTP. To secure
remote access, use the following tips:
First, disable access to your computer
for Telnet, RSH, and FTP. If you want to
keep FTP, at least disable anonymous
login. Secured remote access is highly
recommended, so make users SSH to
your machine and use SCP for
transferring files. Both SSH and SCP are
built into Red Hat Linux 9.
While using SSH, here are some very
important tweaks. SSH protocol 1 is

not secure anymore; force the use of
protocol 2, which also allows for FTP.
Do this by editing /etc/ssh/sshd_config.
Change ‘Protocol 2,1’ to ‘Protocol 2.’ 
Next, prevent root logins via SSH.
Enforce a two-step root login, wherein
users first use a low-level account to
login, and then su to become root.
Change ‘PermitRootLogin yes’ to
‘PermitRootLogin no’. Finally, don’t
allow any remote logins without
passwords—ensure that the
‘PasswordAuthentication yes’ and
‘PermitEmptyPasswords no’ parameters
remain unchanged.

Secured Remote Access
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‘iptables  -A OUTPUT -m state --state
NEW,RELATED,ESTABLISHED -j ACCEPT’

‘iptables -A INPUT -m state --state RELAT-
ED,ESTABLISHED -j ACCEPT’

These open up the machine a little—
allowing all outbound packets to get out.
At this point, your machine will still not
accept any other requests, such as those
for ssh remote access. If you want to
allow sshd to accept incoming connec-
tions on port 22, type in

‘iptables -A INPUT -p tcp -m state --state
NEW,ESTABLISHED -j ACCEPT -dport 22’

Similarly, if you’re running the Squid
proxy caching server on port 3128, you

could use the following command to
allow access to other machines:

‘iptables -A INPUT -p tcp -m state --state
NEW,ESTABLISHED -j ACCEPT -dport 3128’

Of course, this is if you’re using the
default configurations of the services. For
example, if you need to run Squid on
port 8888, you’ll need to change Squid’s
config file, and also set your firewall to
accept connections on port 8888 by typ-
ing in ‘iptables -A INPUT -p tcp -m state --state
NEW,ESTABLISHED -j ACCEPT -dport 8888.’

Remember, custom iptables com-
mands work only as long as the comput-
er is running; if you reboot it, you’ll need

to re-enter all these. Or, you can save
the commands as a script. iptables picks
up the initial script from the /etc/syscon-
fig/iptables file. Once you’re done setting
up your firewall, backup this file and
then use the ‘iptables-save > /etc/syscon-
fig/iptables’ command to save your fire-
wall settings.

If you don’t fancy command-line
interfaces, there are several GUI tools to
use along with iptables. One of them is
Firestarter (http://firestarter.sourceforge.net),
which provides a point-and-click inter-
face. Be warned, though—on Red Hat
Linux 9, Firestarter isn’t very stable.

It’s a little more fun securing a Linux-
based computer than a Windows PC;
there’s just so many more good tools
available—made by hackers of all sorts.
Here are some powerful, essential tools
that you should have. Read the man
and info pages for all of them, to access
detailed settings.
Chkrootkit (http://www.chkrootkit.
org/): Rootkit is the term used for
special tools by hackers, once
they’ve gained access to a machine.
A rootkit could be something like a
tainted ‘ps’ program, which will
never show a trojan or a backdoor; it

could be any binary written to mas-
querade as a legitimate Unix tool,
but it is malicious. Think of a ‘ps’
program that has ‘rm -rf *’ written
into it! To scan for such well-known
rootkits and backdoors, use chk-
rootkit. Once installed, run the pro-
gram and check whether it detects
any rootkits. The sad thing is, if
there are rootkits installed, there’s
no guarantee that all will be found;
your only option is to remove the
ones detected, check your system
logs, and as a worst-case-scenario,
clean format and reinstall Linux.

Nmap (http://www.insecure.org/) is a
tool that maps your computer’s ports as
seen by others. It has numerous fea-
tures, and can be tweaked to show a lot
of detail. It’s available on the Red Hat 9
CDs, but you should download and
install the latest version. Use Nmap
aggressively from a remote computer to
check for the presence of offending tro-
jans and backdoors. Combine it with
‘netstat’ and ‘ps’ to take out all such
offending processes. We detected tro-
jans on our test rig using Nmap. 
F-Prot (http://www.f-prot.com/): Don’t
kid yourself into believing that your Linux
machine doesn’t need an anti-virus pro-
gram. Worms and viruses come for all
OSes. Get F-Prot, install it, and run it reg-
ularly. It comes free for use by home
users, and is a command line scanning
tool. Be sure to update it as often as you
would for a Windows PC.
Tripwire (http://www.tripwire.org/) is a
tool that checks file integrity. It checks
signatures and several binary attributes
for security. If the essential Linux pro-
gram binaries have been attacked, tell-
tale signs such as a change in the signa-
ture of the programs are seen. 
This is the sort of change that tripwire
will detect. 
PortSentry (http://sourceforge.net/
projects/sentrytools/) is a tool that runs
as a daemon and monitors TCP and
UDP ports. PortSentry will block scan-
ning hosts from making connections to
your machine.

The Toolbox 

Nmap picked up numerous trojans in this scan 
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Linux features several tools that show
you how secure your computer is. Start
with the basic ‘ps’ tool to view all
processes. After
this, the ‘net-
stat’ tool will
show you all
open and closed
c o n n e c t i o n s .
The ‘-a’ switch
shows the sta-
tus of all ports;
the ‘-p’ switch
shows the PID
and name of
the program
that accessed
the port. You
should see a full
list of all the
programs that
are setting con-
nections; use
this with the
‘Nmap’ tool (see
box ‘The Tool-
box’ on page
109) and terminate all offending pro-

grams. If the services need to be shut
down, do so using the Service Configu-
ration applet. Finally, make any required
changes to the iptables, and save all 
your changes. 

Here’s a little true story to prove 
that danger is not just limited to the
Internet.

To check out the security of our test
rig, we formatted our disk and loaded
Red Hat Linux 9. Then we tweaked the
firewall, and the machine was denied
access to the Net. 

We allowed sshd to run, and allowed
the entire local LAN subnet access to it
via SSH2. Within 12 hours of the install,
the machine managed to attract four
trojans. Even though there are over 200
hosts on the subnet, this machine was
still targeted! Of course, setting the root 
password to ‘rootuser’ probably wasn’t 
a great idea in the first place. 

Moral of the story: it’s entirely cloak
and dagger, good guys perennially fight-
ing the bad guys. So, secure your com-
puter as you go online—and please don’t
use idiotic passwords.

SRINIVASAN RAMAKRISHNAN

srinivasan_ramakrishnan@thinkdigit.com

Dos:
!!Ensure that you use a non-superuser
account for everyday work
!! Keep making regular backups
!!Monitor your logs routinely—don’t
wait for security-related incidents to
happen to start scanning them
!!Update software regularly; at the least,
install all security updates
!!Keep the firewall, antivirus and other
security software up at all times

Don’ts
"" As far as possible, don’t allow remote
access; if you must grant remote access,
only allow SSH-2 
"" Don’t install binaries without checking
the signatures that accompany them
"" Don’t set easy passwords
"" Don’t let unnecessary services run.
Turn them on when needed and turn
them off once you’re done 
"" Don’t tell anyone your root password

Dos and Don’ts

Your Linux install has two files located in
/etc, which enable you to selectively allow
and ban other computers and networks.
Start with the /etc/hosts.deny file. Open it
in an editor and add this line:

ALL:ALL EXCEPT localhost
This bans all services—the ‘ALL’ bans

all hosts, and the ‘ALL EXCEPT’ exempts
your own machine. Now, to allow access
selectively, open the /etc/hosts.allow file,
and allow selected hosts to access servic-
es. For instance, if you want all comput-
ers on your private network—like
192.168.*.*—to SSH into your machine,
add the line:

sshd:192.168.
This will allow all computers on the

192.168.*.* subnet to access the sshd serv-
ice. Remember, the hosts file alone is not
sufficient. “It’s too easy to spoof and gain
access. It makes sense to tweak both this
and the firewall”, says Chandrasekar—
which brings us to finding out how secure
your machine really is. 

Kernel support
There are a couple of kernel-level features
that help you secure your rig. These pre-
vent IP address spoofing, and also prevent
a common DoS-style attack.

Using IP spoofing, an intruder sends
out data packets that claim to be from
some other host—this conceals the
intruder’s identity. The kernel supports
Source Address Verification, which can
repulse such attacks. By default, this is
disabled; navigate down to
/proc/sys/net/ipv4/conf and inspect the
directory. All your network interfaces

By invitation only

It’s audit time

Play ball

will be listed here. Under ‘all’, Proc file
settings common to all interfaces are
found, so choose that. To enable Source 
Address Verification for all listed inter-
faces, type in

echo 1 > /proc/sys/net/ipv4/conf/all/rp_filter
To turn them on selectively, choose

the right interface, say, eth0, and type in
echo 1 > /proc/sys/net/ipv4/conf/eth0/rp_filter

Use the netstat -punta option and get to know which program is talking 
to which server
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AAuuttoo-ppoowweerr ddooeess nnoott wwoorrkk

I have a few problems. Recently, I
installed Windows XP Professional alongside
Windows 98. Now, I see three options in the
boot menu: Windows XP Professional, Win-
dows XP Professional and WINDOWS 98.
How do I remove that extra Windows XP
option? By the way, XP is loaded in C:\Win-
dows.000 and 98 in D:\Windows.

Also, the machine doesn’t power off
automatically when using Windows XP.
This is not so with Windows 98. As I have
an ATX power supply, I guess by default it
should turn off automatically. Please help
me solve these problems.
Tapas Kumar Mahata

For your first problem, open the file
c:\boot.ini using Notepad. You will
observe that it has two rows with
Windows XP Professional mentioned.
Keep the following line: 

multi(w)disk(x)rdisk(y) partition(z)\win-
dows. 000="Microsoft Windows XP Professional"

Delete the other row, save the file and
restart your PC. 

As for your second problem, you need
to enable Advanced Power Management
(APM) for your system. To do so, go to
Control Panel > Power Options. Here, click on
the APM tab and select ‘Enable Advanced
Power Management support’. Once done,
your PC should shutdown automatically.

Files deleted
by anti-virus
software

I have a Windows
98 PC that uses a Cyrix
Media GX processor,
64 MB RAM and runs
Norton AntiVirus Soft-
ware. It deleted certain
files while scanning for
viruses. Soon after that,
several programs failed
to open and I get the
following error:
‘Program not found.
Windows can not 
find SirC32.exe. This 

program is needed for opening files of
type ‘Application’. Location of SirC32
.exe.C://’. The error message box has
three buttons: OK, Cancel and Locate.
What should I do?
Ashwin Doshi

The filename is that of a virus that
infected your PC. Norton scanned the
machine and deleted it. However, its
residue effect is still present and that is
the cause of the error message. The sim-
plest way out is to download and exe-
cute the virus fix. Norton has one such
fix available at http://www.sarc.com/avcen-
ter/ FixSirc.com. 

Connecting computers in the
same locality

I have a Pentium 4 2.6 GHz, 512 MB
RAM and a GeForce4 128 MB video card.
My friend also has the same configuration.
We would like to play multiplayer games,
but our Internet connection is too slow. Is
there any hardware upgrade possible that
will connect our PCs directly? We would
prefer something that does not need a tele-
phone line. My friend’s house is just a five-
minute walk away from mine. Also, do let
us know the costs involved.
Rahul

You will get a better performance if
you connect to your friend’s computer

PCs lying about their disk space?
Refusing to talk sans a password? Here’s how you get them to behave!

➜
Check the ‘Enable Advanced Power Management support’ option to
take advantage of APM and at the same time save on electricity bills!
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directly using a telephone line. In this
case, instead of you and your friend
dialling out using two different tele-
phone lines to connect to each other via
the Internet, you use just one telephone
line to dial straight to your friend. This
cuts down phone bills by half.

Alternatively, if you and your friend
stay within 150 metres from each other,
consider using a cross-over cable.
Beyond that you will have to make use of
repeaters and  you need to find a feasible
intermediate location to attach the
same. You will have to spend around 
Rs 900 for two LAN cards, about Rs 800
per repeater and Rs 10 per metre of
cables used.

Opt for an ‘Always On’ service
provider if your locality has one. These
connect PCs to a small network and
thereby provide Internet access to the
PCs. In this way you could get connected
on a LAN and then play games.

Another alternative is to set up a Wi-
Fi network but this is possible if you and
your friend stay in line of sight. This solu-
tion also depends on a lot of environ-
mental factors. Typically, you will need a
wireless LAN card plus a couple of high-
gain antennas. You could buy a high gain
antenna or make one yourself. You will
find lot of stuff on the Internet in this
regard. The total cost of this solution
should be around Rs 15,000.

A VGA compatibility issue 

I have a Pentium 4 1.6 GHz CPU and a
VIA motherboard. Now, I wish to upgrade

the VGA card, but I don’t know which one
to opt for? My friend also has a VIA moth-
erboard and a GeForce4, but it causes a lot
of problems while playing games. My deal-
er recommends the Max Force GeForce4;
should I buy that?
Rohit Singh

Yes, there are a lot of issues with the
VIA motherboard and the GeForce4, so
before buying beware. To counter the
problems that arise, you need to con-
stantly look out for BIOS and mother-
board updates and install them as soon
as they are released. If possible, get the
motherboard replaced and then think of
buying a new VGA card.

DAT, .INI and .DLL

Of late, I’ve been facing several prob-
lems. My configuration is a Celeron 466,
128 MB of RAM, an 8.4 GB hard disk, and
Windows 2000 Professional. Here’s what’s
been happening:

I can’t play .DAT files off my CD-ROM.
They run from disk, though. I tried re-
installing Windows but it didn’t work.

I can’t find the boot.ini file on my hard
disk. I’m able to open it in Notepad, but
after I’m not able to save it after modifying
it’it says that I "need to change the Read-
only Attribute." In order to do this, I do a
search for the file, but it doesn’t show up in
the results.

On a system with a VIA chipset Trident
motherboard, 128 MB of RAM, a 20 GB
hard disk, and a P-III 1 GHz, I’m not able to
install three OSes. I have three partitions’

a 5 GB, another 5 GB and a 10 GB. On the
first I have Windows 98, the second one is
for  Red Hat Linux 9, and the last is for XP.
Without Linux, the other OSes used to run
fine, but after installing Linux, when I try to
boot into XP I get this message: "HAL.DLL
is missing or corrupted." I tried the SFC on
Windows 98, found the HAL.dll file, and
extracted it from my XP CD to put it in the
proper location, but it didn’t work.
Any answers?
Mayukh Chowdhruy

If you are able to copy the .DAT
movie file from a VCD to your hard disk
and play it, the problem is clearly hard-
ware related. Older CD-ROM drives may
have problems reading non-original CDs
properly. The drive must retry reading
multiple times before it picks up error-
free data. This means that the data flow
is slowed, and the drive may get very
hot. To play back a movie smoothly, data
flow should not be interrupted in this
manner. You may try a "Lens Cleaner"
CD, but in all probability this problem
will only be fixed by a new CD Drive.

There’s no doubt that your boot.ini file
is in C:\. You can’t find it because it’s hid-
den, and you can’t save it because it’s
read-only. To view hidden files, 
start Windows Explorer, and go to Tools >
Folder Options > View. Select ‘Show hidden
files and folders.’ Now you’ll be able to
see the boot.ini file. Select the file, right-
click it, and choose Properties. Here, uns-
elect ‘Read-only’ and click OK. Now you’ll
be able to modify the file as well.

To recover the HAL.dll file, boot from
your Windows CD and choose the
‘Repair’ option. This will prompt you for
the Windows installation to use. Supply
the Administrator password, and you’ll be
able to restore any file you want to. Now,
execute the following command at 
the prompt:

expand x:\i386\hal.dl_ y:\windows\sys-
tem32\hall.dll. Replace ‘x’ with the drive
letter of your CD-ROM, and ‘y’ with the
letter of your Windows XP partition.
Restart the machine, and you’ll be able
to boot into XP.

Norton error

Whenever I install Norton AntiVirus
2004 Professional on either Windows Me
or Windows XP, I get an error message say-
ing "Norton antivirus has encountered an
internal program error (4002,517)". I
downloaded the 15-day trial program from

Negotiations between 98
and 2000

I have set up two Windows 2000
Professional PCs and two Windows 98
PCs on a LAN. I am asked for a user-
name and password while connecting
from a 98 machine to a 2000 system.
This does not happen when
accessing the Windows 98
PCs from a Windows 2000
PC. How do I get the Win-
dows 98 computers to
access the Windows 2000
computers?
Ashutosh Chatterjee

Create a user
account on both the

2000 computers and specify a pass-
word for each. To do so, go to Control
Panel and click on ‘Users and
Passwords’, to add new users. Use these
accounts to connect from the
Windows 98 system.

Illustrations: Mahesh Benkar
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Symantec’s Web site and activated it as well
as updated the virus definitions. Now, what
should I do?
Kabir

This is a known issue and its 
solution was provided in one of 
the updates. To install the update, 
start Norton AntiVirus, run Live-
Update, download all available
updates, and then restart the computer
when prompted.

If the error still persists in Windows
XP, go to Start > Run, type ‘msconfig’ and
click OK. The System Configuration Util-
ity appears. Here, click the Startup tab.
Now look for the ccApp entry and ensure
that it’s checked. Next, click the Services
tab and under the Service heading, locate
Symantec Event Manager and Symantec
Settings Manager and click the checkbox
in front of these entries. Finally, click
Apply  and then OK. Restart the machine
if prompted to do so.

For Windows 98/Me, go to Start > Run,
type ‘msconfig’ and click OK. Click the
Startup tab, look for the entries for
ccSetMgr, ccApp and ccEvtMgr and
ensure that they are checked. Click
Apply, and then click OK and restart
the machine.

If the above process also fails to solve
the problem, then download the
Symevent installer file Sevinst.exe
(ftp://ftp.symantec.com/public/english_us_cana
da/symevnt/sevinst.exe) onto your computer
and execute the following command at
the MS-DOS prompt: 

C:\sevinst.exe /r
Finally, restart the computer. Get in

touch with Symantec support if the prob-
lem still persists. 

98 after XP

I have Windows XP Professional cur-
rently installed on my PC and I wish to
install Windows 98 on it as well. How do I
do that? My hard drive has two partitions.
Deepinder Singh Mann

Ideally, you should be installing
Windows 98 first, on one partition, and

then Windows XP on
the other partition.
However, as you have
already installed
Windows XP, create a
rescue disk for
Windows XP by going
to Start > All Programs >
Accessories > System Tools
> Backup > Tools Menu >
ASR Wizard. Once the
disk is ready, verify it by
booting the computer
with the floppy. Now,
install Windows 98 on
the other partition. You
will not be able to boot
to Windows XP once
the installation is com-

plete. So, use the rescue disk to get back
to Windows XP, open the boot.ini file
residing in the C: drive using Notepad
and add the following line under ‘[oper-
ating system]’:

c:\="Windows 98"
Save and close the file, and that’s it!

You’re done.

Data’s encrypted

I had some encrypted data on my sys-
tem running Windows XP, and I’m not able
to use that data now. Please help!
Praveen Tanwar

If you have used the encryption built
into Windows XP, then there is hope,
provided that you have backed up the
private key used to encrypt the file. Visit
http://support.microsoft.com/default.aspx?scid
=kb;EN-US;223316 for information on the
encryption process  as well as steps to
decrypt the file. However, if you do not
have a backup of the key, then all we can
do is give you our condolences for your
data loss! When you lock something
away and lose the key, you are just as
locked out as any potential thief!

Why am I cheated on the
size?

I have a Celeron 1.1GHz with 128
MB SDRAM, an 810BU Tomato Intel
chipset motherboard and an
7,200-rpm 80 GB Seagate
Barracuda hard drive. While
creating a partition
through Windows XP
Professional, the drive
capacity was shown as
80 GB. However,  after
the partition, it shows
its space reduced to
74.5 GB. I am
quite surprised at
the loss of 5.5 GB.
Where did it go? What is the real prob-
lem? Is it possible to recover this lost
space?
Tsering Ngodup

The problem is not with your hard
drive. By default, it will report the disk
capacity to be approximately 74.5 GB
for an 80 GB hard drive, just as it
shows 18.64 GB for a 20 GB and 37.26
for a 40 GB drive.

There are a couple of reasons as to
why the hard drive loses some space.
The manufacturers themselves specify
the size in decimal notation instead of
the binary notation used by PCs. In
binary notation, 1 KB stands for 1,024
bytes and not

1,000 bytes, as is the case
in decimal notation. Hence,

the computer perceives the size to be
lesser than the specified value.

Another factor that brings down the
size of the hard disk is the file system
overhead. As a result of both these 
factors you get approximately 95 per
cent of the size specified by the manu-
facturer, which is the same in your case.
Thus, you can’t do anything to recover
this space.

The ASR wizard helps you create a rescue disk in Windows XP



Opening ISO files

I have a Pentium III 866 MHz,
Windows 98 SE, 256 MB of RAM, Award
BIOS, and a 20 GB hard disk. I often save
images of CDs on my hard disk using
Nero 5.5. What software should I use for
opening these image files, which are in
the .iso format?
Abhinav

There are many applications that
open ISO files. Some of them are
WinISO, available from www.winiso.com,
UltraISO from www.ultraiso.com and
WinRAR available at www.rarlab.com. 

No display

I have a Pentium III 800 MHz with Win-
dows 98 SE and a Mercury 810 mother-
board. My problem is that there is no
display on my monitor. As I boot up my PC,
the monitor goes into standby and there is
no activity at all. Please help me.
Tejas

First, verify if the monitor is working
properly. Remove the display cable from
the VGA port at the back of the cabinet.
The monitor should then display a mes-
sage that reads something like this:”No
connection, Check signal cable”. Older
monitors may not display anything.
Connect them to another working com-
puter to test their functionality.

The next step would be to check
whether the SMPS is working. If its fan 
is not working then the problem is 
with the SMPS. You will have to get 
it repaired. 

If all’s well with the SMPS, then 
check the internal speaker. To do that,
remove the RAM chips from the mother-
board and boot up the PC. The speaker
should generate some sound, if not then
get a proper working speaker, as it’s an
important component in the trou-
bleshooting process. If the speaker works,
and yet you hear no beeps indicating the
removal of the RAM, then the motherboard
or processor is at fault. Get them serviced. 

However, if the speaker does beep
then insert the RAM back into the slot
and remove the display card. Now the
speaker should beep again. If it doesn’t,
then there is a problem with the
motherboard. If the speaker beeps then
the display card is at fault; get it replaced
or repaired, insert the new or repaired
display card and the monitor should
work fine. 

The last step would be to check if
the CPU fan is working. If it isn’t,
then again the motherboard is at fault.
Verify the working of the fan using an
alternate computer.
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sos@jasubhai.com
E-mail us your
computing prob-
lems, and we
may answer
them here! Since
we get more

mails per day than we can handle, it
may take some time for your query 
to be answered. Rest assured, we are
listening!

Machine auto-shuts down
in a minute!

I run Windows XP Professional, and
I’ve recently gotten a broadband con-
nection. I didn’t have anti-virus software
when I got the connection. Now, all of a
sudden, I’ve started receiving a message
that says, "NT Authority/system call,
Remote Procedure Call service terminat-
ed. The system will shut down within one
minute." I installed Norton AntiVirus
2003, but it isn’t working at all. I then
tried to run navdx.exe in DOS mode, but
it doesn’t detect a virus. What might the
problem be?
Saptarshi 

The solution to your problem
involves three steps. First, download
the virus removal tool for the Blaster
virus—this the virus that has infected
your machine—available at http://secu-
rityresponse.symantec.com/avcenter/FixBlas
t.exe. Second, the virus may return if
you do not patch your Windows, so
install the Windows patch available at
http://download.microsoft.com/dowload/9/
8/b/98bcfad8-afbc-458faaeeb7a52a983f01
/WindowsXP-KB823980-x86-ENU.exe.

The final step is to download the
latest virus definitions, located at
http://securityresponse.symantec.com/avcen
ter/download/us-f i les/20040311-033-
i32.exe.  If the shutdown error message
occurs while downloading any of the
fixes mentioned above, go to Start >
Run, type ‘shutdown -a’ and press [Enter]
to get rid of it temporarily. 

Reducing flicker

Ever since I upgraded to Windows XP,
the refresh rate of my monitor has
become exceptionally slow. It refreshes
slowly when I try to scroll down the
screen. Can you help me resolve this?
Milan

All you need to do is increase the
refresh rate. Right-click anywhere on
the desktop and select Properties. Go to
the Settings tab, click Advanced and
switch to the Monitor tab. Here, set the
‘Screen refresh rate’ to the highest pos-
sible value. For a 17-inch monitor at
1024 x 768, the maximum refresh rate
is around 85 Hz while it is 70 Hz for a
15-inch monitor at 800 x 600. These
settings do vary from model to model

and vendor to vendor. 
Also, do use the VGA card drivers

provided by the vendor for better hard-
ware acceleration in the display, making
it scroll faster. You may also reduce the
number of colours your display is set to
in the Settings tab.

Works in one, but not in the
other

Somehow my Riva TNT128 AGP card
does not install properly in Windows 98.
The display goes blank once I reboot it
after the driver installation. I have a dual-
boot PC that runs Windows XP and Win-
dows 98 on a BXv98-AT board with 128
MB RAM. The card works fine with Win-
dows XP, though. I am using the drivers
CD  that was bundled with the card. 
Pradip Srivastav

Ensure that the appropriate driver
files are selected while installing the
driver in Windows 98. If there is no
wrong being done in the driver file
selection, then probably the drivers
themselves are corrupt. Download and
install the detonator from http://www.
nvidia.com/object/LO_20010606_3499.html.

FAQs
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Animating
Instincts
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26 Maya
Nifty tips compiled by 

Suzzanne Rebello, 

a Maya consultant, 

who has lent her expertise

to many international 

animation projects.

29 3ds max
Here are 13 useful nuggets

by Sachin Puthran. He 

handles art direction for

audio visuals, especially 

in the area of film and 

televison. 

So you want to be a graphics
animator... You’re definitely
going to need these tips to
to make Maya and 3ds max
work for you...
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General user tips
Manage your scenes

A project lets you group dif-
ferent files such as rendered
images, needed for a scene or
a group of related scenes. Go
to Create Project and click the

‘Use Default Button’ option,
set the Project as Current
and save your working

scenes. Transfer all file
textures to the
Source Image folder.
Before you render,

delete all unused
nodes. To do this, go to
File> Optimize Scene Size.

Clean the Channel
box

Select Object and then
go to Window > General

Editor > Channel Control.
Select channels that you

won’t use on your current
object. Click on Move to
transfer them to the Non
Keyable attributes. Also, look
out for Non Keyable attrib-
utes such as Shear, Ghosting,
etc.—you can transfer them
to the Keyable attributes with

the Move button.
You can split an

outliner in two to
efficiently manage a
number of objects.
Click on the grey
line at the bottom
of the outliner and
drag it upwards 
to do so.

Lock the camera
To the right in the
channel box, select
the channels by
name, click on the
one on top, drag it to
the last, right-click
and select Lock
Selected.

To revert to selections 
Go to Create > Sets > Quick
Selection Sets and name the
selection. Next, go to Edit >
Quick Select Set. This is handy
when you have to revert to
selected vertices in a
complex mesh. Use
the Lasso tool or go to
Edit > Paint Selection Tool,
to make Selections.

Modeling
Making polygonal

Models  
To keep a check on your
polygonal count, Go to Dis-
play > Heads Up Display > Poly
Count On to do so. Make a
polygon smooth proxy by
going to Polygon > Smooth
Proxy. For symmetrical char-
acters or models, model only
one half, and when complete,
mirror the other half. Do this
by going to Polygon > Mirror
Geometry. Here, choose the
respective axis and select Mir-
ror. You can also opt to
‘Merge the Vertices’ at this

time. Rig this LowPoly model,
and keep checking the skin-
ning results, the Outputs on
the hiRes model, or the
Smooth Proxy. Keeping the
LowPoly and HiPoly on two

different layers is usually
helpful, for files with large
scenes, and also when you
have to edit vertices—the
fewer the better.

To make wires, tails for
polygonal meshes 
To create creatures, pipes, or
get multiple appendages to
protrude quickly, use the
extrude process. To do this,
select the edges or faces you
want to extrude and the
curve you want to extrude
along. Go to Edit Polygons >
Extrude Face or Edit Polygons >
Extrude Edge. Here, turn on the

MAYA
Get the most respected animation software to

create breathtaking animations for you

Transfer unused channels into the NonKeyable attributes 

Group different files needed for a scene
into a Project

Use the sel box to name the selection
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‘Use selected curve for extru-
sion’ option and click
Extrude.  Press [Ctrl] + [A] to
access the Attribute Editor
and use its controls to edit the
extrusion.

Use the Twist option to
rotate the extruded polygons,
and ‘Taper/Taper Curve’ to
scale them along the curve. To
control the taper exactly,
open the Taper Curve section
and use the graph control to
set scaling along the length of
the curve.

Nurbs at render time 
To get rid of jagged edges of
nurbs at render time, go to
Attribute Editor and drop-
down Tessellation. Check the
Display Tessellation box and
increase the ‘Curvature Toler-
ance’ by using the drop down
menu. You can Increase the U
and V divisions factor by typ-
ing in a higher value. This
increases the meshcount
when rendering, thereby out-
puting a smoother geometry.

Animation
Reordering inputs 

The way the deformers or
input nodes are assigned
affect the object to a consid-
erable extent. To reorder
these, right-click on Object
and go to Inputs > All inputs,
click the middle mouse but-
ton on the input node and
place it below or above anoth-
er in the same stack.

Evaluate nodes 
This feature is present in the
Modify menu. It’s great, espe-
cially when making a tiny
change in a completely rigged
character setup. Just put the

respective function on, make
your changes, and go back to
Evaluate All.

Smoothing weights 
It’s a bit unnerving to keep
rotating the joints, or moving
the Inverse Kinematics (IK) to
check the influence of the
joints and their weights on
your skinned character.

Instead, simply animate
the joints at their extreme
positions. Set one key at bind
pose at frame 0 and another
at another pose, at, say, frame
50. Now, compare or adjust
the weights as you scrub
along the timeline.

Editing smooth skin bind
To change the weighting of
the CVs, other than by paint-
ing weights, go to Windows >
General Editors > Component Edi-
tor and under the Smooth
Skin tab, type in the values for
the selected vertices.

Ghosting
This is a direct translation of
the classical animation tech-
nique of flipping through a
handful of cell drawings to get
a feel for the timing of the
action you are working on.

You can control ghosting
on each object in your scene
with the ‘Ghost Selected’ and
‘Unghost Selected’ options
windows, or with the Ghost-
ing Information attributes. In
addition to ghosting individ-
ual objects, you can now
ghost entire skeletons or
object hierarchies.

The appearance of ghosts
in the scene view is also
improved for Maya 5. The
colour of ghosts before and

after the current frame or
keyframe lightens as their dis-
tance from it increases. This is
visible only when scene view
Shading is set to Wireframe.

Move along rotation axes
Use the Move tool to move
along the Rotation Axis
option to orient the move
manipulator to the local rota-
tion axes of the object.

Freeze joint orientation
Maya 5 lets you freeze the
local joint rotation axes to
match world space. To do so,
go to Modify > Freeze Transfor-
mation and turn on the Orient
option. If this option is turned
off, the local joint rotation
axes are not affected by Freeze
Transformation.

Parent constraints
With a parent constraint, you
can relate the position—trans-
lation and rotation—of one
object to another, so that the
objects behave as if they are a
part of a parent-child rela-
tionship that has multiple tar-
get parents.

An object’s movement can
also be constrained by the
average position of multiple
objects.

Maintain offset
Use ‘Maintain Offset’ to pre-
serve the original, relative
translation, rotation, and scal-
ing of a constrained object.
This option is present in all
constraint option menus

IK/FK blending lets you
apply keyframe animation to
joints, and also control them
with IK animation. In addi-
tion to blending IK and For-

ward Kinematics (FK) anima-
tion over multiple frames, a
blend can occur over a single
frame as well. This switches IK
to FK or FK to IK instantly. 

Indirect skinning 
Here’s how you can conform
the shape of the skeleton
through a lattice: Construct a
shape in the form of a snake—
draw a curve, create a circle,
and Extrude on Path. Draw a
skeleton of 10 or more joints
inside the model. Create an IK
handle that’s the length of the
skeleton. Select the skin and
create a lattice with ample
divisions. Select Skeleton and
‘Bind Skin to the Lattice’. This
lets you deform the hardest of
objects convincingly.

Rendering
Pelting

Reduce the effort and time
you spend on adjusting those
UVs when texturising charac-
ters or models: The technique
is called pelting. Take your
mesh, for example, the face,
duplicate it and flatten out all
the CVs onto a single plane,
almost as if you were to ham-
mer them. Apply a planar
map to it. Now, transfer the
UVs back to the original face
mesh and then open the UV
editor. Isn’t that something!

Paint FX
Flip Tube direction
Use this to switch the direc-
tion of the current brush
between Along Path (ideal for
canvas painting of plants) and
Along Normal (ideal for scene
painting of plants). This is 
available as a hotkey. 

A ‘Force Tube to be Along
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Path’ checkbox is added to
the Canvas section of the
Paint Effects Globals. When
checked, this causes brushes
with tubes whose elevation-
Min is greater than 0.5 to be
drawn along the path rather
than along the normal in can-
vas mode. Thus, the plant
brushes draw in the expected
direction when painting in
the canvas. 

Paint effects and polygons
You can convert Paint Effects
strokes to polygonal meshes,
including construction histo-
ry, using Modify > Convert >
Paint Effects To Polygons. 

This allows you to: Ren-
der in any renderer, includ-
ing the Maya Software
renderer—mental ray for
Maya—the Hardware ren-
derer, and the Vector ren-
derer. Also to have Paint
Effects show in reflections,
refractions and through
transparent objects. Lastly,
you can use other polygon-
editing tools on them. 

Turn on Quad Output, to
output to quadrilaterals. The
default is off, defaulting out-
put to triangles.

Lights
Intensity and colour curves 
Use a custom brightness
decay rate to increase a spot-
light’s brightness, or a custom
colour decay rate to change its
colour with distance. 

Intensity curves and
colour curves are graphical
representations of a light’s
brightness and colour with
distance. Use the graph editor
(Windows > Animation Editor), to
view them. 

The vertical axis repre-
sents the intensity or colour
intensity value, and the hori-
zontal axis represents dis-
tance from the light source.
Intensity curves and colour
curves are similar to anima-
tion curves, except that the
horizontal axis of an anima-
tion curve represents time.

RampShader brightness
Use this Shader Type to create
cartoon-style shading with the
help of a ramp with stepped
values. The right side of the
ramp shows the colour output
where the brightness of the
diffused and translucent light-
ing is 1.0 or greater. The left
side displays the colour with
brightness set to zero.

3D Paint Tool
Edit existing textures
You can now edit both, the
size and the file format of
existing 3D Paint textures
using the Assign/Edit Textures
button in the File Textures
section of the 3D Paint Tool
settings. This button was pre-

viously named Assign
Textures and used only
for assigning new tex-
tures; it had 
no effect on existing 
textures. 

The displacement
attribute 
Displacement is added
to the Attribute to Paint
drop-down list in the
File Textures section of the 3D
Paint Tool settings. It is now a
paintable attribute.

Output
The Maya Vector renderer 
Make good use of the Maya
Vector to stylise renderings.

It offers cartoon, tonal art,
line art, hidden line, wire-
frame in various bitmap
image formats such as IFF,
TIFF, etc. It also offers in the
following 2D vector formats:
Macromedia Flash (non-inter-
active) version 3, 4 or 5 (SWF),
Adobe Illustrator version 8
(AI), Encapsulated PostScript
Level 2 (EPS), Scalable Vector
Graphics (SVG). 

Render layers
These are used to render
huge scenes. Below the
Channel box, there are dis-
play layers. Click on the
drop down menu, and
change to Render. Add the
objects to the layers as you
create them. 

Now, go to Windows >
Rendering Editor > Render Glob-
als. Here, in the Maya soft-
ware Tab, drop down
Render Layers/MultiPass
Control and turn on the
option to Enable Render
Layers. All objects are
assigned to the default lay-
ers. Also, look for trans-
parency throughout the
layers at render time.

Fcheck
Access Fcheck by going to
Start > All Programs > Maya >
Fcheck. This utility is provid-
ed by Maya to view images
and animation sequences.
Use it to view high-resolu-
tion image sequences. If your
RAM doesn’t support play-
back of larger images—
because the image sequence
is too large—you can shrink
it and reduce the image 
by 50 per cent. Fcheck is 
also used to re-number the
sequence or rename it.Adjust the brightness of a spotlight to suit your animated needs

The Maya Vector to render in style!
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293ds max is one of the
most popular 3D appli-
cations used in the

broadcast and film industry.
Its intuitive toolsets help you
create professional-quality
3D models, photo-realistic
still images, and film-quality
animation on your PC.  

The new channel, Pogo,
has made excellent use of
animation to package itself.
We will use the Pogo logo as
an example to help under-
stand the plethora of features
that are hidden in 3dsmax.

Creating the element
The basic element of Pogo is
a square with its top-right
corner rounded.

Let’s create this shape:
Click on the Front viewport
to activate the viewport.

Click the Create tab in the
command panel. Click the
Shapes button to display the
Splines shape type.

On the Object Type roll-
out, click rectangle. Click the
Keyboard Entry rollout to
open it. Here, select a numer-
ic field with the mouse and
enter a value of 50 in the
Length and Width field.
Leave the Corner Radius
value at 0 and click Create.

Observe the Front view-

port. You now have a square
of 50 units. Name this ele-
ment as Pogo_element in the
Name and Color field.

Create embedded
shapes
We need to embed a circle
inside the square, so that we
can modify the size of the cir-
cle in animation. While there
are many techniques to do so,
3ds max offers you a simple
method to create this effect.

To embed a new shape,
select the ‘Pogo_element’
that you have created in the
Front viewport. Go to the
Create panel and uncheck
the ‘Select New Shape’
option in the rollout. Now,
click the Circle button. Open
the Keyboard Entry rollout.
Enter 10 as the Radius value
and click Create.

The new shape is a part of

the ‘Pogo_element’. Move the
shape in the Top Viewport,
using the Select and Move
tool, and both move together.

Dynamic mouse undo
If you are moving the
‘Pogo_element’ from the
existing position to a new
position by left-clicking and
dragging the mouse, you can
cancel this action by keeping
the left-click pressed and
clicking the right button
once. This is a handy tool to
check certain functions with-
out committing your actions.

Animating the hole
First, convert the object into
a mesh. Select the object,
click on the modifier list and
select Edit Mesh. Alterna-
tively, press [E] after clicking
on the modifier list to jump
to the Edit Mesh modifier.

Expand the Editable
Spline modifier controls and
select the spline module.
Click on the circle in the
object and the selected
spline is displayed in red.
Click on the ‘Show end
result on/off’ toggle button

The basic form of the Pogo logo

3ds max
3ds max is one of the most sophisticated 3D
software that makes your images come alive.
Here, we take you through nifty tips that take

your work to a new animated dimension

Select circle to get that shape in
the animation

View the shape from the Front
viewport

The magic icon to preview the
end result



for the mesh preview when
keyframing. You can see the
mesh in shade view in the
Perspective viewport.

Now go to Frame 1 on
the timeline and hit the
Auto Key button to activate
it. Go to frame 20 and use
the Select and Uniform Scale
tool to scale the circle. Simi-
larly, go to each successive
twentieth frame and
keyframe the circle using
various scaling values. The
best way is to scale up and
down during keyframing.
Remember to scale the circle
within the square.

Now your basic shape is
animated. Save this file as,
say, Pogoanim_ master.max

The rounded corner
Use the Fillet option to create
the rounded top-right edge.
To get a better view, click on
the ‘Zoom Extents All’ but-
ton. This fits the shape to the
best size in all viewports.

Here’s how you fillet the
edge: select the ‘Pogo_ele-
ment’ and click the Modify
tab in the Command panel.
Here, the selected object is
shown as an editable spline
object. Click on the ‘+’ to
open up the sub-object con-
trols. Click on the ‘Vertex
sub-object’ and then on the
top-right vertex of the
‘Pogo_element’ in the Front

viewport. Now, enter ‘10’ in
the Fillet box and press
[Enter]. Your Pogo shape is
now ready. Save this file as
Pogo_master.max. For other
techniques, remember to

save it  as a new file before
starting a new project.

Creating an array of
animated shapes
Use the array command to
create duplicates of the basic
shape. Remember to save as
this file as tech2.max. Select
the object, and go to the
Tools > Array command from
the top menu bar. We will
now duplicate 10 copies on
the X-axis. Note that the size
of our master object is 50
units. In the Move incre-
mental field, set a value of
50. Select type of object as

Copy. In the array dimen-
sions, select 1D with a count
of 5 and click OK. The shape
is repeated across the X-axis
with edge-to-edge accuracy.
Move the slider on the time-
line from 0 to 100 and you
will find that even the ani-
mation parameters are
copied with the object.

Randomising animation
Notice that all the circles are
animated in a similar way
on the timeline. We can
now bring in some variation
by selecting each object and
shifting the keyframe.

Select the second object in
the series and move each
keyframe marker that appears
on the timeline to a different
position. For example, move
the keyframe marker 1 to
frame 5, keyframe marker 20
to frame 35, and so on. This
done, check the playback by
selecting the perspective view
and clicking the Play Anima-
tion button next to the time-
line. Repeat this procedure for
all the objects. On playback,
the circles are animating at
different time intervals.

Save this file as
tech3.max.

Make an instanced
array
Select all the 5 animated
objects and go to the Tools -
array command again. Click
on ‘Reset All Parameters’.
Enter 50 as the value in the
incremental Y Move field.
Select instance as the type of
object. Enter 5 as the array
dimensions 1D and click OK.

Notice that this creates a
new set of objects on the Y-
axis. Go to the timeline and
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Make multiple duplicates in a jiffy

The Play/Pause toggle controls
playback

The Perspective viewport shows
the model with instanced arrays

The Fillet dialog box helps you
create those round edged corners

The magic button to fit views in
all the viewports



hit ‘Play animation’. All the
vertical objects have the
same animation. The base
object keyframes can now be
modified. Remember we had
used the Instance option
while creating an array. Let’s
see how to use this feature.
Select the 3rd object in the
bottom row. Observe that
the keyframes are the same
for the objects placed verti-
cally above it. Modify the
keyframe position of the
base object. All the
keyframes in the instanced
objects above it are updated
automatically. Group all the
objects using the group
command in the menu bar.
Save this file as tech4.max.

Using Instance while
copying, allows you to mod-
ify the parameters of the
master object. All instances
created from the master
object are updated automat-
ically. This is useful when
developing animation—say,
with a school of fish, where
you modify one fish to
update all instanced objects.

Camera animation
Create a free camera in the
Front viewport from the
camera command panel.
Move the camera along the
Y-axis so as to view the
grouped objects. Select Cam-
era view in Perspective view-
port or press [C] while there.
Your animation is displayed
as seen through the camera.

Move the camera till the
objects just fit to the extremes
of the view. This is your view
in Frame 1. Now, turn on
AutoKey and go to frame 25.

Move the camera in the

left view along the X-axis
closer to the object. Move it
along the same axis away
from the object in frame 50.
Use your own creative cam-
era compositions. Repeat the
same for frame 75. For frame
100, copy the keyframe from
frame 1 to frame 100 by click-
ing and dragging the frame 1
marker,  while holding down
[Shift]. Your basic animation is
ready. You can preview your
animation by selecting the
Animation > Make Preview com-
mand from the menu bar.
Save the file as tech5.max

The Make Preview win-
dow has options that allow
you to set the size and param-
eters of your preview. Ensure
that you have chosen Cam-
era01 from the Render View-
port drop-down option. You
can also create multiple cam-
eras in the same scene and
animate them. You can name
these cameras for your con-
venience. Set the camera
name during preview in the
Render Viewport dropdown.

Adding dynamism to
camera animation
Regular keyframing gives
you a very standard looking
animation. You can add
spice to your animation by
using Track View > Curve editor.

Select the camera and
select the Track View > Curve edi-
tor from the Graph Editors
menu to open the curve-edi-
tor window. Select the Trans-
form Y position of the camera
in the left panel of the editor
window. A green curve
defines the movement of the
camera. It starts with an ease
in, takes a peak and then ends
with an ease out. This is the

default attribute assigned to
animated objects in 3dsmax.
However, we can assign dif-
ferent controls to change the
nature of animation required.

You can modify the
nature of curve in the graph
editor to change the tempo of
the animation. Click on the
second node to display the

Bezier control handles. Drag
the left node vertically down
to change the nature of curve.
Preview the animation using
the camera viewport.

Similarly, select the fourth
node and select the Set Tan-
gent to Fast icon on the
curve-editor top panel. Pre-
view it to see the difference.
Save the file as tech6.max.

Handheld camera
effect
Assign controllers to the X or
Z-axis to make the camera
movements look wacky or
like the effect of a jerk when
using a handheld camera.

Assign a controller by
right-clicking on the X posi-
tion of camera01, transform
the position in the curve-edi-
tor, and select ‘Assign con-
troller’ to open the Assign
Float controller box. Select
‘Noise Float’ and click OK.

An irregular wave pattern
appears in the Noise Con-

troller property window.
Preview the animation.
Observe that your camera
has shifted to the left and
the movement is a bit jerky.
Adjust the Group01 object
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Quickly check your animations
in Preview mode

Curves that can set things right

Adjust the curve to change the
pace of the animation

Tweak the curve controls to get
that jerky look
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by moving it to the left of
the X-axis in the front view-
port. Use the camera view-
port to move it till you are
satisfied with the framing.
You can also change the
property of the noise
strength by right-clicking on
the X position name and
selecting properties. Change
the values of Roughness and
Strength to get variations. A
small feature called Ramp in
and Ramp out allows you to
smoothen the start and end
movements. Preview your
animation at this stage and
save the file as tech7.max

Using Skylight
Now we can set up the basic
lights required for the ani-
mation. Choose an Omni
light from the lights pane.
Position this to the right of
the camera and in front of
the object group. Reduce the
multiplier intensity of the
light to 0.5 in the light
properties box.

To make your illumina-
tion convincing and softer,
use Skylights. Click on the
Skylight button in the Create
lights rollout. Create this

light anywhere in the scene
since the effect isn’t based on
its position. You need to acti-
vate the Advanced lighting
control to use the Skylight’s
lighting property. To do so, go
to Rendering > Advanced light-
ing, and  select Light Tracer.

Next, create a spotlight
using the create Spot Target

in the lights create panel.
Use the Top viewport to cre-
ate light from the left of the
camera, pointing towards
the group object. From the
Left viewport, move the tar-
get upwards, pointing to the
centre of the group.

Here’s a special feature
that lets you project an

image onto this object.
Select the spotlight and
open Advanced Effects from
the Modify Light panel.
Click None to open the
Material/Map browser win-
dow. Select Bitmap and press

OK. Select a bitmap image
file from your image
resource and press OK.

Notice that the image
name is shown in the Pro-
jector Map box. Open the
spotlight parameters in the
Modify Lights panel.
Choose rectangle as the
option for the shape of the
spotlight. Use the Bitmap Fit
button to automatically
resize the rectangle of the
spotlight to the rectangular
proportion of the projected
image. Click on the Bitmap
Fit option and choose the
projected image again.

You can also change the
Hotspot/Beam and Falloff/
Field values to adjust the cov-
erage area of the spotlight.

Render the scene. You will
see the projected image ren-
dered onto the group object.
To make the animation inter-
esting, animate the spot tar-
get from the Front viewport
on the X-axis and Y-axis.
Save the file as tech8.max.

Texturing shapes for a
colourful final animation
The animation will look very
colourful and contemporary
if we can assign a different
colour for each square.

To apply colour maps, first
open the group object. select
it and go to Group > Open from
the menu bar. Now, select
each shape one by one and
apply different colours using
the Material editor.

Open the Material editor
by pressing [M]. Select the first
sample sphere and change
the diffuse colour to blue.
Select the shape at the
extreme-left and top of the

opened group and click on
‘Assign Material to Selection’.

Create 5 such colours in
the Material editor and assign
it to each object. Render a sin-
gle frame to see the result.

You are now ready to ren-
der the entire animation.
Select the Camera viewport
and hit the Render Scene but-
ton on the toolbar. Select the
Active Time segment of 100
frames. Select the custom file
size of 320 x 200 pixels. In
the Render Output section
select the Save File option
and enter the filename as
render. Select MOV - Quick-

time as the Save As type. Hit
the render button and enjoy
your Pogo animation.

Remember to render in
D1 PAL size, ie, 720 x 576 pix-
els for professional television-
quality ouputs. Also,
remember that the televison
format requires 25 frames per
second. Happy Animating! 

The magical light meter 

The focus beam light

The ultimate makeup toolkit

Let there be light

Ready to render
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This side-scrolling arcade game
reminds you of your old Nintendo
games. It’s got characters created by

Dr Seuss (of the poem Green Eggs and Ham
fame), and is inspired from the movie
with the same name starring Mike Myers
(of Austin Powers fame). And it’s fun.

The magical Cat decides to pay Con-
rad and Sally—a couple of really bored
kids—a surprise visit. The strange next-
door neighbour, Mr Quinn, persuades
Conrad to open the Cat’s magical box,
letting all hell loose. To make matters
worse, Quinn’s now off to collect the
magic and become all-powerful. So the
Cat bravely volunteers to set off with the
aim of capturing all the magic and bring-
ing Quinn to book.

Since the game is based on a children’s
book, it’s as family-friendly as can be.
Bright colours, comic characters, funny
one-liners, non-violent action. This might
be a ‘children’s game,’ but it’ll take all
your hand-eye co-ordination and light-
ning reflexes to master it. In that sense,
it’s as hardcore as it gets.

The action follows a fairly linear
sequence. Several appliances in the house
have been mutated by magic. You need to
enter one that currently houses Quinn,

fight your way across the level,
and chase him out. To achieve
this, you have a fabulous
umbrella at your disposal. This
multi-utility tool can shoot an
endless stream of bubbles, cap-
turing all monsters in its path.
You can now pick up these
entrapped creatures to blast
other entities, or blow away
obstacles in your path. The
umbrella can also help you glide
across short distances, act as a
shield, and when held upside
down, can be used to slam down
upon creatures and buttons.

Along the way, you’ll need to watch
out for spikes, cuckoo clocks, lobsters, Cat-
eating plants, steam blowers, hammers,
and tons of other hazards. There’s such a
wide variety of ways you can die, you’ll
never get tired of it. But it isn’t all evil. You
can grab cake slices to boost your health,
jump onto bubble-exhaust rockets to take
you across long distances, and find little
hearts to add to your cat lives.

Once you collect all the magic from
the level, and chase out Quinn, the mutat-
ed area returns to its original self. You
might not always get all the magic on

your first pass, so you’re free to
come back whenever you want to
have another go. You can go right
up to the end, then turn around and
go right back to the beginning!

The game  isn’t a side-scroller all
the time. The camera viewpoint
rotates around the character, and
zooms in and out, depending on the
twists and turns the 3D world takes.
The world is extremely colourful,
but the inability to change resolu-
tions hurts. Often, you aren’t able to
see what lies a bit ahead of you, and
this leads to your doom.

The minuses: The interface is a real
pain, full of bugs and unfinished business.
Support for gamepads is half-hearted. The
control options make no mention of it,
but you can use one if you’ve configured
it in Windows. Gamepads are supposed to
let you lie back and enjoy the game to its
fullest, but you’ll often have to switch to
the mouse to navigate the menu (which,
in a very intelligent move, does not sup-
port gamepads). Bugs exist at several
points in the levels themselves, resulting
in the Cat falling off the map entirely in
a couple of places. Then you have some
nicely done movies that, instead of play-
ing, leave you facing a grey screen. You’ll
have to tap the [SPACE] key a few times to
get past it.

But all these niggles are overshad-
owed by the sound department. The
soundtrack itself is nice enough, in a
childish, frantic, and trippy kind of way.
What takes the cake, though, is the voice
acting—in particular, that of the Cat. The
movie stars Mike Myers, and is therefore
guaranteed to make you smile all
through it. This extends to the game too.
It feels like it’s Mike Myers you’re con-
trolling, not a weird cat.

Dr Seuss: The Cat in the Hat
It’s fun

Genre: Action ■■  Developer: Digital Eclipse ■■     Publisher: Vivendi Universal Games ■■     Distributor: E-xpress interactive Software Pvt Ltd 
■■     Phone: 022-2887017 ■■  E-mail: anand@e-xpressindia.com ■■     System Requirements: 600 MHz CPU, 128 MB RAM,16 MB 3D card ■■     Price: Rs 1,299
■■  Web site: www.catinthehatgames.com OR www.e-xpressindia.com
Rating: ★★★   ✩✩

A jumping puzzle you do not want to mess up

✩✩

Calling the graphics colourful would be an 
understatement
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Max Payne 2: The Fall of Max Payne
Payne 2 The Max

Max Payne 2 is, of course, the
sequel to Max Payne (2001).
It was the most anticipated

game at that time, and it raised the
bar in third-person action games
with cutting-edge graphics and
gameplay. It sold more than a few
million copies, and left gamers
wanting more. This time, Max has
weapons that would put
Schwarzenegger to shame. The sto-
ryline is completely new, and
includes another protagonist—
Mona Sax—providing Max with a
love interest. Mona is on a mission of her 
own, and helps Max in his quest to kill
the bad guys.

Max is in the thick of action as an
NYPD homicide detective. The story starts
with you in a hospital bed, all injured;
soon, things start happening, with people

getting killed in front of you. As you start
moving ahead, bits and pieces of the story
fit in like a jigsaw puzzle, making the pic-
ture crystal clear. The engrossing story and
the new love interest in Max’s life will keep
any gamer going, not to mention the
absolutely frantic and well-executed action.

The game engine and graph-
ics have improved. The grenade
launcher is missing, but there’s
a new secondary fire option, and
you can throw Molotov Cock-
tails, or a grenade in tandem
with firing your gun.

The game is not demanding
on the system requirements
front, and you’ll be able to get
decent frame-rates out of an old
Pentium III too. Just make sure
you have at least a GeForce4 MX
running. Load times are bad, but

this has been addressed in a patch avail-
able from the Web site.

Overall, Max Payne 2 does not leave
any space for you to complain. This 
game is right up there and surely deserves
a strong mention for the manner in which
it leaves you spellbound to the very end.

Genre: Action ■■  Developer: Remedy Entertainment ■■  Publisher: Rockstar Games ■■  Distributor: Milestone Interactive 
■■  Phone: 022-28381614/28313501 ■■  System requirements: 1 GHz CPU, 256 MB RAM, 32 MB 3D card with hardware transformation and lighting
support, 1.5 GB free hard drive space, DirectX 9.0 ■■  Price: Rs 2,999 ■■     Web site: www.maxpayne2.com OR www.milestoneinteractive.com  
Rating: ★★★★ ✩✩

Dangerous Liasions

Call of Duty
Not One Step Back!

It’s the sheer intensity of Call 
of Duty (COD) that hits you—

it simply sucks you in and doesn’t
let go.

The COD experience stems from
the amazing sound effects—not in
terms of quality, but in the sheer
quantity. It’s war played out on a
grand scale. There are tens of units at
any given time, all firing away their
weapons. Add to that machine gun
nests, mighty tanks, and mortar shells
dropping all around you.

COD is an FPS, but it mimics life
in that you’re not the only guy
around; you’re in various battles, with
people killing and dying all round you.
Teamwork is the key here, and you’ll have
to co-ordinate your attacks if you ever hope
to take out the enemy.

The developers used World War II
instead of creating a story from scratch, and
you’re in various real episodes of the War.
The most notable is the battle of Stalingrad.

Here, you’re a young lad who’s been
conscripted into the army for the
defence of Stalingrad. You’re given
five bullets with no gun, and told to
take out the German positions. The
beginning of the Russian campaign
is, by far, the most intense experience
this reviewer ever come across in any
game, and it will be etched in your
memory. Other campaigns let you
take part in key battles in the Ameri-
can and British war effort.

In the harder levels, medkits are
few and far between, and a couple of
bullets are enough to kill you. Don’t
let your team become cannon fodder

while you sit back and watch. You won’t
even live to regret it.

COD easily tops Half-Life as the best FPS
we’ve seen.

Genre: Action ■■  Developer: Infinity Ward  ■■  Publisher: Activision  ■■  Distributor: Milestone Interactive ■■  Phone: 022-28381614/28313501 
■■  System requirements: 700 MHz CPU, 128 MB RAM, 32 MB video card with Hardware T&L, 1.4 GB free hard disk space, DirectX 9.0b 
■■  Price: Rs 1,499 ■■     Web site: www.callofduty.com OR www.milestoneinteractive.com  
Rating: ★★★★

One Stuka down, God only knows how many more of 
them to go...

✩✩
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Gone are the days when Web designers
had to keep a reference guide on their

desk while typing away frantically in
Notepad to design that 100-page Web site.
No offence to the veterans who still swear
by Notepad, but Macromedia has trans-
formed the way you design Web sites,
offering the What You See Is What You
Get (WYSIWYG) solution for HTML
designing. You can now build Web sites
quickly, efficiently and with fun. With its
latest incarnation, Dreamweaver MX 2004
is here to set new standards for Web
designing tools, which naturally means
the need for books to help lower the learn-
ing curve for new users.

This 449-page book is meant for begin-
ners and intermediate users. It explains the
interface options and features of the soft-

ware, and describes the use of
the various panels and facil-
ities provided. The book
shows you all that is needed
to set up new Web sites as
well as create simple ones.
One of its strong points is
the explanation of the CSS
implementation.

The book is scattered
with interesting and useful
‘Did you know?’ boxes that
throw light on a fact and
‘How to….’ boxes, carrying
tips and tricks on how
to perform a particular
task. Useful screenshots marked with
appropriate labels help make the text
more meaningful.

Apart from the basic
tasks, the book also cov-
ers advanced topics such
as templates and usage of
productivity features
such as snippets and
library items. The features
new to Dreamweaver MX
2004, such as the HTML
layers, are marked with a
special icon. The book also
touches upon
Dreamweaver’s capability
to generate dynamic data

driven page using built-in wizards.
The book covers the subject compre-

hensively and is a good guide for anybody
looking to dive into the magical world 
of Dreamweaver.

How to Do Everything with 
Dreamweaver MX 2004 
Site building no more a dream

Publisher: Dreamtech Press ■■  Authors: Michael Meadhra ■■  Phone: 011-23260877 ■■  Fax: 011-23275895
■■  E-mail: wdt@vsnl.net ■■  Web site: www.wileydreamtech.com ■■  Price: Rs 229
Rating: ★★★★ ✩✩

Ever since e-mail came into exis-
tence, spam has been a prob-

lem that nobody has been able
to solve completely. But all
hope is not lost. There are a
number of filtering options
available in existing e-mail soft-
ware that can help cut down the
spam that shows up in your
mailbox. This book explains all
these options in considerable
depth for each of the popular
mail clients (Outlook, Outlook
Express, Eudora, Netscape and
Mozilla mail). It also covers tech-
niques used for various popular
Web-based mail services such as
Hotmail and Yahoo! mail.

A complete section focuses

on various anti-spam
software and services
that informs the read-
er of the latest anti-
spam programs (both
free and commercial)
that can be used inde-
pendently or integrat-
ed with their e-mail
software. The book
then explains the
installation and con-
figuration of a few
popular freely available
ones (POPFile and
Spam Bully) in detail.

The section on server-
side spam filtering is the single sore

point in the whole book though. It’s com-

pletely out of sync with the book’s overall
concept (whoever said that sys admins
were dummies!). Although not of any
practical value, the lay user can read it to
get a rough idea about how filtering is
done at the server level.

All along the book gives information
about various aspects of spam such as the
first spam mail that ever went out, the
origins of Bayesian analysis (used in
many of the anti-spam software), etc, that
makes it both interesting and informa-
tive. At places information about a few
software that let you gain POP access to
paid services (read downloading e-mail
from Yahoo without coughing up money)
is given as an added bonus. Overall, a
very helpful book that lives up to its
name (... For Dummies!).

Publisher: Wiley Publishing, Inc  ■■  Author: John R. Levine, Margaret Levine Young, Ray Everett-Church ■■  Distributor: Wiley ■■  Phone: NA 
■■  E-mail: permcoordinator@wiley.com ■■  Web site: www.dummies.com  ■■  Price: US$ 14.99
Rating: ★★★★ ✩✩

Fighting Spam for Dummies 
Whamming spam
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Oh no! Here they come again, like
a horde of hungry monsters,
hooting and screaming like the

Cro Magnon man attacking prehistoric
cattle. Why me? Why do I have to put up
with them? 

It’s bad enough they make all this 
noise, but like clockwork they seem to cel-
ebrate this stupid monthly festival called
‘issue closing’. 

It’s another 10 days of torture. Ten
days of polluting the atmosphere, drop-
ping disgusting things all over the place
(mostly on me), and 10 more torturous
days of  listening to inane conversations
about  stupid things called computers and
philosophy.

Here comes that rounded thing called
‘Srini’, though I’ve heard him being
addressed as Srinivasan before.

He’s the sloppiest, and messes up my
beautiful brown coat with the precision
of Tiger Woods hitting a hole-in-one. He’s
arguing with that queer looking fellow
with the shiny head. What was his name
again?… ‘Raaabo’ or ‘Robert’ or some-
thing… He’s the one with the tool called
‘bike’, which everyone is always begging
him to use. 

“Come on man, I’m tired of that pizza
guy. Let’s get some real food for a change.
Let’s order from McDonald’s,” bellows
Srini. “No way man, I ain’t goin’ that way
again. Last time I spent 160 bucks for that
flat tyre, and no one wants to shell out
any dough for it,” yells Raaabo. They both
leave, thankfully, still yelling.

Aww shucks, it’s only been 10 minutes
and the next bunch of jokers is back.
There’s the podgy one called ‘Upendra’,
the white, tall, slender one called
‘Garfield’, the one with the funny curvy

design called ‘Mitali’, and that infernal
duo of Srini and Raaabo. 

Raaabo has this horrible
habit called ‘smoking’, which
pollutes the air around me
and leaves this grey dust all
over the place. 

They’re all talking about
that gunk called ‘food’,
each one trying to get in an
opinion edgeways, and
screaming their lungs out. 

“Let’s have Punjabi
food,” yells Upendra. 

“No, I want pizza,”
screams Mitali. 

“You just want to order
from that pizza guy because he
has a crush on you, and gives you loads of
freebies,” says Srini. 

At this point, Mitali takes off her slip-
per and chases Srini in circles around me. 

“Why don’t we make Mitali order 
for all of us, and share the freebies,” 
says Garfield. 

“Great idea”, “Wunderbar”, “Let’s do
it”, echo the mindless drones. 

Raaabo promptly blows a puff of
smoke at me, flicks his cigarette in the
general direction of the ashtray, com-
pletely misses and gets ash all over me.
Oh well! Better than last night when he
‘accidently’ stubbed a lit
cigarette on me. Soon
they all leave, and I have
my few minutes of peace.

It’s about an hour
later, and they all come
back carrying little pack-
ets of that deadly sub-
stance called food. Looks
like most of them
ordered pizza—that’s ok,
not to messy.

Oh no, here come
Srini and Upendra carrying Punjabi food,
with (gasp!) gravy. Man I hate issue clos-
ing! For nine hours a day I have to toler-
ate noise and second-hand smoke, and
now for the next 240 hours, the nights
won’t be peaceful either. 

“How much is the bill?,” asks Raaabo. 
“A cool 721 bucks man,” whines

Upendra. “Srini go bug ‘deep pockets’ to
pay the bill,” suggests Mitali. “No way!

man, he’ll kill me this time, I swear. We
already owe him like over 1,000

bucks—and that’s just for this
month,” complains Srini. 

Like fuel to a fire, Sachin
‘deep pockets’ Kalbag (SK) 
is the cause of my misery.
If it wasn’t for him, these 
slobs wouldn’t have the
‘bucks’ to buy food, and 
I would be saved a lot of
mental anguish. 

I have learnt from their
conversations that he
always pays all, or most of
the bucks, and the mon-
sters never pay him back.

It’s obvious he hates me!
SK paid the bill again. I would commit

suicide; if only I knew how. There’s mind-
less chitter-chatter for five minutes, while
I can hear tearing noises of plastic and
foil, and then, silence! 

The only sounds are the gnawing on
flesh, the slurping of fingers, the crunch
of pizza crusts and the scraping of spoons
against plastic. Each one of them is try-
ing to do too many things at once. 

Mitali wants to proof an article, while
boasting about how the pizza guy gave
more stuff free this time and stuffing her
mouth with a salad.

Raaabo insists on
smoking when eating,
and drops sauce on me,
blows smoke in my direc-
tion and stubs his ciga-
rette out on my leg. 

Srini and Upendra are
playing the ‘look-I-can-
stuff-more-in-my-mouth’
game, and dropping
makhanwala gravy on me
all the time. 

SK just cannot live
without caramel custard, and has to share
it with me… by dropping the sugar water
on me. Why are they always in a hurry?
Who is this strange and invisible god
called ‘reader’ they always want to please?
Why don’t I just get up and walk out?

Perhaps it’s because I’m a lost soul
damned to eternity sitting in 
the ‘Smoker’s / Hogger’s bay’, disguised as
the table!

Bottomless Pits
We didn’t have time to write a leader because we spent one hour deciding what to order for dinner...
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a. Hitler 
b. AIDS 
c. The Computer 
d. The Internet

The black-box is a device
that stores events of aircraft
and vehicles, providing valuable
data about these technological
beasts of transportation—
especially after a mishap. 
What colour is it?
a. Black b. White
c. Orange d. Grey

What was the first 
ever video game?
a. Mario b. Pong
c. PacMan d. Paratrooper

A megabyte is bigger than
a kilobyte, which is bigger than
a byte. What is half a byte
called?
a. Bit b. BiByte 
c. Nybble d. None of the above

What was the weight of the
first electronic computer?
a. 30 tons b. 20 Kg
c. 100 tons d. 500 Kg

The country which got 150
billion junk e-mails last year,

making it the second biggest 
target of spam
a. China
b. United States
c. India 
d. United Kingdom

While reading silently with-
out moving lips, the human
throat, tongue and vocal cords
twitch imperceptibly. Which

company is working on ways
for the computer to pick up
these signals directly from the
person reading? 
a. Apple b. Microsoft
c. NASA d. IBM

A cellular hand-
set company has
recently launched 
a phone with an
inbuilt 1 megapixel
camera. Which 
company is this? 
a. Samsung
b. Nokia 

c. Motorola 
d. Siemens

Which search engine 
company recently added linear
local search capabilities to its
existing services?
a. Google
b. Yahoo!
c. Alltheweb.com 
d. Inktomi

One of the most popular
gaming machines in 2000 was
the GameBoy. How powerful
was its computing power?
a. More powerful than Intel 
Pentium 4 HT
b. More powerful that Param 
c. Exceeded all computing power
needed to put first man on Moon 
d. More powerful than the 
human brain
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Crossword with a Virus

Across
4. A new virus, which hides in a 

password protected ZIP or RAR file,
sent from a spoofed e-mail address

5. The 19-year-old female virus writer
recently arrested in Belgium

7. A virus claiming to be an anti-virus
8. Vital Information Resources 

Under Siege

Down
1. First documented virus after Fred

Cohen’s security seminar
2. In 1999, this exploit ranked even

above the great Melissa virus attack
in terms of security concerns, and
infiltrated military systems

3. A new breed of virus capable of

growing a P2P network of infected
zombies

6. The code used to simulate a dummy
virus to test if an antivirus is working

■ qubit

In 1982, Time magazine’s choice for ‘Man of the
Year’ sparked a controversy. Who or what was it?
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There are more than 
200 satellites orbiting earth,
just for private communications
services—including pagers,
telephones and computers

Jeff Bezos, when starting
his business could not name his
Web site Cadabra (as in ‘abra-
cadabra’) due to copyright
issues. What was the final
name decided for his firm?

5

a. Amazon.com
b. Google.com  
c. Ebay.com 
d. Apple.com 

did you know

Got an interesting question? 

Send it in with the correct 

answer to quiz@thinkdigit.com

numberette

Powered by

The US Navy spent

$375,000 on an

“aerodynamic analysis of

the self-suspended flare”.

The research proved 

that the frisbee was 

not feasible as military

hardware!

1 to 5 Way to go...

6 to 10 Good, if you like
being mediocre 

11 to 15 Your next job could
be with us!

QUOTIENT

Quiz
1: c2: c
3: b4: c
5: a6: a
7: a8: b
9: c10: b
11: a 12: c

Crossword
Across: Down:
4 Bagle1 Brain
5 Gigabyte2 ColdFusion
7 SkyNet3 PhatBot
8 Virus6 Eicar

Answers

Who founded one of the
most successful computer
manufacturing companies in
1984 out of his college
dormitory with only $1000?
Now, he also serves on the US
President's Council of Advisors
on Science and Technology.

8

a. Bill Gates
b. Michael Dell
c. Bernard Daines 
d. Steve Wozniak
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